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d Ties,
New Hopes

Iﬁrst wrote to you two vears ago, in the form of a 'Publisher's Page’
on the first anniversary of CHIP- the magazine thar we all had grown
1o love.

Thar first anniversary was a moment of great meaning for us.

The success of CHIP within those first twelve months had validated
much of what we held to be dear- focus on product excellence and
customer service. This is what | have believed in the thirty-two years
since | started my first magazine.

I am writing again to you after rwo years only because we stand on
the edge of something very important.

: = Jasu Shal
Our change from CHIP 10 Digit. Chairman, Jasubhu Digial Media

It may be argued thar since rthe team, editorial structure, content,
periodicity, price and package all remain the same, then there is really
no difference berween rhis new magazine and CHIP,

While this perspective may not be true in its torality, this transition
still remains a very important one for us. This is because we have

always believed thar our rrue sirength lies not in the marketing of any
international brand, but in the rrue, intrinsic producr qualines thar we
ourselves build,

This belief is whar gives us the courage to attempt this change.

Most of our confidence stems from vour confidence in us.

At this unique moment in our young company’s history, | hope and
rrust that vou will give us the same encouragement and strength that
vou always have,

Looking forward ro having vou on this journey!

Zi@.»uM

Jasu Shah
Publisher
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m editorial

“Digit is another step
on the path of
evolution that we
have embarked upon”

Re-evolution!

1100100~1101001~1100111~1101001~1110100

l \nother day...another bit of news.

Some things change, others stay the same...

We began three years ago with dreams of catalysing an interest in com-
puting in India.

In January 2001, we took on the even more daunting task of spear-
heading the digital technology revolution in this country.

Driving towards addressing a new computing environment required a
redefinition of our focus, a redesigned content package, while continuing
our dedication towards the needs of our readers.

Digit is another step on the path of evolution that we have embarked
upon.

A name that best reflects the confluence of people and technology that
our magazine will be about. A magazine that will be dedicated to achiev-
ing the high standards that we will continue to set for ourselves.

We embrace this significant change with a great sense of enthusiasm and
confidence, and we hope that you will continue to support us with the
same passion that you've shown over the last few years.

Digit will continue to strive to live up to your expectations—with the
same focus on quality of content and design that you have come to expect
from India’s premier technology magazine.

Karan Manral

Assistant Editor
karan_manral@jasubhai.com
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NEWS PULSE ...

hypethesis

Simputer

A What is it?

This is a simple low cost
mobile computer that has a
320x240 screen, 32 MB
RAM and runs on Linux.
Input options include a
screen-based keyboard, a
graffiti-style software and
the Information Markup
Language (IML) that is
(amongst other things)
smart-card aware and XML-
based.

AWhat's so great about it?

It aims to lower the cost
barrier for people who
would otherwise never be
able to afford access to
computers.

AWho made it?

It is currently under devel-
opment by the Simputer
Trust and will be licensed to
manufacturers to produce
under their own Simputer
GPL. Find them at:
Www.simputer.org

SNAPSHOT

The first computer bug
discovered by Admiral
Grace Hopper, was a moth
caught in the computer
relay switch, causing errors!

Damage worth millions of
pounds caused as more
than 12,000 Dell comput-
ers affected by

the Funlove virus

Source: Data Fellows,
www.cs.yale.edu

AMD Going 4 Mobile

Early reports on AMD’s latest
processor (code-named

Palomino) are out. This
processor, which has a 37-mil-
lion transistor core, will be
called the Athlon 4 and marks
AMD’s first serious perform-
ance product for mobile com-
puting products.

Athlon 4 will initially come
in four speeds: 850 MHz, 900
MHz, 950 MHz and 1 GHz for
mobile computers.

According to AMD, Com-
pag will probably become the
first PC manufacturer to offer
the Athlon 4, in its Presario

notebook.

The mobile version of the
Athlon 4 will feature AMD’s
PowerNow! technology, which
allows the processor to dynam-
ically change its clock speed
and operating voltage depend-
ing on the applications and
demands on the CPU. The
1 GHz Athlon 4 will make use
of the PowerNow! technology
to scale from 500 MHz to
1 GHz and run at voltages of
12Vtol4V.

This technolgy is AMD’s
answer to Intel’s SpeedStep
technology, which made the
Pentium 11 processors
extremely popular with laptop
and notebook manufacturers.

Also being launched is the
mobile Duron, which is based
on the Morgan core. This will
constitute  AMD’s  value
solution for mobile computers.
The desktop version of the
Athlon 4 is expected go up
against the Pentium 4 some-
time later this year.

Beat the Heat,
Digitally!

Carrier, a provider of heating,
ventilating and refrigeration
systems, has struck a deal with
IBM to install Java-enabled
chips into Carrier air-condi-
tioners, which will enable the
owners to remotely set the tem-
perature and switch on or off
the cooling devices. IBM will
service the chip and software
within the unit.

The system is designed with
the embedded Java serving up
the site to any mobile or desk-
top device via GSM mobile
wireless networks. So if you're a
Carrier AC owner, you can
access the company’s site, Myap-
pliance.com, and pay a fee to
check your unit on the Web.

Alternatively, fault codes
and diagnostic alerts can be
sent directly from the AC to the
service technicians via e-mail or
fax; they can check your uniton
the Web site and tell you what
the problem is.

Microsoft XP: Building another

Is XP the latest bully on the block? It doesn’t
seem so at first glance. Microsoft’s upcoming
operating system will provide users with an
Internet chat program, a new security program,
a DVD player and software to burn personal
CDs. MSN Messenger will install and load

automatically every time XP is run.

But this has led to com-
plaints alleging

case involving the company’s
anti-competitive  practices

such as bundling the Internet
Explorer browser with the Windows 98 OS.

that 73
Microsoft is using the same W
product-bundling strategy that
had given rise to the antitrust

monopoly?

“

Microsoft counters that it is simply trying to
improve its product with new features that con-
sumers demand, and that its rivals are trying to
do the same thing: expand into new markets.

Companies like Symantec and RealNetworks,

which make software that
N might be affect_ed by this
product bundling, claim
that the new Microsoft
applications are rudi-
mentary and not the best
7" in their categories.
Microsoft’s view is that if

people don't find the new fea-
tures in XP compelling enough to
upgrade, they can choose not to.

@ Red Hat Linux chucks Netscape for Mozilla browser 4 IBM to make supercomputers ¢ AMD introduces new powerful mobile

18 R
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quicktake

Ken Constable, Vice President, Dell Asia Pacific

Dell Computer has entered the
Indian market. Dell’s speciality
lies in directly delivering cus-
tom-built PCs to specific cus-
tomer orders.
A What type of business is Dell
looking at in India?
The policy of
Dell worldwide is
to go direct—the
secret of Dell's suc-
cess. We are cur-
rently looking at
the SME market,
which is a bigger
chunk of the pie.
Two products are
being launched
in the desktop segment and
two products in the laptop
segment. We sell directly to
the people through our Web
site www.dell.co.in or through
our toll free number 1600-33-
8046. Our sales representative
will provide assistance in
selecting a product keeping
the price factor in mind. In the

Ken Constable
VICE PRESIDENT
Dell Asia Pacific

direct model, the latest tech-
nology is available to the cus-
tomer so there is an
investment protection. If a new
technology is announced from
Intel today, just give us a call.
We will make sure
that the technology is
available to you today.
This also reduces
costs.

A What advantages do
Dell machines have
over assembled PCs?

All Dell machines
are built in the Dell
factory. No one out-
side the factory can

tamper with it. Our design is
unique. You can open the
machine and take out the
components without a screw-
driver. In laptops there are spe-
cial stress points designed to
protect the internal compo-
nents. The PCs have a single
button with an ‘e’ written on it
that provides online help.

Vengeance gone
wrong

The first person to be charged
for cyber crime in the country,
is the 16-year old son of a
retired Indian Air Force offi-
cer, who was arrested by the
New Delhi police for creating
a porn site featuring the class-
mates and teachers who made
fun of him at school.

Constantly teased in school,
this Standard XII student qui-
etly found away to hit back. He
created a pornographic site
Amazing-gents.8m.net (taken
down now) that ran a warning
that ‘girls should enter at their
own risk.

His plan backfired when a
girlin class complained to her
father about her being fea-
tured in the malicious Web
site. The boy has been sen-
tenced by a juvenile court to
14 days’ judicial custody at a
juvenile remand home in
Delhi. Clearly not the best of
ways to take revenge.

Nokia playing with Linux consoles

Nokia has announced its plans
to introduce a Linux-based
home entertainment console.
The Media Terminal
will be able to func-
tion as a video game
player, MP3 digital
music player, Web
browser, digital TV
recorder and digital TV
set-top box. It will
compete with Sony’s
Playstation and
Microsoft’s Xbox in
what's becoming an increasing-
ly crowded space.

The development platform
for the games on this device will
probably be the popular plat-

form-independent OpenGL sys-
tem. This would also give Nokia
access to a large existing base

of gaming software titles and
game development expertise.
Rickard Nelger, head of the
Nokia Home Communications
group, says that they have

made the hardware an open
design so anyone else can
make a clone or compatible

product. This makes it look
like Nokia plans on using
the Open Source approach
for both the hardware (x86
architecture) and the soft-
ware on this device.
Whether this is a viable
solution, only time will tell.
The company plans to
release the device in
Europe this summer and in

the US late this year or in early
2002.

Visit www.nokia.com/multime-

dia/mediaterminal.html for more
information and pictures.

Redalert
VBS.VBSWG2.Z@mm

This is an encrypted
VBScript worm that sends
itself to all recipients in your
Microsoft Outlook address
book. Rated as 4 (severe) by
Symantec, it arrives as an
attachment, with the subject
as Mawanella and the mes-
sage, ‘Mawanella is one of
the Sri Lanka’s Muslim Vil-
lage’. If no Microsoft Outlook
application is installed, the
worm displays the message
‘Please Forward this to
everyone'. The worm creates
a copy of itself, called
mawanella.vbs, in the Win-
dows\system folder. To
remove this worm using
Norton Antivirus (NAV), run
LiveUpdate to get the most
recent virus definitions. Start
NAV and run a full system
scan, making sure that NAV
is set to scan all files. Delete
any files detected as
VBS.VBSWG2.Z@mm.

Sub 7 2.2 Beta

First discovered in Decem-
ber 1999, this Trojan has
been consistently updated
by the author. With each
revision, updates, are added
to the DAT files. Sub 7 2.2
beta offers the usual access
to the user’s data via the
Internet. By default, the Tro-
jan uses TCP port 27374. It
is normally distributed as a
Win32 PE exe dropper that
may be disguised as a JPG
or BMP picture. When run,
this dropper installs two
files into the Windows fold-
er: the main server exe files,
normally called msrexe.exe,
and a loader program nor-
mally called run.exe, win-
dos.exe or mueexe.exe. Do
a full scan of the system
with McAfee or NAV and
follow the instructions to
remove the file.

chips in competition with IBM @ Intel challenges Sun with telecommunications server ¢ AOL and CompUSA announce alliance
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realitybites

£ L =T he industry doesn’t have a pricing
problem—it has an operating

expense problem”

Michael Dell, CEO Dell Com-

puters, while predicting a drop

in revenue.

A

L& J f we're not able to quickly resolve
these issues, it will be necessary for

Congress and the (United States) Copy-

right Office to step in.”

Rab Glaser, RealNetworks

CEO, speaking about the

| resemblance between their

| MusicNet subscription service

% and Napster

(11 I do not question the right of the
Open Source software model to com-

pete in the marketplace...companies and

individuals should be able

to choose either model.”
Craig Mundie, of Microsoft
referring to his earlier speech
criticising the Open Source
model

SEA

thumbnall

The bottom
line—what we
really need is
more customers
to pay for it!

Heck, if we're
lucky we could
get a patent or
two out of this

And there’s going
to be trouble if
you pick Open
Source

MIT Promotes Open Course

Its a natural marriage of
American higher education
and the capabilities of the
World Wide Web, said MIT
President  Charles  Vest,
announcing that the Massa-
chusetts Institute of Technolo-
gy (MIT) will make the
materials for nearly all its
courses freely available on the
Internet over the next 10
years.

Located in Cambridge,
Massachusetts, MIT is a pri-
vate research university with
more than 900 faculty and
roughly 10,000 undergraduate
and graduate students.

Roughly 2,000 courses will
be offered for free via MIT’s
new OpenCourseWare pro-
gram. The initiative is estimat-
ed to take the best part of a
decade and is projected to cost
in the region of $100 million.

It would involve incorpo-
rating lecture notes, syllabi,
exams, simulations and
streaming video lectures for
nearly all of the research uni-
versity’s 2,000 courses. It will
begin with a two-year pilot
program involving a combi-

PATTERN OF INTERNET USAGE

User statistics show the popularity of certain Web sites based on the percentage of users access-
ing these sites from home as well as the workplace.
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nation of professional staff
and teaching assistants who
will put materials for more
than 500 courses on the Web.

Of coursg, students who do
the course on the Web will not
receive a degree, which is
reserved only for the on-
campus students who enroll at
MIT with $26,000 as annual
tuition fee.

OpenCourseWare would
work more in terms of teach-
ing and training young stu-
dents and faculty in
developing countries where
information and the develop-
ment of infrastructure and
institutions are sorely needed.

thermometer
Hot

XML

Everyone who's
anyone is evan-
gelising it

AMD

With the intro-
duction of the
Athlon 4, they're
getting a foot into
the mobile PC,
high-performance
workstation and
multiprocessor
server markets.

Cold

3G-delaying
launch

Handsets report-
edly lose their
connection when
a caller moves
into a new
mobile ‘cell’
Visual Basic
Almost 3 million
VB programmers
have shifted to
the other plat-
forms.

¢ MS monopoly anticipated with launch of Windows XP in October ¢ ‘Cheeseworm’ repairs broken Linux systems 4 XBox video
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Phone-y videos

As if there weren’t enough
things to do on the mobile
phone already! Along with the
usual phoning, e-mail check-
ing, Web-browsing and SMS
sending, get ready to transfer
and receive film-quality photo
and video images along with
your calls.

Sarnoff, a privately held
unit of SRI International (for-
merly, the Stanford Research
Institute), has designed a low-
power, 1.2x1 inch BLINC digi-
tal camera that can enable
mobile phone users to
exchange high-resolution pho-
tos and video images over

[T ketrics

their cell phones.

Japan’s NTT DoCoMo, a
world leader in advanced
mobile phone systems, is
already offering low-quality
video via its popular iMode
service. It plans to launch its
third generation mobile sys-
tems this quarter, which
promise to deliver broadcast
quality video via phones.

With these initiatives in
place, mobile phone users
worldwide are expected to
switch over to using broad-
cast-quality video networks,
ushering a new era of mass
market video-making.

>10,00,000

people will be employed in IT services

The IT-enabled services industry will grow to

"$17 billion

Source: Nasscom estimates for 2008

tomorrowstechnology
ModelMaker 3D Scanners

The ModelMaker, a handheld laser scanning sys-
tem, enables users to capture 3D and colour

data from complex
3D models. This is
useful for anima-
tion, virtual reality
and product styling
applications.

It uses laser
stripe triangula-
tion technique to
scan real-life
images. A thin red

Illustrations: Farzana Cooper

Yahoo! changes its mind in hurry

Never underestimate the
power of your audience. Espe-
cially if the innocence of their
children is at stake. Web portal
Yahoo! learnt this the hard way.

Under pressure to develop

new sources of revenue, Yahoo!
succumbed to offering a broad
selection of adult material,
including porn videos and
DVDs, through its popular
shopping service.

“We're hard and fast on
being the largest enabler of
commerce on the Web,” said Jeff
Mallett, Yahoo!’s president and
chief executive officer. “We have
chosen to offer adult-oriented
content as part of that” he
added.

But parents visiting the pop-

line of laser light scans the surface of the
object, following the surface profile of the

object. Images trapped by
the CCD sensors are used
for simultaneous and precise
measurement of multiple
points.

The initial challenges lay
in capturing the different
positions of the object and
merging together the scans
collected from different
angles at a good speed.

ular portal would have none of
it. “The very real danger is that
our children will have the very
real possibility to be exposed to
pornographic material,” a state-
ment from the California-based
Capitol Resource Institute
said. “This is not appropriate
and must not go unchal-
lenged.”

Faced with a barrage of
customer complaints and
boycott threats, Yahoo! soon
changed its tunes. Two days
after Mallett took the
‘enabler of commerce’ stand,
Yahoo! announced that it
would no longer
sell adult-related
products in its
Web site’s shopping, auctions
and classifieds areas.

Moral of the story: Don’t
mess with parents.

Whois?

GRUB IT

a What is it?

It is a real-time open source
software free for download-
ing from www.grub.org.

4 What does it do?

This distributed crawling
client creates an infrastruc-
ture providing constant URL
update status information
for almost all Web pages on
the Internet.

a What does it offer?

The distributed crawler net-
work used with GRUB can
enable Web sites, content
providers and individuals to
notify others when changes
occur in the content. No
wonder, it's your real-time
search engine! The database
is accessed by GRUB users
via XML feed that enables
them to make changes on
their Web pages and update
the database accordingly.

game console launching in November 4 DigitalTV makes its approach € New subscription service launched by Napster
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Wow! You guys are really bold. You guys really amaze me. Every now and then
you try new things that attempt at changing the world. Keep it up!

With best wishes.

S.Prashanth, Via e-mail

| was a little upset to know about the change in the name but after going through
the details on the Web site, | am very happy to welcome Digit to my family. Now
we expect a lot more.

Srinath Thakari, Via Web site

| have been reading CHIP since the very first issue (April 1998). It's so good that
| still read it although | am now a hardcore software professional. The new name
and look suit the best computer magazine in India.

Sajid Hossain,Via Web site

| have been reading CHIP right from the first edition and | have seen the improve-
ments. | am sure that you will continue to deliver the same kind of quality con-
tent in the future.

Sagar, Via Web site

The change of name to Digit came to me as a surprise, but reading that the con-
tents and quality of the articles will remain the same reassured me. | hope the
same is true for the CD. | loved CHIP India and will love Digit too. After all, what's
in a name?

Pankaj Nagar, Via Web site

First of all, let me commend you on the excellent choice of name—Digit. Cool, short
and snappy. Sounds just sophisticated enough to make it seem young and at the
same time not a new kid on the block.

Dhruv,Via Web site

P.S. I hope your first magazine cover is kick-ass and mind blowing.

Dear CHIP...er...Digit,

When | saw your advertisement stating that CHIP is being discontinued, | was
heart broken because it was the only magazine that was just right.

Then | learnt about Digit. It’s about time you came up with a better name!
Sushir, Via Web site

Man, this rocks. Same stuff + new stuff = Digit!
Aditya Pandya, Via Web site

CHIP was a trendsetter that captured the hearts and imagination of everyone.
Discontinuing CHIP is a shock, but after going through the publisher’s note, | am
reassured. Let's hope that Digit will exceed the high mark set by CHIP.

Mihir, Via Web site

Dear Sir,

When | saw the ad in The Times of India | was quite surprised to learn of Digit.
Nevertheless, the name CHIP shall always remain in our hearts. We breathlessly
await the new digital experience.

ver the past couple of weeks since we announced the launch
Oof Digit we have received an incredible amount of feedback
from our readers—via e-mail, telephone calls and most of all,
our Web site. Some have enthusiastically embraced the new mag-
azine and others just want the old one back.

This is a pretty accurate reflection of the way we ourselves feel
about the launch of Digit.

Each of us, whether it was those who joined up to be a part of
all that CHIP came to mean to us as readers, or others who have
made producing this magazine their mission, will look upon the
past few years with more than a little nostalgia.

However, Digit is a name that best reflects the convergence of
people and technology that our magazine is about. We look for-
ward to this change with a great sense of enthusiasm, and hope
that you, our readers will support us in our mission, which is to
create India’s premier technology magazine.

™ Web awargs

ditched?

What iy
CHIP-Dishne
IS was One

happen to the

t) ;At/sb Awards?

e foremost

f\;\:;aabﬁcawards that g Net

- S wgre looking out for—
Ind of Filmfare awarg

e Netizens, o

re :
Planning to you sil
If so, when) 90 ahead with ity
SANDEER

Via Web sjte
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Yes, we are still planning to go ahead with
the Web Awards in 2001. You will be able
to see information about the Awards up
on our Web site in the near future.

e of CHIP. What do
e)? 1s Digit really
s strategy to gain

ange in the nam
[ better or for wors

it the same old busines

First Gourav left,
ou want 10 chan! :
\étep ahead of CHIP or IS

I
attention?

D SUMIT A strategy to gain attention? Not real-
ly. We think we already had yours.
‘Digit’ seems to better reflect the spir-
it of the magazine.

PS: May be the two hardware and
three software comparison tests in
this issue are a more acceptable
change.

ARNAB MITRAAN

Z. Sheery Joshua, Via e-mail .
vVia Web site

e
Cite the Site

Does Digit have 4 new :

. o
SUNDA . Ite of jts Own?  Yes, you can now visit our new
Web site for Digit at

; RAND A
. Via Wep site !
www.thinkdigit.com
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The fact is that we created all the
content here for Indian audi-
ences. Digit is here. Right now!

prand name and then
tne time of the mgg—
that you were doing

: i i ically using &
onale in basica!
o with your own setup at

sheer nonsense to say

azine lau are useless.

everything and they
SUNIL KUMAR
Via Web site

the magazine to fulfill the needs of its readers, we had to pro-
vide content that was relevant to our Indian audiences. A large
part of the popularity of the magazine over the last three years
could be attributed to this decision.

Extending this further, since January we have a magazine
that has moved from being restricted to only computing, to
one that covers the larger realm of digital technology. The name
‘Digit’ seems to be better suited to this new product.

Also, at no point have we referred to our relationship with
Vogel as ‘useless’ The changes are simply a reflection of the dif-
ferences that exist between our objectives today and our ideas
on what content is suitable.

| was one of the e

expect such offers?
magazine?
SANKAR, NIVID
Via Web site

CHIP as it was published in India was quite distinct from
any other edition elsewhere. If you have been reading it for
the last few months you will find that the same editorial phi-
losophy, concepts and structure remain.

Also, are you go
What will be the price?

Somehow, | am not happy with Digit. CHIP sounded better and | will miss it big
time.
A Shetty, Sriram, Via Web site

CHIP is the best computer magazine in the market. Please do not stop it
Antonia Paes, Via Web site

| don't understand what is happening to my CHIP. | feel like a mother who has
lost her child.
Tadikonda Srinath, Via Web site

What's the logic behind this name change when it already sounds so good and
is so popular? This is really a shock. Come on guys it's more than just a name to
most people. Me included.

Prasanth, Via Web site

| personally feel that there was no need to create this confusion. Continuing the
name CHIP would have been better.
Guru Murthy, Via Web site

‘What’s in a name?’, you may ask? Call it brand loyalty or anything else, | per-
sonally prefer CHIP. It was a part of a global IT information revolution that spread
across several countries through all continents. Somehow the name Digit does-
n't seem to carry the same charm. | would like to see CHIP again. Or maybe even
CHIP v2.0.

Arnab Mitra, Via e-mail

| know things change as life goes on and CHIP also had to change, as it was no
longer associated with Vogel. But fond memories die hard. The memories of being
a part of the CHIP revolution (as a reader of course) will remain.

Riyaz, Via Web site

first
when CHIP was T
or Rs 1% subscribers of Digit

. Can new ro (o G f U )
i &‘;Ubicc)rég?\;isnue giving two CDS with this new O p
ing
Notice any goof-ups? Write to
goof@jasubhai.com

digdit

We do have a completely new sub-
scription offer. Look for it inside this
issue of Digit. Your issue of Digit will
come with two CDs and will be avail-
able to newsstand buyers for Rs 100

Send your letters marked
‘Readers Letters’ to the Digit
office:

D-222/2, MIDC, TTC Industrial
Estate,

Om Sagar Building, Nerul,
Navi Mumbai 400 706
Phone: 022-7629191/9200;
Fax: 022-7629224
E-mail:
readersletters@jasubhai.com
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“We decided to
focus on the
Internet and the
computer
generation, who
are very
important for us”

TOP of the Charts

The spotlight this month focuses on Pentagram, the first Indian band to

top the MP3.com Asia charts

JULIAN VONGEYER AND ANIL PATRICK R.
entagram isn't just another Indian rock
band. It stands head and shoulders above
other Indian rock hopefuls, and one reason
for this is that the band members have
always done a lot of experimenting with their
music and sound. Their most recent achieve-
ment has been to bag the top spot in the
MP3.com Asia charts.

The band believes that the Internet has a real-
ly wide reach as a medium, and MP3.com has
served them well in meeting their objective of
reaching out to a wider audience rather than just
rock enthusiasts. Barely a week after they were
uploaded onto the site, all five songs, which were
previewed under various genres such as Drum
and Bass, Electronica, etc, reached the number
one slot in their respective categories. This
achievement has made Pentagram the first Indi-
an band to top the MP3.com Asia charts.

Pentagram comprises five members—Shiraz

Pentagram: Papal (bass), Vishal (vocals), Shiraz (drums), Randolf (guitar), Clyde (effects)

28 [l

on drums, Vishal on vocals, Clyde on effects,
Papal on bass and Randolf on guitar. Shiraz,
Clyde and Vishal started the band in 1993, and
were joined by the other two in 1994.

They shifted from traditional rock towards
progressive alternative pop and electronica in an
effort to improve themselves and break the bar-
riers of traditional rock music. The group uses
minimal gear to record their songs—a couple of

samplers (one an Akai and the other an SP808),
guitars, keyboards and drums.

Pentagram first tasted success with wins in
three big competitions, the most prominent being
Livewire. This was followed by a record deal with
Plus Music leading to the release of the album,
We're Not Listening in 1996, which became the
fastest selling Indian rock album. The band fol-
lowed this up with two music videos called The
Ignorant One and Yoo, which got good exposure
on music channels. MTV’s Artist of the Month
and the Channel V award for Best Live Band were
the next two honours conferred upon the band.

In 1999, Pentagram got involved in a bit of
controversy. Their single, The Price of Bullets
which also featured Javed Akhtar and Shankar
Mahadevan, was refused airplay by the music
channels. The track was based on the Kargil war,
and the video was considered too violent and
graphic to be aired. Not to be deterred, the band
put the tracks up on the Internet, which led to it
being featured in Rolling Stones magazine.

Topping the MP3.com Asia charts has now
focused even more attention on the group, with
a lot of publicity from the media and a number
of offers including one from a Russian band that
sent them a couple of songs to remix.

“We have decided to focus on the Internet
and the computer generation who are a very
important aspect for us right now and for the
future,” says Randolf. The band members also
feel that putting up songs on free sites such as
MP3.com makes for a good business strategy as
it arouses public interest in the album. Howev-
er, what’s more important to the band than
being number one on the charts is the number
of people that are logging on to the site to listen
to the tracks—an average of 50 people a day.
And, of course, being the first Indian band to
achieve this only adds to the jubilation. “Being
the first Indian band to top the charts felt good.
Being number one in all of Asia is a good thing.”

However, the band members insist that top-
ping the MP3.com Asia charts wasn't all that big
a deal. “By 1998 and 1999 we were pretty well
known in the country and this has just gotten us
into the news again. We had done cassettes and
CDs and we just thought that it was time to get
some music flowing on the Internet as well,
which is why topping the MP3 Asia charts is nice
but not such a big thing for us as it is for the fans
and people who like our music.” [
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Do we need ‘Big Brother” watching us?

Should corporates monitor employees’ Net usage? Anil Patrick R. speaks with representatives of
Bharat Petroleum and Dishnet DSL on whether it violates the individual’s right to privacy

onitoring  employees’
Internet usage should be
enforced by every organ-
isation. This is highly
beneficial for smooth opera-
tions. If an organisation is pro-
viding Internet access to
employees, it is solely for work
purposes. If an employee uses
the Net for personal reasons, it
is a waste of available resources.

Anil Kumar Kaushik
Chief Manager, IS (Communication
Projects), Bharat Petroleum Corporation

There are several aspects to
this issue. Productivity of the
employee suffers when he
browses the Internet for pur-
poses other than work. Surfing
of sites with sexually explicit
content is a major problem,
which can completely disrupt
employee morale and destroy
productivity.

Downloading of objection-
able material and illegal soft-
ware can cause  Ssevere
bandwidth problems. It can
also lead the organisation into
major legal hassles. We have
monitoring software to ensure
that no unwanted sites are vis-
ited by employees.

W
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Yet another problem is chat-
ting, which is a major waste of
time and bandwidth. Employ-
ees can get so addicted to chat-
ting that work is completely
neglected. Chatting is com-
pletely off limits in our organ-
isation. Similar is the case when
employees use the company’s
e-mail facility for personal pur-
poses. The endless chain of for-
warded e-mail can crash the
mail server and this is some-
thing every organisation can do

“If an employee
uses the Internet
for personal
purposes, it is a
waste of available
resources

S a pioneering company
providing Internet access,
we believe that monitoring
employees’ Internet access
is not an ethical practice. We do
not monitor Internet usage by
employees for various reasons.
Reading an employee’s
e-mail is just like opening and
reading one of his letters. Every
individual has a right to priva-
cy and this basic right is com-
promised when an organisation
gets involved in monitoring.

“The individual’s
privacy is
compromised when
an organisation
monitors the Net
usage of its
employees*

What do you think? Come, speak your mind at www.yahoo.co.in

without. We have enforced
scanning of e-mail for unwant-
ed content to avoid such prob-
lems. If an employee is found
to have misused the facility, he
is warned.

Security is a major problem
as well. When Internet usage is
not monitored, it is possible
that confidential internal infor-
mation could be leaked out.
Other problems such as virus-
es and internal hacking
attempts are also possible.

All these factors made us
enforce monitoring of Internet
usage by employees. We believe
that it is a highly beneficial
practice for the organisation. I

Yet another big issue is that
of trust. An organisation can
attain success only if there
exists complete trust between
the management and the
employees. Our employees are
the essence of our organisa-
tion. If we monitor Internet
usage, we are breaking that
bond of trust. Our employees
understand how to use the
Internet judiciously, and we
don’'t want to question their
integrity by monitoring their
Net usage.

The Internet has ushered in
an era of efficient and cheap
access to information. Knowl-
edge is power. Only if there are

Catch ‘em live on Yahoo!

Sanjeev Panicker on June 10 at 4 pm and Anil Kumar Kaushik on June 20 at 4 pm _

enough channels open for effi-
cient communication and con-
stant learning will there be
efficient employees.

If Internet usage is moni-
tored, what is the difference
between this revolutionary
medium and the old channels
of communication? Tracking
what your employee does on
the Internet is just like tapping

Sanjeev Panicker
Manager - Human Resources
DishnetDSL

into a phone line to overhear a
conversation. Would all the
advocates for Internet monitor-
ing in offices indulge in tapping
employees’ phone lines as well?
I don’t think so. Then why
should we monitor what our
colleagues are doing on the
Net? This type of ‘Big brother is
watching!” scenario only tends
to demoralise employees. It also
tends to breed a tendency to
break the system. Let the Inter-
net be what it is—the best and
cheapest method of access to
information. There is no need
to put constraints on the basic
human right to communica-
tion and information. Fl
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amiliarity breeds contempt. It also

breeds virus and hacker attacks.

Which i1s why diversity is the name
of the game in network Security

Normal is boring. Sometimes, though, normal
can be more dangerous than just plain boring.
Security depends on the attacker being as mini-
mally aware of your information as possible.
Highly diverse, dissimilar systems are likely to
pose greater difficulty for an attacker than a stan-
dard, normal and expected configuration. From
a security standpoint, being average is more than
just being mean (pun unintended). Using simi-
lar application software, operating systems or
even configurations is a probable cause for secu-
rity issues. Thanks to the Internet, now we are
much more closely connected than we actually
believe or understand ourselves to be. This con-
nection implies that problems in one configura-
tion can migrate to another with ease.

The foremost tool used to externally analyse
your machine is nmap (www.insecure.org/nmap).
Nmap is a port scanner that can tell you exactly
which OS and what services are operating on a
given machine. Once an attacker is able to obtain
information regarding the configuration of the
machine, the situation changes. If the scan
reveals the machine to be of a default or well-
known configuration, scripts are usually avail-
able to attack it. These problems are not specific
to just the Windows or just the Unix world, they
are occurring with increasing frequency in both.

True, one would assume that there’s a fair
degree of diversity in the Windows world—after
all, Windows is available as 3.1, 95, 98, CE, ME,
NT, 2K, XP (with some of these in Home, Pro-
fessional Server and Data Center variants). If that
isn't enough, you may or may not have applied
the various service packs supplied by Microsoft.
Hang on, we aren’'t done yet—the 1S Web Serv-
er, IE and Outlook Express are available in a vari-

ety of versions as well. With so much diversity,
we should be safe, right? But given the virus
attacks that routinely cripple the Windows world,
we realise the effects of having an OS based on a
common family with similar security issues. Love
Bug, Melissa and the KaK virus extracted a dev-
astating price in terms of the damage they caused.
The fact that Microsoft routinely creates software
that allows malicious external code to be execut-
ed via an e-mail client is inexcusable; the rate at
which these e-mail viruse spread is an even more
serious cause for concern.

Another example of the implications of a Win-
dows bug comes from a newly discovered exploit
that affects 11S 5.0 servers. This bug is estimated to
affect over a million servers world-wide. How
many of these servers are likely to be patched in
time to avoid automated tools that hunt for such
servers is yet to be known. However, if you read
the relevant Microsoft Security Bulletin, you will
find that if you had not retained the defaults but
had customised your 11S setup instead, this prob-
lem could have been avoided. The rate at which
these infections spread reveals that monoculture,
especially in an office or in an organisation, is a
fertile breeding ground for an attack.

So, then, the Unix world is much safer, right?
Well, not really. Linux is humorously described
as the Unix de-fragmentation tool. And, for far
too long, most new users seem to think that Red
Hat is Linux and vice versa. The outbreak of the
Ramen, LiOn and Adore (www.nipc.gov/warnings/
alerts/200/01-010.htm) worms indicates that Linux
usage is also beginning to show a lack of diversi-
ty. These worms make use of the fact that
machines are typically installed using the default
Red Hat install—something that installs
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unwanted software. It may be far easier to set
up a safe server using Linux, but that does not
explain the success of these wormes.

Purists may object that most vulnerabil-
ities occur in applications and not neces-
sarily in the operating system. That is
true—but what about cross-platform
applications that are
now in  vogue?
Apache can now run
on BSD, Mac's OS
X, Linux and just
about every other
platform out there. In
afamous hack sometime
ago, a bunch of clever hack-
ers attacked apache.org to show that
amis-configured Apache server can lead to seri-
ous security vulnerabilities. Ken Thompson’s
famous compiler hack (www.acm.org/classics/sep95/)
again goes to show that one piece of software (in
this case, GCC) being used everywhere can lead to
system-wide vulnerabilities.

If there is gloom about the state of diversity in
computer systems, is there a flip side? Using
numerous little known, obscure and out-of-date
software does not automatically guarantee
security. The goal is to use the right software for

Ken Thompson’s famous
compiler hack shows that
using one piece of software
everywhere can lead to
system-wide vulnerabilities

34 F

the right job. Tailor each configuration to a par-
ticular need; don’t assume that the default is right.
Don't use one setup or configuration because it
may seem easy to administer or maintain. Securi-
ty is a trade-off between functionality and safety.
Understand the need for diversity in the context
of the systems that you are in contact with.

Yes, there are advantages to a software or
operating system being used by a large number
of people. Widespread use results in better test-
ing and detection of potential problems. In com-
munities that can react quickly to problems (for
example, the Linux community solved the Ping-
Of-Death bug in two hours), the widespread use
of software implies that it can quickly become
safer. So, is there a middle path to choose?

For the Windows world, the simplest option
would be to not upgrade unless you absolutely
need to. If your current browser displays pages
decently, do you really need that new version?
Especially if you have been diligently applying all

lllustration: Soloman Lewis

the patches (from
http://windowsupdate.microsoft.com/) for
your current setup? Use some of the available
freeware firewalls to mask your identity. For the
Linux world, do not use the default install—cus-
tomise each machine based on its requirements.
Use a hardening script like Bastille Linux
(www.bastille-linux.org/) to kill known security issues.
Turn off services that you do not need.

One very interesting possibility is the IP-Per-
sonality Patch (http://ippersonality.sourceforge.net/)
available for Linux Kernel 2.4. This patch makes
your machine look like any other operating sys-
tem to external scanners—so you can make your
Linux machine pretend to be an OS/2, Windows,
FreeBSD or Sun Solaris box! This way, you can
have your cake and eat it too! You can use a pop-
ular distribution (and the attendant benefits)
while pretending to be a rare, and therefore dif-
ficult to attack, platform.

A heterogeneous network in an office or
organisation will need more work and mainte-
nance. It may also need more resources and per-
sonnel. But in the larger perspective, if you want
a more reliable and fault tolerant setup, then
diversity is strength. Learn to mix and match
OSes, software and resources. Depending on
your needs, use different configurations wherev-
er justified. Try to introduce an awareness of
where each software has a particular niche in
which it is most suited. Apart from learning
about different software and how they interact,
this will expose you to potential overlaps
between software—something that is useful
from a security perspective. More importantly,
learning how to use different software keeps you
from becoming normal and ordinary—and nor-
mal is boring, right?fl

Madhu Kurup works for the data engineering group at
the Yahoo! Software Development Center, Bangalore.
He can be contacted at madhumkurup@yahoo.com
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Embedded systems
and real time
operating systems
are fast achieving
ubiquity, blurring the
lines between
science fiction and
hard reality

36 EH

ANIL PATRICK R.
doctor is configuring a cardiac pacemaker
inside his patient’s chest while sitting 200
kilometres away. Another person is travel-
ling in a driver-less car that takes him from
Mumbai to New Delhi using its in-built naviga-
tion program. Impossible? Not really. Advances
in technology have taken place at such speed that
these fictitious scenarios are likely to be translat-
ed into reality within the next couple of years.

Real Time Operating Systems (RTOS) and
embedded systems are two among the several
technologies that will play a major role in mak-
ing these concepts possible.

You may say these technologies have been
around for a long time and there have been no
such dramatic developments. But what you may
not know is that RTOS and embedded systems
are the unsung heroes of much of the technolo-
gy you use today—the video game you play, or
the CD player or the washing machine you use
employ them. Without an embedded system and
an RTOS, you would not even be able to go online

using your modem. Read on to find out what
these technologies have in store for you.

etded

How ‘real’ is real time?

When it comes to real-life situations like con-
trolling a traffic signal or a steel furnace, the OS
has to respond immediately. Imagine the plight of
adriver if his car’s anti-skid mechanism refuses to
respond the moment he jams his brakes. This is
where RTOS comes in. Real time operating sys-
tems are those that respond to inputs immedi-
ately (see box, ‘What is an RTOS?’).

First stop—embedded technology

Why use a hammer when a gentle touch would
do? This is the basic idea behind all the appliances
that make use of embedded systems. They are
pre-programmed to perform a dedicated or nar-
row range of functions as part of a larger system,
usually with minimal end-user interaction. For
example, an entire operating system like Win-
dows 98 is not required for controlling a car’s
valve that has only certain types of movements, or

June 2001



: ¥
4
;o
&:'

; “;":’;‘ﬂl'l.'\l‘r-. o
5

otk
5

IN real time

a washing machine, which uses only specific
cleaning routines.

Embedded systems are used in navigation
tools like global positioning systems (GPS),
automated teller machines (ATMs), networking
equipment such as routers and switches, digital
videos and cameras, mobile phones, aerospace
applications, telecom applications, etc. Even toys
make use of embedded systems (see box, ‘What
goes into an embedded system?”).

Embedded systems are usually low in cost and
are easily available off the shelf for most applica-
tions. They usually have low design risks, since it
is easy to verify the designs using evaluation
boards. The easy availability of good design tools
(many of them in the freeware domain) and soft-
ware engineers have been two key factors in
fuelling the growth of embedded systems.

Embedded systems have received a major
shot in the arm over the past two or three years
due to three factors. The first was the develop-
ment of standard run-time platforms like Java,
which enabled their use in myriad ways that

were unimaginable in the past. The second fac-
tor was the emergence of several integrated soft-
ware environments, which simplified the
development of these applications. The third
factor was the coming together of embedded
systems and the Internet, which made possible
the networking of several embedded systems to
operate as part of a large system across net-
works—be it a LAN, WAN or the Internet. This
convergence of embedded systems with the
Internet is going to transform the way we live.

In the driving seat

There are several tasks in which real time OSes
beat their desktop counterparts hands-down. A
common application of embedded systems in
the real world is in automobiles because these
systems are cheap, efficient and problem-free.
Almost every car that rolls off the production
line these days makes use of embedded technol-
ogy in one form or the other. RTOSs are pre-
ferred in this area due to their fast response times
and minimal system requirements.

Imagin: Neeta Wadiker
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What is an RTOS?

A real time operating system
(RTOS) is an OS that guar-
antees a certain capability
within a specified time con-
straint. There are two types
of RTOSs—hard and soft.

Consider an automated
assembly line that makes
use of robots for assembling
a ceiling fan. The robot will
be required to place the ball
bearings of the fan at the
precise moment when each
fan reaches a specific posi-
tion at a certain time inter-
val. In a hard RTOS, if the
calculation could not be
performed for making the
ball bearing available at the
right time, the OS would ter-
minate with a failure. For a
soft RTOS, the assembly line
would continue to operate
even though the fan is miss-
ing ball bearings. This is bad
because the productivity of
the whole assembly line is
lost. Generally used OSes
like Microsoft’'s Windows
2000 or IBM’s OS/390 can
be considered as RTOSs
since they satisfy some con-
ditions of an RTOS. Howev-
er, they do not meet all the
requirements of an RTOS.

In general, an RTOS has
the following features:

B Multitasking

B Process threads that can
be prioritised

B A sufficient number of
interrupt levels

RTOSs are usually
employed in small embed-
ded operating systems that
are packaged as part of
microdevices like micro-
processors.

The major difference
between embedded sys-
tems and RTOSs is that
embedded systems are
basically platform-less sys-
tems, that is, they do not
use any operating system,
whereas RTOSs work on
specific OSes.

Most of the embedded systems in automo-
biles are rugged in nature, as most of these sys-
tems are made up of a single chip. Other factors
aiding their use are the low costs involved, ease
of development, and the fact that embedded
devices can be networked to act as sub-modules
in a larger system. No driver clashes or ‘system
busy’ conditions happen in these systems. Their
compact profiles enable them to fit easily under
the cramped hood of a car.

Embedded systems can be used to implement
features ranging from adjustment of the sus-
pension to suit road conditions and the octane

built-in management functions. And they will
also be connected to the Internet in most cases.

Real time OSes will work wonders when it
comes to intelligent houses. The huge advantage
they have over desktop OSes is their low cost.
This factor alone can keep desktop OSes out of
the running, but there are other reasons as well.
An intelligent house may have more than 50 dif-
ferent devices in it. Imagine the cost of licensing
that many copies of Windows 2000! Also, RTOSs
are capable of being inter-networked, which
enables co-ordinated functioning between
devices at a scale that is unimaginable if desktop
OSes are used. Imagine getting
scalded while having a hot show-
er—all because of an OS ‘freeze’
or ‘crash’. Ouch!

The doctor will see you now
Imagine a time when body trans-
plants like cardiac pacemakers
will be able to monitor and man-
age themselves remotely. These
systems will be so compact that
the patient wouldn't even be
aware that they are embedded in
his body. Another point in favour of RTOSs is
their stability, instantaneous response and effi-
ciency. No OS crashes or delays in responding, as
is the case with most desktop OSes. After all,
which patient can rest easy with the thought of
his life literally hanging by a thread due to the
time taken by the OS to load!

Embedded technology advances are pointing
towards the use of pacemakers that can be trans-
planted in or near the heart itself. The pace-
maker will be able to monitor parameters like
blood pressure, blood flow, pulse rate, tempera-
ture, etc, using microsensors planted in various
parts of the body. This capability will enable the
pacemaker to automatically vary its operation to
suit the changing body conditions. It will also
transmit data using wireless transmission, thus
enabling a doctor to constantly monitor its oper-
ation. In most cases, wireless transmission is
likely to be done by a transmitter implanted near
the surface of the skin. In case any abnormality
is detected, the doctor will be able to take reme-
dial action even from a remote location.

Embedded systems inacar

content in the fuel to antilock braking systems
(ABS) and security systems. Speaking of things
nearer home, the ‘computer chip’ that controls
fuel injection in a Hyundai Santro or the one
that controls the activation of air bags in the
recently launched Fiat Siena Weekend is noth-
ing but an embedded system. Right from brakes
to automatic traction control to air bags and
fuel/air mixture controls, there may be up to 30-
50 embedded systems within a present-day car.
And this is just the beginning.

Home is where the chip is

How would you like to live in a house that recog-
nises your fingerprints and opens the front door
automatically? Imagine a fridge that checks your
food supplies and places orders to replenish
them; or intelligent lights and air conditioners
that adjust their settings automatically according
to the light and heat available at various times of
the day. What about a microwave oven that can
send a message to your PDA saying that the cake
you kept to bake is done? These are all possible
in the near future. In fact, many of these devices
have already made their debut using embedded
systems for controlling them and the Bluetooth
technology for communication.

Homes of the future will employ embedded
technology devices to become ‘intelligent’. An
intelligent house is essentially a network of smart
devices, which could be a fridge, TV, microwave
oven, washing machine or any of the numerous
domestic appliances that we use at home. They
will be able to optimise themselves or report
maintenance problems to technicians using

Wired wearables
A mobile phone in the form of a ring or a ear-
ring? What about cool sunglasses, with stream-
ing video displays built into them? All these can
soon be a reality. Embedded systems have a small
footprint and consume very little power, which
makes them ideal for wearable computing appli-
cations. The minimal system requirements of
these devices ensure that the hardware is almost
microscopic.

IBM is already working on the prototype of
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What goes into
an Embedded
System?

An embedded system is
any device controlled by
instructions stored on a
chip. These devices are
usually controlled by a
microprocessor that exe-
cutes the instructions
stored on a Read Only
Memory (ROM) chip.

One of the most popu-
lar Real Time Operating
Systems (RTOS) in use
today is QNX (pronounced
‘queue nicks’). It is used for
everything from medical
instrumentation and moni-
toring nuclear reactors, to
traffic lights and industrial
process control. In fact, it is
so widely used that we use
devices having QNX several
times a day without being
aware of it.

QNX makes use of a
micro kernel as opposed to
OSes such as Windows and
UNIX, so system level func-
tions such as device drivers
are not part of the system.
The kernel contains a mini-
mum number of features
for implementing basic sys-
tem calls. These include
message passing along
with other interprocess
communication, interrupt
handling support, and
other features. The other
functions of the operating
system are provided
optionally and modularly
through processes that
communicate mostly
through message passing.
Message passing is a two-
way asymmetric synchro-
nised exchange of data
between two processes in
the OS. It is called asym-
metric because one of the
processes must be a
‘sender’ and the other must
be a ‘receiver’ for passing
to take place.
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Embedded systems can completely change the way pacemakers operate

a mobile phone that can be worn as jewellery.
The components of the phone will be distrib-
uted among different pieces of jewellery—ear-
ring, necklace, ring and bracelet.

The phone is likely to have Bluetooth capa-
bility built into it. The earrings will have embed-
ded speakers and will act as the receiver. The
necklace will have embedded microphones that
will act as the mouthpiece users can talk into.
IBM calls the ring part of the phone the ‘decoder
ring’ Light emitting diodes (LEDs) will flash to
indicate an incoming call. The ring will also have
features that will enable it to be programmed to
flash different colours for a particular user or to
indicate the importance of a call. A video graph-
ics array (VGA) will be built into the bracelet,
which will display the name and phone number
of the caller. The bracelet will also integrate the
keypad and dialling functions in it. IBM plans
to incorporate voice recognition technology for
dialling a number. The phone may also have fea-
tures to indicate new e-mail.

Don’t keep your eyes on the road
Embedded systems can also make driver-less
vehicle control a reality. Major automobile man-
ufacturers are already engaged in work on these
concepts. One such technology is Adaptive
Cruise Control (ACC) from Ford.

ACC allows cars to keep safe distances from
other vehicles on busy highways. The driver can
set the speed of his car and the distance between
his car and others. When traffic slows down,
ACC alters vehicle speed using moderate brak-
ing. This ensures that a constant distance is
maintained between cars. As soon as traffic
becomes less, ACC moves up to the desired
cruise speed that has been set by the driver. The
driver can override the system anytime he wants
to by braking.

Each car with ACC has a microwave radar

Infographics: Mahesh Benkar
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unit or laser transceiver fixed in front of it to
determine the distance and relative speed of any
vehicle in its path. The ACC computer (what else
but an embedded system or a grouped system of
embedded systems) constantly controls the
throttle and brakes of the car. This helps to make
sure that the set cruise speed or adapted speed of
traffic at that time is not exceeded.

Another revolution is the way Internet serv-
ices will be integrated into the car. So when you
drive past your mechanic’s, you will be remind-
ed that your engine oil needs a refill, and when
you cross the city limits, the toll will automati-
cally get deducted from your bank account. And
while passing the shopping mall, your PDA,

T

o

A mobile phone that you can wear as jewellery

which is connected to the Net via the car, will
inform you about a new sale. In fact, the auto-
matic toll deduction concept is already in effect
in several countries around the globe.

All these application areas are just tiny drops
in the big ocean of embedded systems technol-
ogy. These proverbial ‘Davids’ are all set to con-
quer a world that is forbidden territory for the
popular desktop OS ‘Goliaths’ So wait with
bated breath for the fireworks to come. They are
sure to blow your mind.fl
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SIZE it up!

MOHAN KRISHNAN regular software such as Word
and Excel. Others have even cov-
ou can't just call them per- ered personal entertainment with
sonal digital assistants any  built-in MP3 players and support
longer. Most PDAs now offer  for watching movie clips. Here’s a
Internet connectivity and look at some next-generation

come with pocket versions of your  handhelds.

Sony Clie PEG N-710C
Pure Entertainment

The Sony Clie is not just a PDA, it's also a personal enter-
tainment organiser, with an in-built MP3 player, audio

software and a high-resolution reflective TFT colour
display (320x320 pixels) screen that can even be used

for watching movie clips. The 33-MHz Motorola

Dragonball VZ processor with the Palm OS forms
the basic framework for this device.

Web site: www.sonystyle.com/micros/clie

Compaq iPAQ Pocket PC
Packed to Perfection
- L It's light, quite light, at just 178.6 grams, but with a 206
MHz Intel RISC processor under its hood, the
Compagq Pocket PC promises to zip
through e-mails, schedules, MP3 files
and digital photos. Standard Pocket PC
« versions of office suites are available, as
also support for 4,096 colours at 12-bit
(240x320 pixels).
Web site: www.compag.com/products/IPAQ
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HP Jornada 720
PDA Powerhouse

A convenient PDA that also provides Internet connectivity, the HP
Jornada 720 sports a 206 MHz processor with 32 MB SDRAM and

also offers 2D graphics acceleration. There’s an in-built 56K
modem, and also USB support. It weighs 510 grams and comes

with the Pocket Office suite. The 6.5-inch colour display is capable

of 65,536 colours and a maximum resolution of 640x240 pixels.
You can also record notes using the built-in voice recorder.
Web site: www.hp.com/jornada

Psion Revo Plus

Mobile Internet Organiser

At 200 grams, this mobile organiser doesn’t weigh you down
even though its loaded with features. Revo Plus comes with an
ARM 710 core running at 36 MHz. It includes standard features
such as a calculator, scheduler, alarms, etc, and you can specify
different alarms that will set off at the appropriate times. Colour
display is still missing in the 4800x160-pixel resolution. You get
e-mail as well as WAP connectivity with this PDA.

Web site: www.psion.com/revoplus
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Nokia 9210 Communicator

Talk Mobile

The Nokia 9210 Communicator uses the EPOC (from
Symbian) platform and 3G technology for much of its
mobile functions. The Communicator provides up to
4,096 colours and comes with word processing,
spreadsheet and presentations software. Other fea-
tures include mobile e-mail, WAP and mobile multi-
media. This sleek gadget weighs in at 244 grams.
Web site:
www.nokia.com/phones/9210/index.html

Palm m505
Palm Time
An LCD screen with support for 65,000 colours, expansion
card slots and the Palm OS 4.0—these are some of the best
features of the m505. If you have
access to data-enabled mobile
phones, you can also use the
connectivity software to get onto
the Net, use SMS or access
e-mail. You also get Pocket
software to aid you with
standard document applica-
tions.
Web site: www.palm.com/
products/palmm505

Ericsson Communicator Platform
All-round Communication
The Ericsson Communicator Platform is based on
EPOC. It has an in-built GPS receiver for positioning
information and works on GSM technology. Inter-
i net is accessible through WAP as well as HTML.
There’s also an in-built Bluetooth chip for wireless
connectivity with other devices. The Communica-
tor comes with a colour touch-screen and the
interface is designed for easy accessibility.
Web site: www.ericsson.com

Visor Edge
Spring 1t On
Its USB cradle makes synchronising
the Visor Edge quite a simple task. It
also has the Springboard expansion
slot, which allows you to add devices
and change the very nature of your
handheld. The Visor Edge runs on
the Palm OS, so you can install all
the popular software for the Palm
0OS. There is a 33 MHz Motorola i

Dragonball VZ processor with L L

8 MB RAM. : . .

Web site:
www.handspring.com/
products/visoredge
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If you, like Microsoft,
believe that .Net is
going to change the
face of computing,
get a certification in
this platform and join
the revolution
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MANU KHANNA
he last time Microsoft did something from
‘scratch’ was in 1990 when it launched a new
‘ghost’ operating system which, unlike its
predecessors (the DOS family), could be

operated by a device called the ‘mouse’. This ghost

OS was Windows 3.0. Since then, Microsoft has

just been improving (still improving!) its OS by

adding more features to make it more user-
friendly.

Finally, 11 years later, Microsoft has launched
.Net, which, if all goes well, is going to change the
way computer users go about their work. Simply
put, .Net is a new operating system platform that
aims to take users to the next generation of the
Internet. It plans to do so by conquering the defi-
ciencies of the first generation, which is the pres-
ent-day Net, and by giving users a more enriched

experience when they work with the Web for both
personal and business applications.

The story so far

Necessity is the mother of invention, and so it
is in this case. .Net is an invention that was
fuelled by the idea of making distributed com-
puting the next ‘Giant Leap in Technology’ after
the Internet.

In the distributed computing model, compo-
nents and objects belonging to one application
can be located on different computers as long as
they are connected via LAN or over the Internet.
For example, a spreadsheet application could
have the Main Editor on one computer in India,
an Organisational Chart Object on a second
computer in the US and a Standard Deviation

Ieyuag ysauep :uomensn|||

Object on a third machine in England. Sure, that =¥
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What is available?

Following are the courses
that have been released by
Microsoft to its training part-
ners across the world.
Course 1905: Building XML-
based Web Applications
Description: Training on
how to structure and vali-
date data in a document by
using document type defini-
tions (DTDs).

Course 1913: Exchanging
and Transforming Data
Using XML and XSLT
Description: Techniques for
exchanging and transform-
ing data using XML and
XSLT. Best practices for using
XML and XSLT by giving
compelling examples of the
best ways to solve real-
world problems.
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sounds cool. Wait, there’s more. Some distrib-
uted computing systems would be such that each
of these three computers could actually be run-
ning a different operating system!

To put itin a nutshell, .Net plans to erase the
boundaries that exist between applications and
the Internet. Instead of interacting with an
application or a single Web site, .Net will con-
nect the user to an array of computers and
services that will exchange and combine objects
and data.

Big deal! What do I get out of it?

Thanks to the unpredictable ‘blue screens’ and
amillion other shortcomings that have been an
integral part of all its software products,
Microsoft has always been criticised. But still,
Microsoft products are the obvious choice for
new computer users. In fact, most home, SoHo
and even enterprise users don’'t know of any OS
other than Windows. Even today, it’s virtually
impossible for most people to name a word
processor other than MS Word. So, in .Net’s

The demand for .Net
professionals is going to increase
by leaps and bounds once
Microsoft releases the first .Net-
based operating system

known as MCSE, is a networking course where-
in a student is imparted training on installing,
configuring and administering the Windows
2000 operating system.

On the other hand, the Microsoft Certified
Solutions Developer or MSCD is a program-
ming course and deals with developing cus-
tomised software and solutions for the business
or SoHo community. For example, after com-
pleting the MCSD course one could use MS SQL
or Visual Studio to develop inventory control
software for, say, a large production house. After
this certification the student can also administer
and manage databases with the SQL knowledge
that he/she has acquired.

.Net is also a programming course and to a
certain extent can be called the successor to
MCSD. Till now Microsoft has not announced a
replacement for the current MCSD track. How-
ever, it might do so in the future. So the best bet
for someone who is interested in getting a pro-
gramming-based certification is to go in for .Net
rather than MCSD.

The reason for this is
quite simple: if and when
Microsoft disbands MCSD,
the demand for MCSD pro-
fessionals is going to
decline. In such a scenario,
most MCSD professionals
will end up spending huge
amounts of money and,
more importantly, time to

Karrox Technologies

case as well,
people are likely
to accept it with
open arms.

According to
Nua Internet
Surveys, by the end of last year, the number of
people connected to the Internet was 407.1
million. To develop software that is stored
online for so large a community, a massive
number of programmers would be required—
something that Microsoft knows it cannot
handle by itself. Therefore, it has introduced a
certification programme to enable people
other than its own employees to use its source
code to develop applications for .Net. Once
you complete this certification, you will
become a certified professional in this
platform.

So is MCSE/MCSD Dead?

No it isn’t. Microsoft has broadly bifurcated its
training and certification into networking,
applications and development. The Microsoft
Certified Systems Engineer course, popularly

upgrade their skills to the
.Net platform.

Tools of the trade

As with most certification programmes, there is
no fixed minimum requirement that has been
laid down for the .Net certification. According
to Jitendra Nair, vice president (Software Edu-
cation Division) of Karrox Technologies,
“Though Microsoft hasn’t defined any fixed
criteria for .Net exams, we at Karrox believe
that at the very least the student should be a
graduate as it becomes easier for him or her to
comprehend the technology that is being
imparted.”

This isn’t all. The .Net platform will be used
to develop Web-enabled e-commerce and
m-commerce applications, which will incorpo-
rate XML as an industry standard interface for
exchanging information. So the minimum
requirement for taking the exam would be to
acquire a thorough knowledge of XML and also
of WinForms, C#, ADO.NET and ASP.NET.

Itis also recommended that you have knowl-
edge about software servers that facilitate
creation of distributed and scalable applications.
These include BizTalk Server (for B2B
applications), Commerce Server 2000 (for B2C
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applications), 11S 5.0 Web Server, Exchange 2000
(messaging server), SQL 2000 (database
server), etc.

The Facilitators
Going by the requirements, you are probably
getting a fair idea of the scope and vastness of
the .Net platform. But don’t think that this is
something you can’t do on your own. You can.
The only things required are dedication and a
lot of hard work. Once you think you are ready,
you can walk up to the nearest Microsoft Pro-
metric Institute one fine day and crack the exam.
In case you think you can’t, there are people
and institutes that can help you. In India,
Microsoft has tied up with various institutes to
provide training to people who are interested in
.Net certification. One such institute is Karrox
Technologies. It is offering .Net as part of a com-
prehensive modular career program called
K-Map that spans four semesters. Karrox is not
the only one. NIIT and APTECH are also offer-
ing .Net certification courses.

That’s it then

Now comes the all-important question—what
about job prospects? .Net is still in its nascent
stage in India. Still, one thing is certain. Sooner
rather than later, the demand is going to build

up. Nair adds, “The initial intent is there. Com-
panies are ready to absorb .Net professionals.
The demand is going to increase by leaps and
bounds once Microsoft releases the first .Net-
based operating system, which it should by the
end of 2001.”

Employment avenues aside, another issue of
concern is the remuneration that will be
offered. This is because we Indians have this
really bad habit of going and doing the same
course that our neighbour did. As a result of
this, 1,000 job seekers might line up for 50
vacancies. Because of this excess supply in rela-
tion to demand, those who finally do get the
jobs will end up working for half to one-fourth
of what a .Net professional would get in the US.
This has happened in the past with jobs relat-
ed to MCSE/MCSD, Java certification, etc, and
it just might happen again.

In any case, if your basic programming con-
cepts are clear, then you should be able to decide
whether or not .Net certification is the thing
for you.

Visit www.microsoft.com/downloads and download
the software (if you have lots of bandwidth, that
is) along with the documentation. Play around
with the software and let that help you make up
your mind about whether or not to go in for the
.Net certification.f

Try it out!

Here is a glossary of some
of the technical terms

C#: Pronounced as ‘C
sharp’, this is a simple,
object-oriented, and type-
safe programming language.
C# is firmly planted in the C
and C++ family tree of lan-
guages. C# aims to combine
the high productivity of Visu-
al Basic and the raw power
of C++.

ASP.NET: A revolutionary
new programming frame-
work that enables the rapid
development of powerful
Web applications and servic-
es. Part of the emerging
Microsoft .Net platform, it
provides the easiest and
most scalable way to build,
deploy and run distributed
Web applications that can
target any browser or
device.
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Graphic images of impending storms, other defence needs during the ColdWar are now affecting our
i i daily lives?So much so that we d eave our house for a trip
Instant reportmg of events from - to the '_x_‘- hill station before:seeing the latest weather report
remote corners of the world, receiving beamed dowsto us by our ‘friend from up above —the INSAT 11B
quality radio broadcast even when you ~ satellite. 2 " 8
are on the move...welcome to the

world of satellites

f i c p tes :WhICh collide to cause earthquakes. These
dlf'flcult to record because the plates move just

S every year.

logists at the California Institute of Technology and the

- Japane
.,’Lfeﬁ’ bal Positioning Systems (GPS) to accurately predict an
'j:ll - earthquake a few hours before it actually strikes, Ihug plcexenyng !

;‘.‘,J  loss of thousands of lives.=:%7777711 1) 13
; Solaf—poweréd receivers and antennas are pIaced in quake-
prone regions. They transmit their positions through signals,
which are sent out every 30 seconds or so, to two or more satel-
lites in orbit. Researchers and scientists use the results to try and
predict when the stress building between plates is likely to culmi-
nate into an earthquake in a particular region.

GPS locks into air traffic
November 1996: Midair collision over India. Over 300 feared dead

The exponential growth in the sheer volume of air traffic over
the last decade has led to a number of new challenges for the exist-
ing air traffic control infrastructure. Managing the progress of
each individual aircraft is currently done by tracking them using
a combination of high-frequency radio and radar networks.

Boeing has put forward an audacious plan that proposes to
replace radar with GPS-based satellite tracking. GPS receivers can
pinpoint their location with a great degree of precision by trian-
gulating signals from any of the 24 NAVSTAR satellites that orbit
the earth. This really precise information can then theoretically be
used to reduce the separation between aircraft and plan more
direct routes to a destination.

Plans include using a constellation of 16 satellites in a 12-hour
medium earth orbit (MEO) at the same altitude as the NAVSTAR
GPS satellite system. Such a large network would help ensure that
any airplane or air traffic control terminal is within the view of at
least two satellites, so that in the event of a satellite failure, an adja-
cent satellite can ensure seamless service.

-
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The US-based FAA and cargo airlines such as
UPS and FedEx are already testing the feasibili-
ty of GPS-based alternatives, which can help
increase safety and efficiencies in controlling air-
craft arrivals and departures. Using new digital
tools, pilots would be able to get precise infor-
mation from their cockpit displays about their
position, the positions of other planes and maps
of a particular airport and its runways. This
would be enabled by a combination of satellite
positioning technology and digital datalinks
between aircraft.

If Boeing and the others can convince the scep-
tics that this system has to be adopted, it will
become necessary for each and every one of the
world’s 14,000-plus commercial jets, military and
private aircraft to have a costly receiver installed.
The likelihood of this happening in the immedi-
ate future seems remote, but over the long run
satellites may be the only way to enable aircraft to
fly more safely, ease congestion, and prevent flight
delays that seem to be an everyday occurrence.

The new radio

Most of the applications for satellites have tradi-
tionally been centred around communication,
whether you consider the extremely successful
services for consumers like television broadcast-
ing, moderately successful ones like satellite-
based Internet access, or ones that just did not

Car Watcher

Beware, all car thieves!

US-based Seaguard Electronics and Direct-
ed Electronics have developed Valet Car Com
I, a system designed to provide a Web-
enabled theft tracking system that can be
accessed from any PC connected to the Inter-
net. So if your Maruti gets stolen, just use this
cyber ‘valet’ to track down the missing car.

take off—like the Iridium telephone communi-
cations network.

One new service that has begun to take off all
over the world is satellite radio. Radio has been
an extremely popular medium since before
World War I1. Even in the age of television and
the Internet, radio continues to be popular
amongst a wide range of audiences. Traditional-
ly, the problem areas for radio have been the
quality and range of the broadcast. Despite the
popularity of thousands of stations that have
adopted the Internet as a medium for streaming
music to listeners all over the world, these issues
have not been resolved completely.

Satellite radio promises to deliver a solution
to both of these problems. It is probably the first
significant advancement in radio since the
arrival of FM more than 30 years ago. It offers
listeners access to their favourite programmes
while on the move, when they are out of range
of conventional radio stations. Picture this: stat-
ic free CD quality music from your favorite sta-
tion, beamed to you in your car, home, or
personal stereo—anywhere in the world. This
is going to be possible because digital technol-
ogy is actually being incorporated into the radio
receiver set itself.

Sirrus, XM Radio and Worldcast are the pio-
neers that are looking to bring satellite radio to
consumers all over the world. All of them will
probably use proprietary chipsets in their
receivers that will allow them to decipher the
encrypted broadcast signal. The signal itself will
be transmitted via a network of two or three
satellites and several ground-based repeating
stations.

These services are targeted primarily at car
radio listeners, who will have access to a large
selection of channels. The receivers are already
being offered by car manufacturers in the US,
including Ford, BMW and DiamlerChrysler, as
options on their newer models. Users will have to
pay a monthly subscription charge for the service,
which will include many commercial-free chan-
nels. However, several of the larger manufacturers
of consumer electronics like Hitachi, Panasonic
and JVC have introduced digital receivers for the
home device markets.

Future scope

Although a large number of people are already
dependent on satellites, mostly for communica-
tion, these ‘eyes in the sky’ are now going to make
an impact on our everyday lives in a more sig-
nificant manner. What kind of help will these
satellites render unto humankind in the future?
Even Nostradamus would have been hard-
pressed to answer this question. But what is cer-
tain is that we shall continue to become
increasingly dependent on these sentinels that
orbit our planet.fl

WorldSpace
becoming a Radio
Star?

In India, US-based broad-
caster, WorldSpace, first test-
launched its radio services
in Bangalore in September
2000. The company claims
that the response has been
quite positive. WorldSpace is
offering several models of
satellite radio receivers,
ranging from Rs 4,400 to

Rs 9,990.

They have signed up
with Radio Mid-Day and
AIR, in addition to other
popular international broad-
casters. WorldSpace also
creates some original pro-
grammes, including modern
rock and contemporary pop
hits as well as broadcasts
for children and adults.

Music, education and
entertainment programmes
in a multitude of languages
that include English, Hindi,
Tamil and Telugu are
beamed by the AsiaStar
satellite to subscribers
across Asia.
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Regional language
e-mail and chat are
here to enhance your
Internet experience.
So log on and reach
out...language is no
bar!
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sites dedicated to Indian art
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ANIL PATRICK R.

ired of hearing your grandma complaining

about how difficult it is for her to read your

angrezi e-mail? Don't fret, for help is at

hand in the form of various
sites offering e-mail in regional languages. Yes,
you can now send e-mail in Indian languages
like Hindi, Marathi, Gujarathi, Bengali,
Malayalam, etc.

Check out what technology has in store for
people who are more comfortable communi-
cating in their mother tongue.

Regional language e-mail sites

Some of the major Indian sites offering these
facilities are www.epatra.com, www.mailjol.com, www.red-
iff.com, www.mail sify.com, www.jagran .com, etc.

A US-based site, www.langoo.com, offers e-mail
in Indian as well as several international
languages. All these sites offer Hindi and
some even offer up to 12 or more regional
languages.

These sites make use of a technique called
transliteration for conversion of English char-
acters to regional language fonts (see box:
‘Transliteration’, for more details on how it
works).

Epatra.com
Epatra is one of the best Indian sites offering
regional language e-mail services. It currently has
11 regional languages on its menu—Hindi,
Marathi, Gujarati, Punjabi, Malayalam, Assamese,
Bengali, Tamil, Telugu, Kannada, and Oriya.
Registration is easy, after which you can start
firing e-mail in any (or all) of the 11 languages.
Epatra also has features like chat in regional lan-
guages, kamna cards, discussion forums, news,
etc (see box: ‘Get that Epatra Going’). To help you
compose your message in the regional language,
epatra has a typing assistant that shows you the
correct combination of English characters to get
the regional language character.

Mailjol.com

Mailjol is similar to epatra and also features 11
languages. It is easy for even a novice to figure
out the interface. Download and install the
software component, and you are ready to go.
The main difference in features between
mailjol and epatra is that in mailjol, you just
have to click on regional language characters
from a table for them to appear in the message.
It also features a typing assistant similar to the
one on epatra.
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Transliteration

The easiest way to write a
message in a regional lan-
guage is to type out the
words using the Engish
alphabet. For example, Aap
kaise hain? (How are you?).
Sites that offer the facility of
sending e-mail in regional
languages will then convert
this message into the ver-
nacular script.

This process of convert-
ing characters from one par-
ticular script to another is
called transliteration. In our
case, it would be the con-
version of the English (also
known as Roman or Latin)
script to Hindi or Telugu or
another regional language
script, and vice versa. It
should be clearly under-
stood that transliteration is
not the same as translation.
In transliteration, only the
characters are converted to
another script. There is a
strong possibility that factors
such as pronunciation,
meanings, accents, etc.,
would change if translitera-
tion methods are not prop-
erly designed and used.

A transliteration can
either be applied to a string
of text in one go, or can be
used incrementally for a typ-
ing and buffered output. For
example, let’s consider that
you want to have the word
‘Hello’ transliterated to
Hindi. For the Hindi equiva-
lent, you may have to type
in ‘Helau’. This is the string
of characters that gives the
Hindi script equivalent of
Hello after transliteration.
Different transliteration
schemes have different
string combinations.

Most transliteration
schemes work reasonably
well with Hindi, but are not
as efficient with other
regional languages.

Jagran—Hindi special

In case you need to send only Hindi e-mail,
check out this site. www,jagran.com offers the option
of sending mail only in English or Hindi. Regis-
tration is simple. The page will look unreadable
when you log on for the first time, but this is rec-
tified after you download the required fonts by
selecting the option, Download Hindi Font, and
then installing it.

One option for sending e-mail in Hindi using
Jagran is the Phonetic Style, which is the same as
transliteration and allows you to type the letter
in Hindi using English equivalents. You could
check the Show/Hide keyboard option when
you're composing a Hindi e-mail. This brings up
a Hindi keyboard below the mail being com-
posed. Positioning the cursor on each alphabet
will give you the English equivalent of the Hindi
alphabet. Above the Hindi keyboard is a dynam-
ic guide showing the different Hindi equivalents
based on the first alphabet you type.

Langoo.com—a global view
If you're looking for something more than just
an Indian language e-mail site, you must visit
www.langoo.com. This US-based site offers an
impressive array of Indian and foreign lan-
guages. In addition to Indian languages such as
Hindi, Tamil, etc, langoo.com also features Chi-
nese, French, Arabic, Russian, Greek and a whole
host of other languages. This is one of the best
sites for sending regional language messages and
the options offered are sure to make you linger
on at the site to check them all out.

You can even chat and send e-cards in your

oy PR i

Langoo.com: view it in the language you want

native language (provided, of course, it’s sup-
ported by the site). In fact, the whole site can be
viewed in your native language instead of in
English.

The best part about Langoo is that it does not
require you to install any new fonts, and using it
is child’s play. The language can be changed at
your whim. Hindi, Punjabi, Tamil, Farsi, Gujarati
and Urdu are the Indian languages currently
available on Langoo. A help list on English char-
acter equivalents for the regional language char-
acters is available under the text box where you
type in your message. This is a very useful feature
when compared to epatra and rediff, where the
alphabet usage lists appear only when you type in
the first alphabet.

So what are you waiting for? Select your lan-
guage, register, and start Langooing.

Get that Epatra Going

Click on the Sign Up link on the home page to
get the registration form.

Fill in the form and click the ‘Register me’ but-
ton at the bottom of the page. This takes you to
the next page along with a prompt, asking if
you want to download and install HlInstall.exe.
Click on the ‘Run program from current loca-
tion’ option and press OK. The font will be auto-
matically installed on your system.

Now go
to the bot-
tom of the
Web page
and log on
using your
password.
This takes
you to the
Inbox. Select the Compose option on the left-
hand side of the page to start composing your
e-mail.

Select the
language in
o1 whichyou want
| Ehm— . to write your e-
' mail. Click Go,

and start typing
your mail.

As you type the
first letter of an
alphabet, a help
table pops up,

s “——— 1 showing the cor-
o rect combination
of English charac-
ters required to
get the desired
regional language
character.
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Downloading and Installing Fonts

Except for langoo.com, most sites that employ transliteration

require special fonts to be installed on the PC for proper font dis-

play. These fonts have to be downloaded from the site. The

process of installing these fonts is simple enough, but it can be
quite a pain on a dial-up connection.

New Font.

In Add Fonts, select the
directory into which you
unzipped the font, and select
the font name. Click OK, and

directory.

A B M Toccklos b Sl Mo
D B A Fubks Tisbarre.

& Laorid it Dochans

(B Slgd Dowa S Winker Ui,

Problems that may crop up

Most of the problems that may crop up when
using regional e-mail services are related to the
fonts. At times, the fonts may not be clear or may
not be displayed properly. In such cases, try
installing the fonts again (see box: Downloading
and installing fonts). Problems may also arise at
the receiver’s end. He/she will not be able to view
the e-mail properly if the required fonts are not
loaded. Most of the services include a link on

Now go to Start > Settings >
Control Panel, and select Fonts.
Click File, and select Install =

A nin To install the fonts, browse through these

e | steps after you have downloaded the font. . =

7 o lita Lo Many of the fonts will be in zipped format. _In-—

o E:’_'j : Unzip the fonts, using an unzipping utility like ] et | I
i WinZip 8.0, to a particular i ez

their e-mail, which enables the recipients of
these mail to download the fonts directly from
the site. And do read the FAQ section of the site
as it will provide you information on rectifying
the problems that you will encounter.

So now you can make your e-mail as person-
al as you would a handwritten letter in your
mother tongue. And no more worries about
postal or courier delays either. Reach out and say
what you feel—anytime you feel like it!El

the font will be installed on
your PC.

In most cases, the fonts
may not be clear or may not
be displayed properly. Well,
the only solution to this is to
install them again.
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WELCOME TO MY HOME

Build it exactly the
way you've always
wanted to and watch
the world admire
your dream work.
We're talking about
constructing your
own Web site

56 HM

RINKI BANERJI

‘ ‘ hat a wonderful home you have!” You
hear these words and beam with
pride. Ever wondered about having
another home that could make you as

proud? Your very own Web site can have its

doors open 24 hours a day to visitors from all

over the globe.

Make it your dream home...

Once you have decided what your site is going to
be about, whether it will be a professional Web site
or a personal Web page, you might be fretting
about the labour and expense it might entail.
Think again! It’s actually simple, usually econom-

ical, and can become a rather interesting endeav-
our. On your personal Web page, you can upload
photographs of yourself and your loved ones. Tell
the world what an interesting and eventful life you
lead, by maintaining a personal diary that folks
from across the world can peek into around the
clock. Professional sites, on the other hand, are
centred on a business proposition. As Atul Garg,
an MBBS student who has built his own site
(www.atulrg.com) says, “Personal Web sites help
you gain an identity on the Internet, while profes-
sional sites help you make money.” Irrespective of
the purpose of your site, there are certain elemen-
tary issues that you will have to deal with when
you go about building your very own Web site.
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Domain suppliers

www.Directi.com

Offers domains for Rs 575. The site is also
credited with having a standardised
process for domain registration.
www.Vsplash.com

This domain name provider facilitates
domain registration at prices ranging from
Rs 399 to Rs 599.
www.Net4domains.com

Offers domains for Rs 525. The site also
provides banner exchanges, business serv-
ices, hosting, corporate mailing, etc.
www.123domainregistry.com

Offers real-time domain registration servic-
es for Rs 425 with 5 MB of free Web space.

Set Your Sights on Them

www.register.com

Offers domain name registration online for
prices ranging from $35 to $299.
http://domain.ncst.ernet.in

For registering India-specific domain
names ending with .co.in

International domain name registrars
ww w.domain-supplier . com, w w w.domain -
namesco.com, ww w.webdeveloper . com,
w w w.netcolaly . com,

W W W .getyourdomain.com

Site builders

www.geocities.com

Log on and surf through the instructions
for building your dream Web site. If you
seek a domain name from geocities.com,

you'll get it as www.geacities.
com/myname. Geocities assists you
through the entire process, right from cre-
ating your title and page designs (with
page builders and page wizards) to
uploading your site through a file manager.
www.tripod.com

Tripod provides 50 MB of free space and
has introduced new multimedia add-ons
to enhance the interactivity of your site.
www.homestead.com

This is a very user-friendly site builder with
easy tools and a site building software that
can be downloaded and used for design-
ing your Web pages and then uploading
them.

Location, location, location!

On the Internet your Web site address becomes
your identity. You can choose to use the URL
(Universal Resource Locator) provided to you by
your Web host, which might go like www.servi-
ceprovider.com/yourname. But if you are look-
ing for a unique identity then your first move
should be to register your own domain name.

There are several sites that offer these servic-
es, allowing you to register either online with an
international credit card or via a longer paper-
driven application process which allows you to
pay by cheque or demand draft.

You would have to cough up anywhere
between Rs 500 and Rs 1,000 to get your domain
name registered. You need to first make sure that
the name you have in mind has not already been
taken. Most of these sites (like ww w.register . com)
provide a search facility that helps you to settle
on a unique name for your cyber abode. Simply
hook on to the site and enter the domain name
you want in the search box to check if it is
available.

“When we were looking to register our
domain, we found a plethora of tempting offers
from various sites. We finally zeroed in on
net4domains, which registered our domain
name for Rs 575 for a period of two years,” says
Anup Nair, who owns an e-consultancy site.

Where do | host it?

Once you've decided on your domain name you
need to look for a place to host your site. This
means getting hard disk space on a computer
that is always connected to the Internet.

There are a plethora of sites such as geoci-
ties.com and homestead.com offering free Web
space to users. These offer anything between 25
and 50 MB of free space. But you would do well
to consult your friends and colleagues before you
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make your choice—some of these free Web space
providers can be quite unreliable and a lot of
them have shut down services recently. You
might end up staring at a blank page instead of
your dream cyber abode.

“The netfirms subdomain account of one of
my friends got permanently deleted when he did
not access it for nearly two months because he
had other urgent matters to attend to,” says
Anup.

Also, the free Web hosts might not be able to
provide you with some of the features that are
important for your site. “I purchased the domain
name from net4domains.com and secured 25
MB of free Web space. However, they do not
offer e-mail forwarding services for subdomain
accounts and all mail needs to be forwarded to
another e-mail address belonging to me. Besides,
you can't upload any file bigger than 1 MB,
which is a problem for me,” says Anup.

If you don’t want to avail of free Web space
because of the uncertainties and the strings
attached, you can buy server space from an Inter-
net Service Provider. Net4domains has packages
ranging from Rs 850 for a 2 MB student account
for one year to an economy pack which costs
Rs 5,500 for 15 MB annually. Hosting on a serv-
er located in another country (mostly the US and
Canada) can cost less and is usually a more reli-
able solution due to the higher bandwidth avail-
ability in those countries.

L=

Looking for an architect?

Now that you've got a name and place for
your site, you can either outsource the entire
development process to a pro-
fessional Web developer
or employ your musty
gray cells to read up on
the basics and then : -
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Working with
FrontPage

Microsoft FrontPage is a
Web designing software that
offers a WYSIWYG (what-
you-see-is-what-you-get)
effect. Start with a new file
from File > New. Give an
attractive heading, say, ‘Wel-
come to my Web Abode’.
Select the text and right-
click to set the theme for
the page. Select from vari-
ous effects such as banners,
artsy, blends, blueprint
effects, etc. The Modify but-
ton allows you to change
the graphics, colours and
text. Next, list the topics you
wish to cover about your
business, say, company his-
tory, achievements, mission
statement, sister concerns,
company news, and services
offered. You can create links
for every topic by selecting it
and right-clicking for the
hyperlink option. All you
need to do is enter the
name of the file for the link
to the page where the
details are provided.

Using tables helps to
organise the elements on
your Web page and facili-
tates downloads. Just
choose the Table > Insert
Table option from the menu
bar. Enter the number of
rows and columns for your
table. The Insert menu offers
plenty of options such as
components (hit-counters,
hover button, marquee, ban-
ner-ad manager, scheduled
pictures, etc), forms (check-
boxes, text fields, radio but-
tons, scrolling text box,
drop-down menu, etc), and
advanced features such as
plugins, ActiveX controls,
Java applets, etc. It is easy to
embed Flash files in your
document. Create your .swf
and .html files and then
copy and paste both the files
in the page field of your
html editor.
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build your own site. Professionals could charge
up to Rs 50,000 to design a fairly comprehensive
site. This usually includes the cost of the design-
ing and programming involved.

If you decide to do this all by yourself then
creating your own Web site will entail a major
investment of your time, energy and patience.

A lot of the free Web hosting services offer
you Web-based wizards that can help you build
your site. All the options for page designing,
hosting, and uploading are available through
simple clicks. If you have created your own Flash
or JPEG files, you can add your own look to the
standard design templates available on the sites
of these free Web space providers.

Doing this all by yourself would involve
learning how to use a host of designing applica-
tions such as Macromedia Dreamweaver,
Microsoft Frontpage, Adobe Photoshop, Macro-
media Fireworks, Adobe Imageready and Macro-
media Flash. Most of these applications can take
a while for newcomers to get a hang of.

Be careful that you don't go overboard with
those fancy images or you may end up with a page
that downloads at a snail’s pace. You need to con-
sider the space your site would occupy and the
size of each page. You can optimise your graphics
images by using the ‘Save for Web’ option in most
imaging software. The GIF and JPEG formats are
most popular for simple graphics on the Web.

Ensure that the images and the content are
appropriately designed for your site.“l had to work
a lot on the logo for my site. In fact, it took me a
whole week to get that formal look that is so cru-
cial for a business-oriented Web site,” says Anup.

Using CuteFTP

The entire process involves typing in your
host name (ftp.yourhostname.com), user 1D
and password with the host where your Web
site resides, and then dragging the index.html
(main page) and all other relevant files and
folders from your local disk to your space on
the server. After you have all the relevant files
ready to be uploaded, you simply have to
click on the option indicated by an up-arrow
sign to transfer your files from your local disk
to your server on the Web.

“Designing is not just about using sophisti-
cated applications—you have to use them the
right way and for a genuine purpose. The site
should have the right ‘look and feel’ to be able to
hold the visitor’s attention,” says Sunando Baner-
ji, who works at Netguru.com.

Launch pad

Now that your Web site is ready, you need to
upload it onto the World Wide Web. For free
Web site providers such as Geocities.com and
freeservers.com, you can simply upload the files
using their Web-based file manager. It allows you
to browse for the files on your hard disk that can
then be uploaded to the server by clicking a sin-
gle button.

A more efficient solution could be using one
of the numerous FTP clients that allow you to
transfer files via a Windows Explorer-like inter-
face. In fact, Windows 98 allows you to use
Explorer to transfer files via FTP.

However, a dedicated FTP client would offer
you a lot of features such as the resume function
that can be quite useful. CuteFTP is one of the
simplest and most popular applications for
uploading files onto the Net but others like FTP-
pro and WS_FTP are quite proficient too. “FTP-
pro isa very user-friendly and reliable FTP client
and | have been using it for quite a long time
now,” offers Sunando.

Spreading the word

Once your site is up and running, you will
probably want to publicise it by registering your
domain name with the more popular search
engines such as yahoo.com, altavista.com,
google.com, webcrawler.com, lycos.com, and
infoseek.com. You can submit your site to these
search engines for free. Log on to
w w w.searchengines. can/urlsubmission. html for
more information about search engines on the
Net. The other option is to use software such as
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The Right Ingredients

You can enhance your site with interactive features. Links such
as ‘Contact Us', ‘About Us', ‘Disclaimer’, etc, give the user a gener-
al idea of your Web site and can induce him to either surf
through it or out of it.

The ‘Contact Us’ link should include your official e-mail
addresses where the user can post his queries and complaints,
and offer feedback on your content, products or services. Never
display your postal address on your site—it can be misused.

The ‘About Us’ link should offer company details and a brief
description of what your Web site offers.

The ‘Disclaimer’ notice is a legal document that limits your
responsibility for the content, products or services offered
through the site.

Submitta, which allows you to save time by submitting your site to
a number of different search engines.

Other ways of increasing traffic to your Web site could include a
co-branding arrangement with other popular sites, advertising in
popular chat rooms that will provide links to your site, or just simply
e-mailing your Net buddies to check out your site. You can also use
services such as SmartClicks (www.srertage.com) that allow you to
exchange banners with other members of a huge network.

What else can | add to the site?

Other than the basic Web pages that make up your site, there are sev-
eral other elements that you can include to make it more interesting.
Add a free search engine (using metatags) or maybe a chat room or
message board (look at the ones offered by www.beseen.com) that
provides people a forum to interact. Another important feature that
you would want to add is a Web counter that would help you track
the popularity of your Web site. Most of the Web hosting services
offer basic counters and search features as free features.

Keeping it ship-shape

Just remember that Web site maintenance is a very essential chore.
After all, you don’t let your brick-and-mortar home run to seed. Your
cyber abode will require some looking-after as well. Be prompt when
it comes to maintaining your Web site.

The more complex your site gets, the more difficult it will be to
maintain it. You need to be diligent and resourceful to tackle those
frustrating times when your ISP fails you, when you have problems
using your FTP client, or (God forbid!) the server crashes. Updat-
ing your site on a regular basis and maintaining consistency in your
content are the surest ways to attract visitors and keep them hooked
to your site.

Put out the welcome mat
Well, as you can see, making Web sites is not really a big deal. As
long as you are clear about certain key issues such as whether to go
in for a free domain or buy it from free domain name providers;
the kind of facilities you want your site to have; how you want to
promote your site to increase traffic, etc.

So get a head start with this new exciting venture. And get ready
for the muhurat of your very own cyber home.Fl

Have insights to share on creating your own Web site?
Write all about it to readersletters@jasubhai.com
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Two Web-based
applications,
GoToMyPC and VNC,
let you control your
PC from any other
computer that is
linked to the Net

Control kar

ALISAGAR PARDAWALA
hat if someone were to give you a magic
wand and say, “Wave this wand three
times over any computer in the world and
it will magically turn into the PC you have
at home.” Well, no such wand exists. But if you
are really in need, there is a substitute—in the
form of PC-controlling programs and services.

The aim of a PC controlling suite or service
is to allow a person sitting at one machine (the
local machine) to access another machine
somewhere else (the remote machine). Once
connected, the mouse and keyboard of the local
machine can be used to control the desktop,
applications, services and configuration of the
remote machine.

Imagine how useful this can be if you want a
technician to solve your computer problems
without having to pay you a visit, or if you're
abroad and need to access files lying in your PC
at home or at the office.

Virtual Network Computing (VNC)

AT&T’s VNC is one of the most popular PC-
controlling software around, and that is not nec-
essarily because it’'s free. It is completely
platform-independent, so while the local
machine runs on Windows, the remote machine
can have a different architecture, say Unix. VNC
is available under the GNU Public License,

Photographs: Rahul Sharma Imaging: Ram

which means the program as well as its source
code are obtainable for free.

The software is extremely easy to install and
use. There are two components in the package:
WinVNC is the software that has to be set up on
the remote machine and VNCviewer is the soft-
ware that is used on the local machine.

VNC'’s performance is excellent. It runs quite
smoothly even from a dial-up connection and
makes it extremely easy to make and break con-
nections. So you can start a task, terminate the
connection, and then come back later to check
if the task is complete.

m YN tirwns |m :.:I| s i
[ e e el |
e areged

Dinberdtadrioliine gy Qoo |

Use the VNCviewer to connect to the remote
machine

VNC is quite good for accessing a machine
over a LAN, but you can also use it to access
machines over the Internet. To do this, you
would have to know the unique static IP address
of the machine you wish to access. Good points
apart, VNC is not perfect. It does not have the
facility to directly transfer files between the
remote machine and the local machine.

yaar!

Setting up WinVNC

Step 1. Download the package from
www.uk.research. att.com/vnc/download.html. Run the
Setup program to install WinVNC on the
remote machine. When you run WinVNC for
the first time, you will be asked to set a pass-
word. The program will then run as an appli-
cation in the system tray. The machine is now
ready to accept connections.

Step 2: Copy the VNCviewer program on to the
local machine and run it as an application. You
will be prompted for the host name. If you are
not on the LAN, you will have to enter the
unique IP address of that machine. Click OK,
and you will be prompted for the password
you set.

Voila! A window opens, showing the con-
tents of the remote machine. The remote
machine will now respond to the local
machine’s mouse and keyboard.
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Vital Stats

GoToMyPc

Price: $19.95 per month

Web site: www.gotomypc.com

Download size: 1.35 MB for the server, 200
KB for the viewer

Platforms: Windows 9x/NT/2000

Virtual Network Computing

Price: Free

Web site:
www.uk.research.att.com/vnc/download.html
Download size: 978 Kb

Platforms: Windows 9x/NT/2000, Linux, Unix,
Sun Solaris

Accessing VNC using a Java-enabled browser
As an alternative to using the VNCviewer, you
can also access the remote PC from any stand-
alone Web browser that supports Java, like Inter-
net Explorer. All that’s needed is the machine
name/IP address and the port (by default, this is
set at 5800).

GoToMyPC
Expertcity’s GoToMyPC allows you to control
your PC from a remote location anywhere in the
world, as long as you have an Internet connec-
tion and a Web browser. What sets GoToMyPC
apart from other PC-controlling software is that
itis a service instead of a specific software.

The best part of this Web-based service is that,
unlike with most other services, you do not need
a permanent IP address for the computer you
wish to have control over. Simply register with the
service and download a very small client program
that rests in your system tray. Since a static IP
address is not required to use this service, it
is ideal for people who need to access
their PC but don’t know the technical
properties of the network to which
it is connected.
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Expertcity had originally started GoToMyPC
to help out its technical support team, so that it
could remotely help customers with their prob-
lems, without having to go on-site. But then, real-
ising its potential, it made GoToMyPC a public
service for anyone who wanted to connect to his
or her PC from anywhere. Until May this year,
Expertcity was offering the free beta version of
GoToMyPC. But now the company has decided
to charge a monthly fee of $19.95 for a single user.

Set it up now

Step 1: Log on to gotomypc.com. Register to set
up your account. You will need to give your cred-
it card information after which the GoToMyPC
software will be downloaded and will assign the
remote PC an access code, user name and pass-
word, which is chosen by you.

Step 2: From the local machine, log on to goto-
mypc.com. Hit the connect button next to the
nickname of the remote machine. A tiny 200-KB
plugin will be downloaded automatically. This
plugin lets you connect via your Web browser
to the remote machine on which the GoToMyPC
software has been installed.

WL The remote machine will
. respond to the local
machine’s monitor, key-

board and mouse.Fl
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Should I go in for
GoToMyPC?

This, of course, depends on
the kind of use you would
have for a service like this and
whether you are willing to pay
for it. There are lots of useful
things that GoToMyPC allows
you to do. The draw mode
lets you draw anything on the
remote machine’s desktop
with the mouse. The in-built
chat applet lets users talk.
These could be immensely
useful to technicians in high-
lighting areas of the screen
and indicating things to the
customer without being physi-
cally present.

A unique feature is the
support for two-way file
transfers. GoToMyPC does
not use the conventional
method of transferring cap-
tured video from the remote
machine to the local
machine. Actually, it uses a
compression algorithm that
efficiently transfers data.

One of the biggest disad-
vantages of GoToMyPC is
that it is dependent on the
speed of your Net connec-
tion. Even at 56 Kbps, there
can be up to a 30-40 second
lag between the two
machines. Also, it only sup-
ports the Windows platform,
though plans are underway
to release a cross-platform
version.

Another consideration is
security. Even though it pro-
vides 128-bit encryption, it is
not as secure as software
such as Symantec’s
pcAnywhere. So companies
that have highly sensitive
data might not want to go in
for this service.

On the other hand, it is a
boon for people who have
round-the-clock access to
the Net at their workplace
and need to access their
machines regularly from
home or while they're on the
move.
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Everyone’s getting on
to the SMS
bandwagon—here’s
how you can join in
the fun!

ANIL PATRICK R.
f ‘expensive teeny-weeny messages that yup-
pies send back and forth on their mobiles’ is
what you think SMS (Short Message Service)
refers to, then you're only partly correct. You
can easily send an SMS text message to your
friend’s mobile even if you don’t have one. And
the story doesn’'t end with text messages on
mobiles!

Getting on the SMS highway

Get the basic information on the required tools.
For this, check out the box, ‘SMS Funda Pack’
Okay, now that you have the basics right, you can
choose how you want to send the SMS. Do you
want to send the message from a Web site or

would you rather use your trusted instant mes-
senger (IM)? Both these services have their pros
and cons. Web sites offer features such as track-
ing whether or not your SMS has been delivered.
However, there is always the risk of your cell
phone number being marketed. IMs are gener-
ally more secure when it comes to this aspect.
However, most of them do not have tracking
features—you have to rely on providence with
most IMs.

SMS via e-mail

Nowadays, most cellular operators allow e-mail
messages to be sent to users. The usual e-mail
address of the wuser is in the form,
number@provider.com. For example, if you want

Imaging: Ashwin Boricha

R T T T

Speici  Took  Heko

ashwin, type your message.
zws... sit, walk, or run, but don't wobble

Text Message | .
fo- amnil
;.t‘m: m and o mobile number: ﬁm
ing lones umzuTm_mlmma:][ =
o -
1 from: & Astwin o[ chars [0
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SMS Funda Pack

Hold on for a moment
before sending that SMS!
First ensure that the cell
number of your friend is in
the international cellular
number (more accurately,
SMSC number) format. This
format includes a two-digit
number that you have to add
before the mobile phone
number to which the SMS
has to be sent. For Indian
SMSCs, you have to type +91
followed by the mobile num-
ber. Some of the SMSC num-
bers of Indian mobile
services will look like the fol-
lowing after conversion:
BPL Mobile:
+919821000005
MAXtouch India:
+919820005446
Essar Cellphone:
+919811009998
Tata: +919848001104
Command:
+919830099990

If you plan to use free
SMS Web services, certain
requirements need to be
met. First of all, you should
have a PC with Internet
access. It also helps if you
have a mobile phone as
many of the sites require
you to have a mobile phone
for registration.

Fimd it an

i C
Interactive;,
Whitepapers on ~ ~

Wireless Technologies
check out
Mindware

to send an SMS to an Orange mobile number,
say, 982017XXXX, all you have to do is send an
e-mail to 982017XXXX@maxtouch.co.in. The
biggest problem here, of course, is that you
would need to know the mobile service provider
of the recipient as well as his e-mail address in
order to successfully send your message.

SMS via Web sites

Another alternative is to use Web sites that pro-
vide free SMS messaging facilities. Some of the
free SMS Web services that offer these facilities
are www.mtnsms.com, www.hooya.com, Www.voices-
tream.com, and www.blueskyfrog.com. MTNSMS is
absolutely free, with no strings attached (see box,
‘MTNSMS-Swift and Simple’). VoiceStream and
BlueSkyFrog have limitations in the form of
points for using their service. For additional
SMS services such as ring tones, you have to pay
for additional points.

Sending SMS using IMs

In case you haven’t noticed, many IMs such as
MSN Messenger and 1CQ offer SMS messaging
services. MSN Messenger offers SMS services as
standard, but the person to whom you want to
send an SMS has to have an MSN passport and
enable the option for you (or anyone else) to
send messages to his mobile. All that you then
have to do is to right-click on the name and
select Send a message to a Mobile device.

To enable other people to send SMS via MSN
Messenger to your mobile, go to Tools, select
‘Send a Message to a Mobile Device’, and then
click on ‘Edit my Paging Settings’ or ‘Setup my
Pager Address’, depending on the version of
MSN you are using. Register your mobile device,
after which you will be sent the authorisation
code. Enter the code and then proceed to per-
sonalise your settings using the Phone prefer-
ences. Fill in the numbers and click on ‘Go to

Operation of SMS Web Services

Short Message Service (SMS) is defined as the
transmission of short text messages to and from
a mobile phone, fax machine, or an IP address.
These plain text messages have a maximum limit
of 160 alphanumeric characters, and cannot have
images or graphics.

Let’s consider that a message has been sent
from a Web site or application that offers SMS
services. The message is routed by the service
to the user’s cellular network. It is received by a
Short Message Service Centre (SMSC), which
directs the message to the recipient’s cell
phone.

The SMSC sends an SMS request to the
Home Location Register (HLR) to find the roam-
ing customer. Once the request is received by
HLR, it responds to the SMSC with the sub-
scriber’s status (active or inactive) and roaming

location. If the status is inactive, SMSC stores
the message for a specified period of time.
When the device is active, the HLR sends an
SMS notification to the SMSC, which then tries
to deliver the message.

SMSC uses a Short Message Delivery Point
to Point format for transmission of the message
to the serving system. The system contacts the
mobile and if it responds, SMSC tries to deliver
the message. When the message is received by
the user, it is categorised as ‘sent’ and is not
sent again.

And if you have a mobile, the moment you
receive an SMS message, you get two short
beeps (or any other sound that you may have
pre-configured), to indicate that you have
received an SMS message. So, go ahead and
read that message.
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MTNSMS—Swift and Simple

MTNSMS, one of the foremost Web sites offering Web to mobile SMS services, is
very simple to use. Log on to www.mtnsms.com and register.
Click on the join us button for the registration form.
In the registration form,

o gy ot e B fill in details such as your
e —— e-mail ID and personal
s information (see Fig 1); the
T mobile number field can
"..'.'. — be left empty. Clicking on
L = the smiley button ensures
L s that your confirmation

o i code is mailed to your e-
mail address, on receiving
which you can start firing

o= [Ea e v T [ off your SMS messages.

i = . Sending an SMS using
-_IE @_‘ MTNSMS is very simple
(see Fig 2). Select the

smsxpress link at the bot-
tom of the page if you're in
a hurry. Type the mobile
number to which you want
to send an SMS message
in the mobile text box.
Ensure that the number is
in the international format.
You can convert Indian cel-
lular numbers to this for-
mat by adding +91 before
the number. For example,

if the mobile number is
rrudsdn, | 3

messages gemt to 21 BEI0 TEE83. truck it here.
nave a7 abeut miname? ask tie flcionim. com

982017XXXX, in the inter-
national format it

_ = = becomes +91982017XXXX.
Enter the message in

; the text box. Take care that
my sk H iy '.ul:w.H iy Somm
the message does not

exceed 160 characters—
the counter will help you
while doing this. Press the
smiley and your SMS is
sent.

Tracking your e-mail
can be done using the
track it here link in the
page that comes next (see
Fig 3).

You can see all the
messages you send as well as the messages that you forward to other numbers in
your message outbox (see Fig 4).

MSN Mobile’, which will take you to the MSN
Mobile Alert Settings page. Select the Add but-
ton next to Instant Messages, which will take you
to the Instant Message Alerts page. Select the
‘User & Device information’ link to fill in your
mobile number and other information, and

voila! Your friends and colleagues can now send
messages to your mobile using MSN Messenger.
MSN Messenger also allows you to send news,
sports updates, etc, to a mobile phone for free.

Sending SMS with ICQ is really easy. All you
need to do is click on the ICQ SMS icon below
the ICQ tool bar. ICQ offers three options for
sending SMS to your friends—via ICQ, Web, or
e-mail. Select the preferred mode and start send-
ing out your messages.

More than just SMS

There are free Web services on the Internet that
offer news, sports updates, free icons, logos, and
even horoscopes (see box, ‘Operation of SMS Web
Services’). And, of course, SMS chat. You also
have free Web services that enable you to down-
load ring tones (yes, you can get the theme of
Mission Impossible as your ring tone to replace
that monotonous beep).

For free ring tones, logos, horoscopes, etc,
there are several sites such as www.texer.com,
www.boltblue.com, and www.yourmobile.com, although
some of these sites require you to register. You
need to have an Internet-enabled cell phone for
downloading ring tones directly. It’s also possi-
ble to download the tone directly to your PC and
transfer it via the infrared port of your PC to the
cell phone. In order to do this, though, both your
cell phone and PC should have infrared ports.
So are you ready to get those services going?

The hidden thorns

Other than getting addicted to SMS (and it is
highly addictive!), there are some other points
to be considered. A major limitation is that SMS
allows only a maximum of 160 characters in a
message, and sometimes even less. If a message
is longer than 160 characters, it is sent as multi-
ple messages, which might involve a loss in
transit.

Whenever you use a \Web site to send an SMS,
you essentially provide the site with your cell
phone number. This could make you a target for
spam.

Cellular phones provide advertisers an
opportunity to contact people with location-
and user-sensitive advertisements. With wireless
Internet becoming increasingly popular, adver-
tising on mobile devices is going to become
widespread two or three years down the line and
you may well be bombarded with advertise-
ments on everything under the sun.

This is a worst-case scenario, though, and
there’s no need to get paranoid now. Most of
these advertisements are likely to be of the ‘opt-
in’ type, which means the user will be offered the
option of receiving or rejecting them. No adver-
tiser would want to have a user filing a case
against him for spamming. So set your worries
aside and get onto the SMS bandwagon. [l
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Applications

+ Voice error

Whenever | open IBM ViaVoice 98, it gives me
the following error, ‘VOICEPAD caused an
invalid page fault in module MFC42.DLL’. How
do | get rid of this message?

Kovid,

via e-mail

R( This error could occur because the
mfc42.dll file is missing, corrupted or it’s
the wrong version. This file is required by
many applications and usually most appli-
cations come along with their own copy of
the file, which is placed in the
Windows\System folder, thus causing
problems for other applications.

To fix this problem, the file required by
Voice Pad should be placed in the ViaVoice
directory. You should follow these steps:
Make sure that you can see all the files (hid-
den as well as system) in your system. Then
rename mfc42.dll in C:\Windows\System to
mfc42.dll.old. Reboot the system before this
step to ensure that no program is using this
file. Next, reinstall ViaVoice. Now you will
find a new copy of mfc42.dll file in C:\Win-
dows\System. Copy this file to the
viavoice\bin directory. Finally, rename the
mfc42.dll.old file back to mfc42.dll in
C:\Windows\System. This should get rid of
the error.

Linux

4+ Modem in Linux

How do | go about configuring a modem in Linux
Red Hat 7.0?

Aji,

via e-mail

R( Configuring a modem under Linux is
pretty much the same as it is in Windows.
All you need to know is which port it is
installed on.

A point to note is that COM1 in Win-
dows is ttyS0 in Linux, COM2 is ttyS1, and
so on. Once you figure this out, you should
symlink this device to /dev/modem, so as

70 FHE

Troubleshooting

Problems with installing Windows Me, printer not being
detected, converting PDF files to word, configuring a modem in
Linux...solutions to these and other problems
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Disabling existing DNS servers in Kppp
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Configuring wvdial

to avoid confusion later on. Use the com-
mand In -s /dev/ttyS0 /dev/modem.

Now you could use any one of the
diallers that are available in Linux. One of
the best utilities is Kppp, which is very easy
to configure. Those who like command
line utilities could use wvdial. To configure
wvdial, you need to use the command wvdi-
alconf /etc/wvdial.conf. You have a host of con-
figuration options for wvdial. You should
see the man pages for wvdial for more
information. Also note that if you are using
utilities like wvdial you will have to set the
DN server to that of your ISP. This can be
done using netconf. This can be avoided if
you are using Kppp, as it has the option of
accepting your ISP’s DNS server in its con-
figuration, with your current DNS server
being disabled.

Windows

+ Me doesn’t install

Whenever [ try to install Windows Me on my
Windows 98SE, setup runs well till ten per cent
of it is complete but then it shows the following
message, ‘Setup cannot copy the files to your
system. error-Suo325.’

Ibadat,

via e-mail

R( This problem arises when a corrupted
.cab file has been copied to the hard disk.
This corruption can be caused either by a
virus or by failing hardware, but the most
likely reason is a scratched, dirty or dam-
aged CD-ROM. Try cleaning the CD-ROM
or replace it. Also make sure that your PC
is not infected by a virus. If this does not
help, you need to check the possibility of
failing hardware.

Linux

+ Of native and swap partitions

| recently upgraded my system to a 20 GB
HDD. | have five disk partitions that contain
3.99, 3.65, 3.65, 3.65 and 3.64 GB, respectively.
| would like to install Red Hat Linux 6.2 in the
last partition of 3.64 GB. But when | run the
Linux setup and allocate swap and native par-
titions, it says, ‘Boot Partition too big’ and does
not allocate the native partition, although it
does allocate the swap partition. What should
| do?

Hariharan,

via e-mail

R( This is a common problem when the
hard disk size is too big. The error occurs
when the boot partition falls outside the
1024 cylinder area of the hard disk. You
should try the following. Delete all the par-
titions that you have made for Linux, that
is, swap partitions. Then make a /boot par-
tition of around 10-16 MB of Ext2 type.
Now go ahead with making all the other
partitions, namely, the /Linux Ext2 type
and the swap partitions. This should solve
the problem.
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Hardware

+ Printer problems in Win Me

| am using Windows Me. The problem is that
when | connect my printer on the USB port,
Windows does not detect it. If | use the Add
New Hardware wizard, it still does not detect it.
Please tell me what to do.

Anoop,

via e-mail

# This problem occurs if the printer was
previously installed, or if an install was
attempted and did not finish for some rea-
son. In this case, when you attempt to rein-
stall the driver, the ‘Add New Hardware
Wizard’ does not appear again.

To solve the problem, you need to unin-
stall the printer first. Download and exe-
cute the USB supplemental uninstaller
from the manufacturer’s site. This will
uninstall the printer from your system.
After the system restarts, you will be able to
install your printer successfully.

Applications
<+ From .pdf to .doc

To convert .pdf format files to Word document
files, I use the Copy & Paste method. The prob-
lem is that the formatting gets lost. This is espe-
cially troublesome when tables are involved. Is
there any way in which this conversion can take

Windows

Unwanted affection
| work on a network and of late, many of the
applications on my system do not work. My
system has also become slow and crashes
often. | scanned my system with an antivirus
software, and found that the system is infect-
ed with the Funlove virus. How do | get rid of
it?

Vinay Raj,
via e-mail

R( W32.Funlove.4099 is a
virus that works on a net-
work and affects .exe, scr and
.ocx files on Windows 95, - _
98, Me, NT and 2000 sys- ‘[
tems. It corrupts most of the
Windows applications and
causes the system to crash
often. To get rid of this virus,
you need to download the
virus removal tool that is
available at
www.symantec.com/avcenter/Fixfun.exe

You need to copy this file toa DOS
bootable floppy, and then run the tool as
follows:

Illustrations: Farzana Cooper

72 BEEH

place without the formatting getting lost?
Arun Sinha,
via e-mail

R( You cannot convert .pdf files directly
to .doc files. However, you can use tools
such as BCL Drake (available at
www.zdnet.com/downloads/). This tool allows
you to convert .pdf files to .rtf files. If this is
an online document, you can also convert it
to html format, using the Adobe PDF con-
version form available at
http://access.adobe.com/simple_form .html.

Windows

+ Defrag will not read

| have a Pentium 90 MHz PC. | have been expe-
riencing trouble with the Disk Defragmenter in
Windows 95. After checking the drive for errors,
amessage comes up that says, ‘Windows could
not access part of this drive, ID No.
DEFRAGO06'. It also suggests using Scandisk,
which | did with the Thorough option enabled.
Scandisk could not find any errors on the disk.
What could be the problem?

Rupak Ranjan Roy,

via e-mail

R( This error occurs when Disk Defrag-
menter is unable to read from or write to

fixfun /a

This will scan the files on your hard
drive and repair any file found to be
infected with the virus. Instructions for
removal, for all versions of Windows, are
also available at www.symantec.com/avcen-
ter/venc/data/fix.dos.funlove.4099.html

 —

one or more bad sectors on the hard disk.
The error ID is DEFRAG005 when Disk
Defragmenter is unable to write to a sector
and when it is unable to read from a sector,
the error ID is DEFRAGO006. To fix the
Erarisim wimd  FmE|

M P Temel Rm

E -1
* hnal -l erwl o, sl frer Lromlilnh 0¥ sl o
brtows, pmer 10 B drleemleal Theg oo oo

Ypaer Dl = O -
A - Pmmn -

[P L
Sl ag = Emllm e Few  Cole= S5
o = Bu [ T
Ur-anThe-fall = I [ I
s T s W el ey e
k1T - OF w
ke = W
w

Editing the Scandisk.ini

problem, you need to run Scandisk with
the Thorough option enabled, as you have
already done. Since you have not found any
bad sectors and the problem is not yet
fixed, you need to configure Scandisk to
detect disk timeouts and check each clus-
ter five times while performing a surface
scan. To do so, you need to do the follow-
ing:
Use Notepad to open the Scandisk.ini
file, present in the Windows\Command
folder. Create an [Environment] section in
the file, if the section does not already exist,
and then add the following lines to the sec-
tion, if they don’t already exist:

ScanTimeOut=0On

NumPasses=5

Save and then close the Scandisk.ini file.
Restart the computer in MS DOS mode
and then click Yes.

Type the following line:

scandisk C:

Then press [Enter] to run Scandisk.

You should run a surface scan when
Scandisk prompts you to do so, and repair
any errors that it finds. You can then start
your PC normally and run Disk Defrag-
menter. This should solve your problem.

Hardware

#+BIOS updates

| have a computer with a P-111 800 MHz proces-
sor and an ASUS CUV4X motherboard, with
Windows 98SE installed. | get an error some-
times that says, ‘BIOS Data Update Not Correct
Cpuid 000000586'. Please tell me what it means
and how to fix it.

Rajesh,

via e-mail

R( This message is from the BIOS Update
data file located in the motherboard BIOS.
To make sure your PC does not continue to
display this message, you must run the
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BIOS update utility. You need only run this
program once. This utility will load the
correct data file for the steppings of the
processor so that the correct data file is
available. If you do not have access to the
Update utility program, then it is possible
to update your system BIOS from the Asus
site (www.asus.com).

Applications

4+ No icon, no access!

| downloaded and installed TweakUIl from
download.com. It was working nicely till |
removed its icon from the Control Panel. Now,
since there is no TweakUl icon in Control Panel,
I can’trun it, nor can | do or undo any changes,
as | justdon’'t have access to it. Uninstalling and
reinstalling did not work.

Donnir,

via e-mail

R( Icons in Control Panel are controlled
by the .cpl files. TweakUI allows you to
hide these icons from the Control Panel.
The problem is that it does not prevent
you from hiding its own icon.

However, here’s what you can do to
fix this problem. Go to Start > Find > Files and
Folders. Here, enter *.cpl and click OK.
You should get a list of cpl files.
Find TweakUl and right-click it. You
should find an option, ‘Open With
Control Panel’. Selecting this option
will open TweakUI. Then click on the
Control Panel tab and click on the
TweakUI checkbox. This should solve the
problem.

Windows
Unsent mail
| am unable to send any messages through
Outlook Express. My default mail handler is
cal2.vsnl.net.in. | receive the following error
message, ‘The message could not be sent
because one of the recipients was rejected
by the server. Subject’, Account:
‘cal2.vsnl.net.in’, Server: ‘cal2.vsnl.net.in’,
Protocol: SMTP, Server Response: ‘550
<my_email_address>... Relaying denied’,
Port: 25, Secure(SSL): No, Server Error:
550, Error Number: 0x800CCC79'.

A.G. Krishnan,

via e-mail

R( This error, which isusually ran-  ~
dom, means that your SMTP server
is checking whether the recipient
name actually exists before sending
your mail. If the recipient’s mail
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Check the TweakUI box to make it show
up in Control Panel

Windows
<+ Wipeouts

Windows Me has an excellent facility called
System Restore. However, when | opt to restore
my system to any previous date, the computer
wipes out any programs or applications that
might have been installed after the restore date.
Is there any way to disable this wiping out of
applications installed after the ‘restore date’?
Doc Lawrence,

via e-mail

R( The System Restore feature actually
restores the system to the last snapshot
taken by Windows Me. It deliberately does
not install the applications that were
installed after this time, because they
might have caused the system to crash.
Windows Me takes these snapshots at
some intervals, or at the time specified by

server is down or unavailable for some
reason, your SMTP server cannot verify
the address and may reject the relay. If
this is the case, the message will be sent
when the receiving server is again avail-
able. You actually cannot do anything
about the error as this is usually a prob-
lem with the ISP.

the user.

You can disable the option completely,
but there is no way you can disable it from
only wiping off the applications. However,
here is what you can do. You can get Win-
dows Me to take a snapshot of the system
just before you install an application, and
if it works fine, take another one after the
installation.

Internet and communications

4+ Modem queries

I have a 28.8 Kbps internal modem. When | dou-
ble-click on ‘modem’ in the system tray to see
its data transfer rate, it gives the number of bits
or bytes received and sent. My questions are
as follows:

1. When | am browsing any site without
sending any data to it, the modem lights still
blink, indicating some bytes are being sent.
Please tell me what this information is about?

2. Though the maximum speed of the
modem is 28.8 Kbps, sometimes the data trans-
fer rate is large such that it reaches 11500 bps
(that is 11.5 Kbps) and sometimes as low as 2
KBps. How is this possible?

Manty,
via e-mail

R( The modem light blinks as there is
some data transfer that is taking place on
your machine. If the page you are brows-
ing contains ads that change dynamically,
data transfer takes place when these ads
load.

This could also be due to an instant
messenger that is running, a download in
progress, or even some backdoor or a
virus. You can use the command, netstat, in
DOS to check what ports are being used in
your machine.

Secondly, you have the date transfer
rate wrong as you are mistaken between
the bauds, bits and bytes of the modem.
Your modem speed could either be said to
be 28.8 kilo bauds per second or 28.8 kilo-
bits per second.

A baud is the number of signalling ele-
ments that occur each second. This is
approximately equal to the number of bits
per second. Now, 1 Kilobit in communica-
tion terms would be 1024 bits (2°10),
while a byte equals 8 bits.

Your data transfer speed reaches speeds
of 11500 bits per second, that is 11.5 Kbps
to 2 Kilobytes per second, which translates
as 16 Kbps. Hence, the data transfer that is
taking place is not from a minimum of 2
KBps to 11.5 Kbps, but from a minimum
of around 11 Kbps to a maximum of 16
Kbps.
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Windows

#+ Driving slow

My computer, with Windows 95 installed, has
become very slow. When | run my computer in
safe mode and open the systemicon in the Con-
trol Panel, in the Performance tab, | see the fol-
lowing errors:

1. “Compatibility mode paging reduces overall
system performance. Windows was unable to
identify a real-mode driver or memory-resident
program loaded in your Config.sys or Autoex-
ec.bat file.

You will see another message that lists the
name of the driver or program causing the prob-
lem. Because Windows could not identify the
driver or program, it has switched to MS-DOS
compatibility mode to ensure the program will
run.

However, this slows down overall performance.
To improve performance, remove the program
or driver causing the problem, or contact its
manufacturer for an updated version.”

2. “Drive X: using MS-DOS compatibility mode
file system. This problem often occurs on more
than one drive. Usually it is caused by a driver
in Config.sys that Windows doesn’t recognise,
and is related to the problem ‘Compatibility
mode paging reduces overall system perform-
ance.’

If you also see that problem, see the Help for
that problem first. If you only see this message
on one drive, that drive is using an MS-DOS
compatibility (real-mode) driver, which may
slow down access to that drive.

Contact your hardware manufacturer to see if
an updated driver is available for your drive. If
not, the drive may work more slowly than is opti-
mal, but you can still use it.”

Munish,

via e-mail

R( Windows 95 uses the MS-DOS com-
patibility mode when it is not using 16 or
32-bit disk access drivers. To fix the prob-
lems, you could try the following:

Go to Start > Run. Type regedit and click
OK. In Registry Editor, click on Edit > Find.
Type noide and click on Find Next. Delete
all the entries that you find. Reboot the
machine.

If this does not work, go to Start > Settings
> Control Panel > System. In the Device Manag-
er tab, check if the Primary and Secondary
IDE channels have any conflicts (exclama-
tion marks next to them). Select Standard
IDE/ESDI Hard Disk Controller and click
Remove.

DO YOU NEED HELP?

Reboot the system. Windows should
detect the Primary IDE channel. Don't
allow Windows to reboot, and let it detect
the Secondary IDE channel. Now continue
to boot into Windows 95 and then reboot
from the Shutdown menu. If this too does
not work, you should format the hard disk
and repartition using fdisk.

Windows

+ Truant files

| have a Pentium 11 333 MHz, 48x CD-ROM sys-
tem. When | try to play VCDs through Windows
Media Player 7, it displays an error message, ‘A
device attached to the system is not function-
ing’. When | try to enter into MS-DOS prompt
from Windows 98, | get a similar error message
and another which says, ‘The object that MS-
DOS prompt refers has been unaccessible or
removed’. What may be the error? How can |
overcome it?

Sivapadmanaban,

via e-mail
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Specifying the source and destination for
the damaged or missing files

R( It seems that you have a damaged or
missing Vgafull.3gr file or Winoa386.mod
file in the Windows\System folder. To solve
the problem, you should rename these two
files (use the Find tool) and extract the cor-
rect files using WinZip or System File
Checker.

To open the System File Checker, go to
Start > Run and type sfc; click on OK. Select
the ‘Extract one file from installation disk’
radio button and type out the file you want
to extract.

Clicking on Start will bring up a dialog

Send an SOS to sos@jasubhai.com

box that will ask for the source and the des-
tination of the file you are extracting. This
should solve the problem.

Windows

+ Added options

When I right-click on Start, | can see the options
Open, Explore, and Find in the context menu.
Can | add more options to this context menu,
which can open applications?

Satish and Sanju,

via e-mail

R( Yes, you can add your own options in
this context menu. To do so, open Win-
dows Explorer. Go to View > Folder Options >
File Types. Here, click on Folder and click
Edit. Now click on New and specify a name
for the action that would appear in the
menu. Also specify the program that would
execute this action. Click OK, and close.
You will now see your own option in the
context menu.

Internet and communications

+ Clear URLs
When you click on the drop-down button in
Internet Explorer’s address bar, you can see a
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Deleting select URLs from Internet Explorer

list of all the URLs that you have visited. Is it pos-
sible to selectively clear URLs from this drop-
down list? I do not want to get rid of all the URLs
by doing a Clear History.

Gaurav,

via e-mail

R( You can edit the registry to do this, or
use software that allows you to do so. How-
ever, backup your registry before editing it.
Here’s what you should do: Go to Start > Run.
Type regedit and click OK. Go to
HKEY_Current_User\Software\Microsoft\
Internet Explorer\Typed URLs\.

Here, you will find many URLs. Just
select the ones that you do not need and
delete them. Make sure that your IE is not
running. Exit the registry and restart Win-
dows. The URLSs should be gone.l

Or write in to DIGIT, D-222/2, Om Sagar Bldg, MIDC, Nerul-400 706
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WORKING WITH WINDOWS

There’s no understating the fact that most likely you are going to be working with one Windows operating system or the other.

Windows 9x/Me

The most popular operating system is not
that security conscious, but you can cer-
tainly tweak it to gain more control

w Creating security policies

You can get a higher level of security with
your Windows machine if you create
user profiles on your PC. Go to Control
Panel, double-click the Users option and
follow the wizard to create a new user for
the computer.

If you are using Windows 95, you
have to select the Passwords option to go
to the User Profiles tab. Enable users can
customise the preferences and restart the
computer. In the login window, type in
your name and password, and Windows
will prompt you for creating a new
profile.

You can specify rights for individual users

Now, with user profiles created, you
can use the System Policy Editor to
restrict access to new users (or those
who just hit the Cancel button at the
login menu). Before using Policy Edi-
tor, back up your registry and other
password files. Restart the computer,
and at the login prompt, press Cancel.
This represents a setting for an unau-
thorised user. Start the Policy Editor by
typing poledit in the Run menu. Go to
File > Open Registry and double-click on
Local Users. Check or uncheck the var-
ious options to restrict access by an

80 Rl

So, getting to know the OS is quite important

oft/Windows/CurrentVersion/Run. In
the right-hand pane, right-click and
choose New String Values, and rename it
as FixLogon. Finally, open the FixLogon
entry you've just created (by double-
clicking on the right-pane of the Registry
Editor window) and specify the follow-

ing command as its Value

ST | o

Make users enter | ..

data: rundllexe user.exe,
EXITWINDOWS. Reboot your
PC to save the changes. If

a password on
Windows startup

e | v |

you want to restore the
old setting, delete this key.

unauthorised user. Click OK when you
are finished. The settings you choose
are the ones a person will find when he
logs in with a new name or hits Cancel
at the login prompt. This can be a very
stripped down version of Windows
with no access to many of the settings
or folders.

= Forcing users to enter password
during login

Unlike Windows NT/2000, the login
window in Windows 9x/Me can be easi-
ly bypassed by pressing the [Esc] key or
by clicking Cancel. So, it’s possible that a
third person who turns on your PC can
gain access to your personal informa-
tion. To prevent this from happening,
first make sure that the user profiles are
created and enabled for each user, and
that the ‘Include Start Menu and Pro-
gram Groups in User Settings’ option in
the Control Panel is enabled for each
user.

Reboot the PC in Safe Mode by hit-
ting the [F8] key during Startup and
choosing Safe Mode from the Boot
Options. This is very important because
if something goes wrong, you can always
reboot your computer in the safe mode
and rectify the problem.

Type regeditexe in Start > Run. Find the
following key in the Registry:
HKEY_USERS/Default/Software/Micros

Ad will come

= Installing Critical Updates

A feature that often goes unnoticed in
Windows (and other applications too) is
the update utility. Microsoft uses the term
‘Critical’ updates for patches and bug fixes
related to your operating system, though
sometimes these may be for other appli-
cations too. While you can go and indi-
vidually download the updates from
Microsoft’s Web site, you can do the entire
thing in a faster manner by just clicking
on the Start menu and selecting Windows
update. This ensures that you get the
entire database of updates in some cen-
tral location. It’s not necessary that you
install each and every update, especially if
you have not been facing any problems.
And the latest updates for Outlook
Express have made it extremely restrictive.
But, do select the updates that fix any
exploits to your browser or operating sys-
tem and install them.

= Disabling sharing
If your machine is part of a network, you
need to configure it for file and print
sharing so as to enable other people on
the network to access your shared folders
and printers, and to allow you in turn to
access their resources. But most intru-
sions are done using this exploit to gain
access to your machine.

On the other hand, if you have a stand-
alone machine, then there’s no reason
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Disable file sharing

why file and print sharing feature should
be enabled. To disable it, open Control
Panel and double-click on the Network
icon. You will see a list of installed pro-
tocols, including ‘File and Print Sharing
for Microsoft Networks’. Click on File
and Print Sharing, then click Remove,
and finally click OK. Reboot your PC to
save the changes.

= Unbinding NetBIOS to TCP/IP

By default, NetBIOS is bound to TCP/IP
protocol, and therefore it is possible for
outside intruders to access your file
shares. You can prevent this by unbind-
ing NetBIOS to TCP/IP. Firstly, you need
to have NetBEUI installed along with
TCP/IP. (Install NetBEUI from the Pro-
tocols options in the Network Configu-
ration menu). Now, select the Dial-up
Adapter that you use to connect to the
Internet, and click on Properties. Go to
the Bindings tab, and uncheck all the
boxes except for the TCP/IP Dial-up
Adapter. Click OK. Now, select TCP/IP >
Dial-up Adapter, and click on Properties.
Ignore any warning messages, and click
the Bindings tab. Uncheck all the boxes
present here, and click OK. You will get
another warning message, but click No
at this juncture. Close the Network prop-
erties menu and restart the machine.
This will result in NetBIOS being

unbound to TCP/IP and you no longer
have to worry about your file shares
being accessed over the Net.

= Enabling file extensions

By default Windows Explorer hides file
extensions for known file types, and this
includes the .vbs extension which is also
used to create many of the malicious
scripts. Therefore, it’s quite possible that
you might receive an attachment in your
e-mail with the actual file name as good-
image.jpg.vbs, but since the .vbs is a
known file extension, it gets hidden and
you perceive the file name as goodim-
age.jpg and since .jpg files are non-exe-
cutable you open it. This could cause the
Visual Basic Script to execute whatever
code is written in it (provided you have

Active  Scripting  enabled). To
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Uncheck the option to hide known file
extensions

prevent this from happenning, go to the
Explorer Window, select Tools > Folder
Options, click on the View Tab and
uncheck the ‘Hide file extensions for
known file types’ option.

= Scraping past security

What happens when you try to paste,
say, the contents of your Word document
into the Explorer folder? You get what is
known as a scrap document or scrap

Ad will come

object, which is basically a wrapper for
OLE data. Double-clicking on the scrap
file launches any program that may have
been defined in the properties of the
scrap object. The scrap object icon is
quite similar to the icon for a text docu-
ment, and even if Windows Explorer is
configured to show all extensions, it hides
the .shs extension that is associated with
a scrap document. So, you can easily end
up opening an e-mail attachment, say,
goodstuff.txt.shs (which only gets dis-
played as goodstuff.txt), and invoke a
malicious command (such as opening
some file or running the format com-
mand) associated with that scrap object.
To prevent this, you have to modify
some settings in the registry. Back up
your registry before you proceed. Type
regedit in the Run menu, and go to
HKEY_CLASSES_ROOT\ShellScrap.
Locate the NeverShowExt value in the
right-hand pane and then delete this
value. Adopt a similar procedure for the
value under HKEY_CLASSES_ROOT\
DocShortcut. Now, all that’s left to do
is change the icons for the scrap object
so that they don’t resemble the text
icon. Go to Windows Explorer > Tools, click
on the File Types tab and select the .shs
extension. Click on Advanced, and then
on Change Icon. Browse to the pifm-
gr.dll file, and select one which presents
the warning signals or the dynamite or
shield, so that you know there’s danger
associated with such file extensions.

= Changing default locations
Many intrusion attempts and malicious
Web sites look at specific directories for
certain files. This is done on the
assumption that the software will usual-
ly be installed in the default locations.
For example, Windows will most prob-
ably be in C:\Windows and other appli-
cations will be within the C:\Program
Files folder.

Wherever possible, don’t use the
default folder and change it to some
other name. This will make the task of
whoever is trying to pry into your sys-
tem all the more difficult.
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Windows NT/2000

Windows NT/2000 offer a more secure
environment, though a few exploits can
let other users gain access to your
machine. Here's how to plug those holes

w Restricting guest access

Unauthorised users can access your
Win2K PC by specifying Guest in the
logon window. To disable the Guest
account, open Users and Passwords from
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No Guests please!

the Control Panel. Click on the
Advanced button twice to display the
Local Users and Groups window. In the
left pane, double-click on Users. Here,
right-click on Guest and choose Proper-
ties. Once there, disable all options by
clicking in the check box against each.

w Encrypting and securing drives

In Windows 2000 or NT, if you are using
the NTFS file system for a drive, you can
restrict access to selected users. To secure
your drive, right-click on the NTFS par-
tition and choose Properties to display
the Drive Properties. Click on the Secu-
rity tab and then click on the Add button
to display the ‘Add Users, Computers or
Groups’ window. In the upper part of the
window, click on the users you want to
allow access to and press Add. Repeat this
if you want to add more than one user.
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Encrypt drives for greater security

w \Vatching your shares-|

If you have kept some important docu-
ments for, say, your boss in one of your
shared folders, then someone else who
isn’t supposed to read that can open it if
you haven't set the right permissions.
Unlike Windows 95/98, Windows 2000
allows you to close the files that have
been opened by unauthorised users
without unsharing the folders that con-
tain them. To do this, right-click on the
My Computer icon on the desktop and
choose Manage. In the window that

r
B

Close unwanted network connections

opens, click on Shared Folders and then
on Open Files. In the right pane you
should now be able to see all the files
from your machine that have been
opened by various users. Simply right-
click on the file that you want to close
and choose Close Open File.

o Watching your shares-I1

The above method is quite effective, but
the unauthorised user can again open
the same file if he wants to, because the
folder that contains the file is still shared.
Use the following method to share

Ad will come

folders selectively—it ensures that only
the person who knows the exact name of
the folder can access it. Open Windows
Explorer and click on the folder you want
to share. Now right-click on it and choose
Sharing to display the properties window
for that particular folder. Click on the
check box against ‘Share this folder”. In the
Share Name option, put any name and
add the ‘$’ sign at the end. For example,
you can give the share name ‘DOCS$’.
Now, if you want your boss to read a
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document in that folder, just tell him to
access it using the Run menu and not
through Network Neighborhood because
folders that are shared using the ‘$’ tech-
nique can only be accessed through a Win-
dows command line like the Run menu.
In the Run menu your boss will have
to type \\machine name\DOCS$. To check

whether you have done this correctly, O
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Access $ folders using command line

type \\machine name with and then with-
out the folder name. In the first case, you
will see the folder while in the second
case, you will not.
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BROWSER PROTECTION

Your browsing activity and the configuration you have selected can, to a large extent, define the security levels that you enjoy.

Internet Explorer 5 and 5.5
Internet Explorer is the most popular
browser and therefore majority of the
exploits are targetted towards it. So, you
definitely need to be more cautious

w» Deleting cookies

Many Web sites drop little files onto your
system that let them keep track of your
passwords, and the date and time of your
visits. To get rid of these files, delete the
contents of the Cookies folder and the
Temporary Internet Files folder in your
Windows directory (but not the folders
themselves). This will remove all traces
of your surfing pattern. You could also
use a third-party cookie cleaning soft-
ware such as Cookie Crusher.

= Working around cookies

Adjust IE’s security settings to keep ran-
dom Web sites from sending cookies to
your hard drive or uploading ActiveX
Controls. To do this, select Internet
Options from the Tools menu, and click
on the Security tab. Slide the bar under
‘Security level for this zone’ up or down
to increase or decrease the security level.
Each level (High, Medium, Medium-
Low, and Low) lists exactly which
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Configure it right for safe surfing

actions and applications it allows or
blocks. It is better to click Custom Lev-
els, and then select to prompt for cook-
ies that are stored on your computer and
per-session cookies. This allows you to
control which sites you want to allow
cookies. Remember though, that some
sites may not work properly if cookies is
disabled. In addition to this, you should
also disable ActiveX, since this can pose
a serious security hazard.

w Disabling Windows Scripting Host
Internet Explorer installs Windows
Scripting Host by default, and this is
used to run VB scripts that may contain
viruses or Trojans. To remove Windows
Scripting Host, go to Control Panel >
Add/Remove Programs > Windows Setup. Select
Accessories and from there uncheck
Windows Scripting Host. You can also
go to the Folder Options in Windows
Explorer, and select the .vbs file type and
remove it.

= Disabling AutoComplete

The AutoComplete feature may be use-
ful while filling out forms and user-
names, but it also allows other users to
know your username and then probably
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Adjust security settings to block cookies

Tame Auto-Complete to ensure privacy

Ad will come

guess your passwords. When the Auto-
Complete function is active, some sites,
search engines and entry fields retain the
words you've entered, so anyone who
uses the browser after you and visits that
site can see the entries you made.

To turn off this feature, in the Inter-
net Options dialog box, click the Con-
tent tab. Next, click the AutoComplete
button in the Personal Information sec-
tion to display the AutoComplete Set-
tings window. Uncheck the ‘Forms’ and
‘Usernames and Passwords on Forms’
boxes.

w» Deleting History items

The History folder stores a record of all
the Web sites you've visited. This is very
convenient, but then your boss, friend,
or colleague can easily find out what
you've been surfing. Here’s what you
can do to get rid of unwanted URL his-
tories: in Internet Options under the
General tab, find the History section
and click the Clear History button.
Repeat this before you close the brows-
er. Set the ‘Days to keep pages in Histo-
ry’ to 1. This will not only keep IE neat
and tidy, but will also act as a cushion if
you forget to clear.

If you don’t want to clear your entire
History folder, you can choose to remove
single pages. To do this, click the Histo-
ry button on your IE toolbar to open the
History window frame. Right-click on
the file you want to dump and select
Delete from the pop-up window.

w Filtering content

Certain sites on the Internet are certain-
ly not appropriate for children. You can
use a separate software program for fil-
tering content, but IE also has some
built-in filtering tools. To configure
these, click the Content tab from Inter-
net Options. Next, click the Enable but-
ton under Content Advisor and adjust
the slider in each of the four categories:
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Language, Nudity, Sex, and Violence. The
Description box at the bottom details
what each level allows. Click OK to acti-
vate the Advisor.

= Disabling Java

Java and JavaScript applets can take con-
trol of your browser and you should
therefore exercise caution in surfing
unknown and potentially questionable
sights. Both Java and JavaScript can be
disabled from within the browser, but
you will miss out on a lot of serendipi-
tous cyber experiences if you surf with
JavaScript turned off. The best course,
then, would be to toggle between these
settings according to the perceived secu-
rity threat.

-'Changing setting of restricted
zone

The default settings of Internet Explor-
er for Restricted Sites has Active Scripts
enabled, which sounds a bit of a
contradiction. To modify this settings,
in Internet Explorer, go to Tools > Options
> Security and select Restricted Zones.
Click on Custom Level and then go
to the Active Scripting option and
disable it.

Netscape 6

The latest release of Netscape might be
quite sluggish and not that popular, but if
you are a Netscape fan, certain safety
measures are still in order

w Changing your security level
Skittish about sending unencrypted infor-
mation, such as your name, phone num-
ber, or address across the \Web?

Thankfully, Netscape 6 warns you
before it sends information through an
unencrypted fill-in form. To enable this
feature, select Tasks Privacy And Security
in Security Manager, and click the Appli-
cations tab. Then check the ‘Sending
unencrypted information to a site’ box.
From this dialog box, you can also set
Netscape 6 to raise a red flag before you
enter or leave a site that does not support
encryption.
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Lock out hacker, cracker attacks

- Clearing the Location Bar

Most of us mere mortals occasionally
visit Web sites or perform searches that
we don’t want anyone else to know

Hide visited sites

about. But then anyone can see the last
dozen URLSs you entered into the Loca-
tion bar by clicking the little down arrow
on the right side of the window.

To clear the list, select Edit > Preferences
> Navigator > History. Finally, in the Histo-
ry dialog box, click on Clear Location
Bar.

w Managing cookies

The History folder isn’t the only place
where Netscape records your surfing
habits. Many Web sites drop cookies
onto your system. To clear them, select
Tasks > Personal Managers > Cookie Manager. A
pop-up window will appear with a list of
the cookies already on your PC.

Select a cookie to see its name, the
domain name the cookie came from, its
path, whether it’s secure or not, its expi-
ration date, and the data it is storing.

Ad will come

Click Remove Cookie to zap the cookie
from your PC.

w Setting privacy options

It's advisable to be discreet when you're
signed on to Netscape 6 Instant Messen-
ger. To ensure privacy, click Tasks, Instant

Chat with no one but your friends

Messenger, and then select the Preferences
icon. Under Instant Messenger, select Pri-
vacy. Choose either the ‘Block all users
from connecting’ button or the ‘Block the
users listed below’ button, and type in the
screen names of the people you want to
avoid chatting with. Click OK.

o Manage your Usernames and
Passwords
Netscape’s Password Manager stores and

Massword Mansqer
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Get warnings from Netscape

automatically enters your login infor-
mation for password-protected \Web
sites. To start using the Password
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Manager, click Edit, Preferences, and
then choose Password Manager in the
Advanced section. Next, click the Enable
Password Manager check box in the pop-
up dialog box.

The next time you visit a site that
requires you to log in, you'll be prompt-
ed to create a master password. To see a
list of all your stored passwords, select

Tools > Personal Manager > Password
Manager, and finally View Saved Pass-
words. From the same configuratio
menu, you can also choose to encrypt
the data that is stored on your hard disk,
so that others don’t have access to it.

= Encrypt Passwords
The problem with saving your pass-

words in the above manner is that any-
one who uses your computer will have
access to your saved passwords, for
instance your bank account. Netscape 6
allows you to store all your passwords
behind a master password. To do this,
select Tasks > Privacy and Security > Password
Manager and finally the Change Personal
Security Password option.

SAFETY IN E-MAIL AND CHAT

Your personal privacy is quite often at stake while chatting on the Net or posting at newsgroups. A little protection can safeguard your

w» Disabling archiving of postings
When you post to a newsgroup, your
post is not only accessible to millions of
users, it gets archived also with a site
such as DejaNews. That means you can
still be ‘hunted’ down after many years.
If you don’t want your messages to be
archived, type the following text in your
header, x-no-archive: yes. You can also
remove messages that have already been
archived by DejaNews. Information
about archival and removal can be found
on the site.

= Avoiding newsgroup spams
There are many bots which automatical-
ly retrieve e-mail addresses from news-
group posting and then bombard you
with spam. To prevent such spamming,
while at the same time ensuring that you
get a response to your posting, use an
e-mail address which contains removal
instructions for the correct e-mail
address. You can for example use an
e-mail address such as
abc@removethishotmail.com.

= Encrypting messages

If you regularly send confidential infor-
mation, then it’s a good idea to encrypt
all your outgoing messages. You can use
a freeware tool such as PGPfreeware for
this. PGPfreeware encrypts your mail
and enables you to send online decryp-
tion keys to the recipients, and integrates
with Outlook Express and Eudora. In

identity on the Net

Outlook Express, go to Tools > Options,
click on the Security tab and check the
option for encrypting all outgoing
messages.

w' Blocking messages using filters

All e-mail clients allow you to define
mailing rules for sorting mail. This fea-
ture can also be used to block spam mail,
or mail from certain users. Start the fil-
tering process, and select to delete mes-
sages which have some text string in the
e-mail address or text like ‘lloveyou’ in
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Use Rules to control Outlook Express

the subject field. In Outlook Express, if
you have received an unwanted message,
you can just go to the Message menu and
select Block Sender. The Block Sender
option can be quite useful when you get
junk e-mail from some list servers.
Unsubscribing to these may often not
work, and only serve to tell them that
yours is a genuine e-mail address.

Ad will come
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Make your zip files password protected

w Password-protecting by using
compression

If you must send e-mail attachments,
make sure they arrive safely. You can add
a level of security by compressing attach-
ments with WinZip or a similar pro-
gram, and by adding a password so that
only the intended recipient can decom-
press the file. Click the Password button
or use the Options menu in WinZip to
assign a password.

w Changing the Internet Zone

You can change the secure content zone
in your e-mail client (Outlook or Out-
look Express) to that of Restricted sites.
This creates a more secure environment
though it might be a little less function-
al. To change the zone, in Outlook, go to
Tools > Options > Security. Select Zone from
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the drop-down menu, and select
Restricted Sites. For changing the Zone
in Outlook Express, go to Tools > Options >
Security, and select the Restricted Sites
option.

w Hiding IP address in ICQ

Since 1CQ works by establishing a direct
connection, you should ensure that your
IP address is not visible to other users.
Select the option to hide your IP address
(though a determined user can easily
bypass this security option), and ensure
that other users need authorisation before
they can connect to you. You can even
select to remain invisible to most users
and not publicise your details on the Web.

= Spoofing IP in mIRC

When you are chatting in an IRC chan-
nel, anyone can just give the command
/whois <yournickname> to get your |IP
address.

To spoof your IP address, you can use
the command, /mode <yournick> +x (Or +z)
depending on the channel. Alternative-
ly, you can work through a proxy server
Or an anonymiser.

= Using a proxy server

The best possible solution for absolute
privacy is to surf using a proxy server.
You could, for instance, use Internet
Junkbuster Proxy (www.junkbusters.com/
ht/en/ijo.ntml), which can selectively block

PC SECURITY

cookies. Another such tool is InterMute
(www.intermute.com/), which blocks pop-
ups as well.

= Keeping a spam address

When filling up registration forms at
sites or when you have to provide your
e-mail address at public places, you
should use an e-mail address that you
have specially created for that purpose
and don’t give out your personal e-mail
address.

Also, see to it that you reveal the bare
minimum in the forms, and give false
information as far as possible (unless you
are in a shopping site, and require deliv-
ery of a product).

You can secure your PC by using firewalls and antivirus programs and configuring them correctly. A few tips towards this end

= Locking Internet access in
ZoneAlarm

If your office has an always-on Internet
connection, use ZoneAlarm’s Internet
Lock feature to protect your machine
in your absence. To enable this, right-
click on the ZoneAlarm icon in the sys-

tem tray and choose ‘Restore
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Use the Lock icon to block Internet access

ZoneAlarm Control Centre’. Then click
on the Lock tab. The Internet Lock is
disabled by default. Click on Enable.
Now specify a delay time of 20 minutes.
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Next, check the High Security option.
This will stop all Internet activity if the
machine remains idle for more than 20
minutes.

= E-mail protection with Norton
Antivirus

If you are using an e-mail client to access
your POP mail account(s), then you
could set up Norton AntiVirus to scan
all incoming mail. To do this, start Nor-
ton AntiVirus and open the Options
window. In the left pane, browse down
to the E-Mail Protection sub-menu
under the Internet menu.

Next, select the e-mail accounts you
want scanned before the mail is down-
loaded on to your hard disk. Finally,
from the Action tab, specify the action to
be taken in case a mail is infected by a
virus and press OK to complete the con-
figuration.

If you have Norton Personal Firewall,
then you can also block ActiveX controls
and other cookies. A unique feature of
Norton is that it can also block adver-
tisements and HTTP referrers (wherein
a site comes to know where you are com-
ing from).

Ad will come

= Importance of LiveUpdates

By default, LiveUpdate is configured to
look for updates every time you connect
to the Internet irrespective of whether or
not updates have been released. This can
be very annoying. You can change the
default setting to download updates only
when a newer version is available. To do
this, browse to the LiveUpdate menu
under Internet in the Norton AntiVirus
Options dialog box. By default, the ‘Apply
updates without interrupting me’ option
is checked. Change the default option by
ticking the check box against ‘Notify me
when updates are available’ and press OK.
w Scanning all downloads in
FlashGet

You can set up your download manager
to scan files before they are downloaded.
To configure FlashGet, start FlashGet
and open the Options window from the
Tools Menu. Once there, click on the File
Manager tab and tick the check box
against the ‘Use virus scanner to scan the
downloaded files’ and browse to the
folder where your antivirus program is
stored.
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YOUR WORKS

ALIASGAR PARDAWALA
ith innumerable free Web services and
‘get-your-Web-site-up-in-five-minutes’
software, the need for affordable imaging
solutions is very apparent. The good news
is that a plethora of such solutions are now avail-
able and you can choose from among them
depending on your application.

With a scanner, you can port all those birth-
day and family photos over to your personal
Web site. Apart from working with just images,
if you buy a scanner with OCR capabilities, you
can also scan documents and text from newspa-
pers and magazines.

The latest scanners offer a host of features
such as Scan-to-Web and Scan-to-e-mail. The
Scan-to-Web function enables you to post
images to your Web site at the touch of a button,
while the Scan-to-e-mail feature allows you to
e-mail an image directly—you don’t have to sep-
arately import it into your e-mail client.

Apart from the enhanced functionality,

today’s scanners are sleeker and smaller than
their predecessors, so you don't have to allot half
of your desktop space to your new scanner.

Speed test

The speed of each scanner was first tested using
asimple text document created in the lab, which
contained both text and a company logo.

This document was previewed using the
Twain drivers that came with each scanner, and
the timing was logged using a stopwatch. Here,
we logged the duration between the moment the
Preview button was pressed and the moment the
image appeared in Photoshop.

The fastest preview was generated by the
Epson 1640 SU, which uses Twain 5 drivers
developed by the same vendor. The scanner took
only 5.58 seconds to preview the document at
300 dpi in true colour. The other impressive per-
formers in the preview test were the Microtek
ScanMaker 3600, which took 8.58 seconds, and
the Epson 1240U Photo (9.31 seconds).
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TEST PROCESS

We ran a battery of tests that evaluated a range of characteristics
of the scanners besides just the image quality. We considered four
factors in determining the performance of each scanner:

Contrast between
darker and lighter
areas of leaves

Wrinkles between
the eyes

Detail on the
fabric

Specular shine on
the bracelet

B Image Quality:
Since the prime
function of a scan-
ner is to pick up
images and con-
vert them into dig-
ital format, image
quality is one of the
most important parameters for evaluating flatbed scanners. Two
reference images were used to test the image quality—the IT8.7
colour card, which is a standard image used worldwide for colour
correction and calibration, and an A4-size photograph that
helped determine the accuracy of the scanner in picking out details

Detail in flowers

The preview speed depends a lot on the tech-

Ability to differentiate
between highlights (RGB)
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Ability to differ-
entiate

between shad-

ow (dark) areas
(RGB) |
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Distingushing between
different shades of grey

and subtle variations in colour, hue, brightness, and resolution.

M Resolution: To determine the maximum resolution at which
each scanner could pick out the finer details, we used a resolution
target that consisted of five squares forming bar patterns, created
at different dpi ratings.

W Speed: We logged the time taken to scan a range of different
images, and at different resolutions and colour depths. Additional-
ly, the time taken to scan text documents and photographs in full
colour and gray scale modes was also logged.

B Features: We also considered build quality, ability to scan trans-
parencies, documentation, buttons for one-touch scanning opera-
tions, and provision for upgrading to an Automatic Document
Feeder.

nology used, the implementation of the optics
used in the scanner, and the software that con-
trols these scanning elements.

Next, we scanned the document in black-
and-white (line-art) mode and then in gray scale
mode at 200 dpi. The document was scanned
directly to Photoshop from the Twain drivers of
the respective scanners.

The HP ScanJet 5300C was the best among
the pack in this test—it took just 8.31 seconds to
scan the document in black-and-white mode,
and 9.25 seconds for the scan in
gray scale mode. In black-
and-white mode, the
HP ScanJet 5300C
scanned the image,
opened  Photoshop
and displayed the image
in the application in just 9
seconds. This impressive per-
formance could be primarily
attributed to HP’s proprietary Twain
drivers.

The final speed test was conducted
using the test photograph. The scanning was

done at 300 dpi in full colour mode and subse- Contents
quently in gray scale mode, using the maximum TEST PROCESS . .. .. . 100
bit-depth offered by the scanner. FLATBED SCANNERS 100
In gray scale mode, the HP ScanJet 5300C Acer ScanPrisa 640BU
emerged the winner with a timing of 13.5 sec- Acer ScanPrisa 640U
onds. The Umax Astra 2400S, which is a SCSI Acer ScanPrisa 1240UT
scanner, came in second by clocking 15 seconds. Epson 1240U Photo
The fastest scanner in full colour mode was Epson 1640SU
the Epson Perfection 1640SU. It scanned the test HP Scanjet 5300C
photograph in just 25.31 seconds. The first run- A SRR
ner-up was the Umax Astra 3400 with a timing RIS ST SRS
of 31 seconds. This scanner, however, gave an mljc;gslggggsgker %6
average performance in the other tests. The UMAX Astra 3400
results indicated that the Epson Perfection UMAX Astra 3450
1640SU is the best suited for office UMAX Astra 2000p
applications because of its UMAX Astra 2400S
speed in scanning the pho- UMAX Astra 4000U
tograph, although it was UMAX iA101
not quite as fast in BOXES
scanning the text L can -
document. How Much Colour Depth? ..102
The Umax Astra Scanning Transparencnes ...103
. An Eye for Detail .......... 104
- : 3400 is the perfect SCORE BOARD . . . ... 104
/ buy if you are looking DECISION MAKER . ...... 103
for an inexpensive CONCLUSION .......... 105

HP ScanJet 5300C scanner for home use.
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USB or SCSI?

Almost all low-end scanners use a par-
allel port with a pass-through for a
printer to also connect to the computer.
This provides an inexpensive way to
connect both the printer and the scan-
ner to the computer. The downside to
this is that speed is compromised and
the other external Zip drives that need
the parallel port cannot connect to the
scanner. USB devices have been very
successful in the market and you
should opt for a USB connection over a
parallel connection since it offers
increased plug-n-play support, greater
reliability and better flexibility.

A high-end scanner usually comes
with a SCSI connector. This is because
SCSI connectors can handle a lot of
data—a feature that is needed when
dealing with large files. SCSI connectors
usually ship with their own card and
the SCSI connector of a scanner is likely
to be incompatible with other SCSI
cards.

If you are buying a low-end scanner
with a resolution of less than 600 dpi,
then opt for a USB device, while if you
need a high-end scanner, a SCSI con-
nector is a good choice.

It would be unfair to omit mentioning
the Epson 1240U Photo, which wasn't far
behind in any of the tests but couldn’t
make it to the ranks of the top three.
Although it took more time than expected
(84 seconds) for scanning the test photo-
graph in full colour mode, it logged above-
average results in all the other speed tests.

Overall, the HP ScanJet 5300C emerged

Speed test of documssnt in
gray scale [seci
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Neer ScanPrize G40EL e 340
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Mid-Ranpe Scanners

Epsan Ferlection 164050 B b5
HF Scanjet 53000 I 73,34
Epzan Perfection 12400 Phota B 8031
IBAAY Aste 0000 I 7R5R
HF Scanjet 63500 W 18.75
Rurged Scanners
UMAX Astra 3450 I 13
fcer Seanfrisa 4060 I 11.35
UMAE Astra 2000p I 2326

LK AacraMET le101 O 17
IMAX Astra 3400 I 15.81

as the fastest scanner in the speed test and
the quality of the scans was also quite
impressive. The Epson Perfection 1640SU
came in a close second.

Image quality evaluation using IT8 card
This is one of the most comprehensive tests
to evaluate the performance of imaging
equipment. It was used to evaluate the abil-
ity of the scanners to differentiate between
fine nuances in colour and luminosity.

To ascertain the scanner’s ability to dis-
tinguish tonal resolution in gray scale
areas, a set of 22 different blocks were
observed to check for blending between
adjacent blocks. This test determines the
accuracy of the scanner in reproducing the
various colour blocks in the IT8 card.

First, we checked if the scanner could
accurately pick up the 22 different shades
of colour. In order to log the most accu-
rate values, we used the histogram func-
tion in Photoshop. We scanned the IT8
card onto Photoshop using the maximum
optical resolution and bit-depth offered by
the scanner in full colour mode. We select-
ed an area that comprised 50 per cent each
of two adjacent blocks and ascertained the
standard deviation using Photoshop’s his-
togram option. If the reading was greater
than or equal to 2, then it implied that the
scanner had differentiated between the
two blocks. All the scanners but one passed
this test by differentiating between adja-
cent blocks right up to block No 22. The
exception was the Mustek 1200CUB,
which could only detect differences among
the first 21 blocks.

The next test performed using the IT8
card was the colour uniformity test. In this
test, seven coloured blocks in the A row
were selected in Photoshop. These were
the lightest blocks in the row with very fine
variations among them. Again the his-

Spead t=at of 2at-photograph in
full enloarr mode (sex)

Mig-Aanps Scanners

Ereson Peefection 164050 I 36.03
HF Scanjet B300C W 33
Epsson Perfection 12400 Photo I G4
URAAY fztra AD00U N 117
WP Scanjet B3E0G - ELE

Budget Scamers

UMAAY Asien 3450 0 9737
Az ScanPrisa G40BU D113
LSTAKR Asira DU - Kk
UMAY AstraNET 107 [ BA
URIAY fztra 3400 BN 24

togram function in Photoshop was used to
determine the standard deviation of the
red, green and blue colour values. The cri-
terion was the same: a value of 2 or high-
er meant that the scanner had successfully
detected the colour variations. Although
none of the scanners scored below 2, many
of them failed to pick up the green tones
accurately.

The HP Scanlet 6350C recorded the

How Much Colour Depth?

Colour/bit depth is often wrongly asso-
ciated with the number of colours a
scanner can pick up. The bit depth is
actually the number of levels of colour
that a scanner can distinguish between.
The extent of brightness values that a
scanner captures (also called the
dynamic range) depends upon two fac-
tors—the sensor and the analog-to-digi-
tal converter (ADC). For photos, the
minimum depth needed is 24-bit, that
is, 8-bits per colour or gray shade.
However, even high-end 24-bit scan-
ners often reduce the number of bits
from 8 to 6. This means that the image
does not have a 24-bit depth and so
quality suffers. Also, the 6-bit colours
tend to gather around the mid-tones,
leading to deterioration in quality of the
shadows and highlights. As the bit-
depth increases, the output quality of
the scanner should also increase. How-
ever, some manufacturers use a 24-bit
scanner with a 10-bit ADC instead of an
8-bit ADC. This improves image quality
to such an extent that it may even be
better than a 30-bit scanner. However,
you would need 30 bits or more for
scanning slides or films.
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lowest RGB tone readings (4.31, 3.11, and
4.35 respectively), while the Acer Scan-
Prisa 640U registered the best combined
RGB value, with the individual readings

Scanning Transparencies

If you want to scan transparencies,
slides or negatives, you have to place
the original between the light source
and the sensor so that light passes
through it before it reaches the sensor.
But most consumer-level transparency
scanners place both the light source
and the sensor on one side. Due to
this, the sensor can actually pick up
light as it reflects off the original. In
such cases, you will need a transparen-
cy adapter (TPA), which is nothing but
a backlight to replace the cover of the
scanner. Not all scanners support TPAs,
and the adapter costs between Rs
4,500 and Rs 13,500. Some high-end
scanners come packed with the TPA.

An alternative method is to have a
slide-out tray so that there is no glass
surface between the original and the
sensor. This reduces what are called
Newton Rings. The downside is that
these scanners cost around Rs 36,000.

Yet another option is to go in for a
slide or transparency (4x5) scanner.
These scanners focus on a small area
and provide a high optical resolution
for enlarging small negatives or slides.
But good slide scanners are expensive,
costing between Rs 40,000 and Rs
90,000.

The feature that you need to consid-
er for scanning negatives or slides is
optical density (OD). The higher the
OD, the better the scanner. The OD is
usually associated with the colour
depth. For instance, the OD of a 24-bit
scanner is generally less than that of a
36-bit scanner. But scanners with the
same colour depth can have different
optical densities.

Most scanners today have an OD of
about 2.9, which is sufficient for scan-
ning normal pictures. Slides and trans-
parencies scan better with an OD of at
least 3.2, and negatives need an OD of
3.4. An easy way of differentiating
between a good scanner and a con-
sumer-level device is to look at the
packaging—a consumer-level scanner
will never have the OD printed on its
specs sheet.

being 11.65, 6.48 and 6.3, respectively. This
implies that the ScanPrisa 640U’s CCD
(charged couple device) is of very high
quality since it is wholly responsible for the
detection of variations in colour tones.

In the last test in this series, we evalu-
ated the tone detection in the shadow and
bright areas of the IT8 card. We selected
the area from block 1 to block 4 (F1-F4)
for detecting variations in the shadows,
and block 9 to block 12 (F9-F12) to test
the detection of tones in the bright areas.
Two blocks were selected, for instance, F1

Microtek ScanMaker 3600

and F2. The maximum area was selected
and the standard deviation of the individ-
ual RGB values was noted down for both
the shadow and bright regions of the T8
card. Many of the scanners had problems
in detecting the green tone and scored less
than 2. The scanner that did well in this
test was the HP ScanJet 6350C. It logged
impressive results in the detection of red
tones in the shadow region, but performed
poorly in detecting the green tone, as did
all the other scanners that we tested.

The scanners that gave consistent read-
ings in all the three tests were the HP Scan-
Jet 5300C and the Microtek ScanMaker

3600. The Umax AstraNET iA101 turned
in the poorest performance—the standard
deviation score for red was a dismal 0.47.
The Acer ScanPrisa 640U also recorded
poor readings in these tests.

Resolution test

This test evaluates the ability of the optics
used in the scanner to detect the smallest
possible details on the target document.
We used a resolution card containing five
blocks, each of which is made up of very
fine lines that are created at a particular
resolution. The first block was of 120 ppi
(points per inch) while the fifth block was
of 2400 ppi. The scan was done both in full
colour and gray scale modes, and at
the maximum optical resolution
and bit-depth. It was then convert-
ed to 8-bit mode in order to
use Magic Wand, which
doesn’t work on the
. directly scanned image.
~ The tolerance was kept
at 8 as opposed to the
default value of 32. The indi-
vidual scans were checked to
ascertain the scanner’s ability to
pick up a particular resolution. All the
scanners passed the third block effortless-
ly in gray scale mode, but many of them
failed to detect even a single line in the
fourth block (1200 ppi). The Microtek
ScanMaker 3600 and the Umax Astra 3400
failed to detect even the second block in

full colour mode.

The winner in this test was the Umax
Astra 4000U, which detected all the indi-
vidual lines in the fifth block. This scanner
returned above-average results in the other
tests but could not make it to the top three.
The only other scanner that matched this
performance was the Epson Perfection
1240U Photo. Although it could not detect
the fifth block in full colour mode, it man-
aged to do so in gray scale mode.

Performance

b T

Price

Performance

Price

Acer ScanPrisa 640U

HP Scanjet 6350C

Epson Perfection 1640SU

HP Scanjet 6350C
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Specifications

BOARD
SPECIFICATIONS
Manufacturer Dealer Phone E-mail Price Max. Max. Light source Scanning
Resolution ~ Resolution element
(Optical) (Interpolated)
AceR ScanPrisa 640BU Acer Peripherals 022-5705230 pankajpamani@acercm.com.tw Rs 6,700  600x1200 19200x19200  Cold cathode fluorescent CCD
AceR ScanPrisa 640U  Acer Peripherals 022-5705230 pankajpamani@acercm.com.tw Rs 5500  600x1200 19200x19200  Cold cathode fluorescent CCD
AceR ScanPrisa Acer Peripherals 022-5705230 pankajpamani@acercm.com.tw Rs 16,000 600x1200 19200x19200  Cold cathode fluorescent CCD
1240UT
Epson 1240U Photo Epson India Itd 080-5321266-70 sheetal@eid.epson.co.in Rs 19,500 1200x2400  9600x9600 White cold cathode fluo-  ColorMatrixCCD
rescent lamp line sensor
Epson 1640SU Epson India Itd 080-5321266-70 sheetal@eid.epson.co.in Rs 22,500 1600x3200  12800x12800  White cold cathode fluo- Color MatrixCCD
rescent lamp line sensor
HP Scanjet 5300C Hewlett Packard (1) Itd 011-6826000 princy_bhatnagar@hp.com Rs 12,499 1200x2400  9600x9600 Dual cold-cathode CCcD
flourescent
HP Scanjet 6350C Hewlett Packard India Itd  011-6826000 princy_bhatnagar@hp.com Rs 26,499 1200x2400 999,999 Dual cold-cathode CCcD
flourescent
MICROTEK Scanmaker Microtek International 491 3986/87/ info@compuageindia.com Rs 4,550  600x1200 9600x9600 Cathode fluorescent CCD
3600 Ltd. 88/89/90 lamp
MICROTEK Microtek 491 3986/87 info@compuageindia.com Rs 7,250  600x1200 9600x9600 Cathode fluorescent CCD
Scanmaker X6 International Ltd. /88/89/90 lamp
Mustek 1200CUB Integra Micro Systems 8207208/8215179 mumbai@integramicro.com Rs 9,000  600x1200 19200x19200  Cathode fluorescent CCD
Pvt. Ltd. lamp
UMAX Astra 3400 Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 5550  600x1200 9600x9600 Cold cathode lamp CCD
UMAX Astra 3450 Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 9,950  600x1200 9600x9600 Cold cathode lamp CCcD
UMAX Astra 2000p Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 3,900  600x1200 9600x9600 Cold cathode lamp CCcD
Cold cathode lamp
UMAX Astra 2400S Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 18,000 600x2400 9600x9600 CCD
UMAX Astra 4000U Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 17,000 1200x2400  9600x9600 Cold cathode lamp CCcD
UMAX iA101 Neoteric Infomatique 022-4172600 sales@neoteric-info.com Rs 6,500  600x1200 9600x9600 Cold cathode lamp CCD

An Eye for Detail

The feature to look out for in scanners is
resolution. Basically, this means the opti-
cal resolution, or the information the
scanner has actually acquired, and the
interpolated resolution, which is the reso-
lution attained after applying several
enhancements to the image. If you are
looking for greater detail in the docu-
ment/picture, then you should go in for a
scanner with a higher optical resolution.
However, if you just want to enlarge the
photos, then a higher interpolated resolu-
tion is what you need.

For images with few details, an optical
resolution of 300 dpi will be sufficient. But
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for scanning line art and detailed images,
you will need a scanner with an optical
resolution of 600 dpi. Some film and slide
scanners offer a resolution of 1200 dpi.

However, it is advisable not to scan at
the maximum resolution your scanner sup-
ports because the quality of the image suf-
fers when it is passed through an image
editing software. Also bear in mind that
quality at a given resolution differs in the
case of scanners offering different maxi-
mum resolutions. For example, an image
scanned at 300 dpi would look clearer if
scanned from a 1200 dpi scanner than if
scanned from a 300 dpi scanner.

Test photograph evaluation

This was a real-world test wherein we
printed a full A4-sized photo in the high-
est quality mode using photo paper. Here,
we looked out for the overall reproduction
of the image and compared it with the
original one in terms of colour reproduc-
tion, tones of the image and the hues in
specific portions. A total of 11 results were
logged in this test.

One scanner that really stood out in
each of these 11 tests was the Epson Per-
fection 1640S.

The Umax Astra 4000U also performed
impressively, but lost out in its reproduc-
tion of the finer details. The Microtek
ScanMaker 3600 turned in the poorest
results, and the ScanMaker X6 was also
disappointing.
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OTHERS

Color AD ScanArea Scanning Scanning  Physicial Dimensions Weight  Interface TP Bundled Software Overall
Density  Converter (ininches) | method surface (DXWxH) - cms Adaptor Grades
(LxB) cms
48-bit Yes 8.5x11.7 F/B 8.5x11.7 19x12x3.5 8.8lb usB No Ulead PhotoExpress,ABBYY FineReader OCR soft- B+
ware,Presto! PageManager
48-bit Yes 8.5x11.7 F/B 8.5x11.7 19x12x3.5 8.8lb usB No Ulead PhotoExpress,ABBYY FineReader OCR soft- B+
ware,Presto! PageManager
48-bit Yes 8.5x11.7 F/B 8.5x11.7 18x12x3 8.8lb usB No "ABBYY FineReader,Presto! PageManager,ScanButton B
software,Ulead PhotoExpress"
42-bit Yes 8.5x11.7 F/B 8.5x11.7 269x435x93mm (W.D.H)  2.8kg usB Yes PageManager,ScanButton software,Ulead A-
PhotoExpress "
42-bit No 8.5x11.7 F/B 8.5x11.7 17.4x11.4x3.8 45kg usB Yes Adobe PhotoDeluxe, ScanSoft Textbridge Pro OCR; A-
ArcSoft PhotoPrinter, ArcSoft Panorama Maker.
36-bit Yes 8.5x11.7 F/B 8.5x11.7 19.9x11.9x4.1 8.1llb usB No Adobe PhotoDeluxe, ScanSoft Textbridge Pro OCR; B+
ArcSoft PhotoPrinter, ArcSoft Panorama Maker.
36-bit No 8.5x11.66 F/B 85x11.66  19.6x12.3x7.6 1271b  USB/SCSI2 No HP PrecisionScan,PhotoDeluxe, Hemera PhotoObject A-
gallery, Hemera NetGraphics, Internet DesignShop
42-bit Yes 8.5x11.7 F/B 8.5x11.7 290x100x440 - usB No HP PrecisionScan, HP Scanjet Copy utility,Hemera B
PhotoObject Gallery, WebShop Designer 5.0.
36-bit No 8.5x11.7 F/B 8.5x11.7 11.5x3.2x17.3 111b SCsI No Adobe PhotoDelux,Photolmpact, Caere B
OmniPage,Caere PageKeeper,Trellix Web.
48-bit No 8.5x11.7 F/B 8.5x11.7 16.1x10.6x1.4 421b usB No MICROTEK Scansuite, Photolmpact,Kai's B
PhotoSoap,Caere PageKeeper,Caere OmniPage
42-bit Yes 8.5x11.7 F/B 8.5x11.7 18.2x11.6x2.6 - usB No Ulead Photo Express, Text Bridge OCR B
42-bit Yes 8.5x11.7 F/B 8.5x11.7 18.2x11.6x2.6 - usB TP Adobe Photo Deluxe,Caere OmniPage, NewSoft B+
cover Presto! PageManager, NewSoft Vistashuttle.
36-bit Yes 8.5x14 F/B 8.5x14 21.4x13x4.1 991b Parallel No Adobe Photo Deluxe,Caere OmniPage, NewSoft B+
Presto! PageManager, NewSoft Vistashuttle.
42-bit No 8.5x14 F/iB 8.5x14 21.4x13x4.1 9.91b SCsI No B+
42-hit Yes 8.5x11.7 F/B 8.5x14 21.4x13x4.1 9.91b USB No Adobe Photo Deluxe A-
Yes F/B 8.5x11.7 18.2x11.6x2.6 - usB No MGI Photo Suite Ill, OCR, Mailpack B+
CONCLUSION Perfection 1640SU was the clear winner. The HP Scanlet 6350C was also a note-

After putting all the scanners through our
speed and image quality tests, we came up
with a set of choices for virtually any appli-
cation.

In terms of sheer
speed as well as overall
performance, the Epson

Due to its high price tag, this scanner is not
the best option for most home users, but it
is definitely a very viable option for the
demanding office user
who is looking for the
best scanning solution
in the sub-Rs 30,000
price range.

worthy performer, delivering excellent
quality both in the photo and the combi-
document tests, and at very impressive
speeds.

In the budget category, the Acer Scan-
Prisa 640U turned in an excellent per-
formance and is an ideal buy for home
users who are looking for both quality and
speed at an affordable price.

The runner-up in this range was the

- Umax Astra 3450, with its high cost being
. the only drawback of this scanner.

With the steady advancement of optical

[ technology coupled with declining prices,

il \.\ ,--“’f ’ scanners are rapidly penetrating the home

Acer ScanPrisa 640U

Epson Perfection 1640SU

segment. For all you imaging buffs out
there, the future of imaging looks really
clear and sharp!fl
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IN TEST: 21 INKJET PRINTERS

.
4

For ardent fans of the world of ink
and paper, vivid colours and
breathtaking resolutions are now
within reach, with a plethora of
inkjet printers to choose from

MENLYN NORONHA

rom stunning greeting cards to your hous-

ing society’s newsletter, today’s inkjet print-

ers are capable of some of the most realistic
images and sharp text printouts today.

Printer technology has not really witnessed
as drastic a change as that seen in other realms of
computing such as 3D graphics processing, but
it has seen a very significant drop in terms of the
technology available for a given price.

Until about six months ago, for instance, 1440
dpi printing was imaginable only in the profes-
sional printing segment, and home and SoHo
users had to be content with a 600 dpi resolu-
tion. However, today’s printing technology lets
even home users enjoy full colour printing at
high densities, and at prices that put inkjet-print-
ing technology within the reach of most home
users.

TEST PROCESS

The test system consisted of a Celeron 466-
based computer with 128 MB SDRAM, a
440BX-based motherboard, and a 20 GB Sea-
gate U8 IDE hard disk. Since the performance of
the printers also depends on the interface, we
configured the parallel port to operate using the
ECP+EPP mode. The USB ports were also
enabled on the system to support printers that
featured this interface.

We loaded Windows 98 SE on a cleanly for-
matted system and mapped the image of the
drive with the OS and all the drivers loaded. This
image was restored after each printer was tested
0 as to eliminate any interference from previ-
ously loaded printer drivers.

Each of the printers was subjected to a range
of tests that evaluated their performance on two
basic parameters—printing speed and image
quality. For ascertaining the print speed, we used
a sample document file that consisted of five

Interactive,,

More Info on

the test process and the
products tested, check out
Mindware
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Inkjet printers penetrated the home seg-
ment only a few years back. Vendors such
as HP and Canon developed inkjet-print-
ing technology in the 1980s, but the pre-
vailing prices were beyond the reach of
most home users.

Working with these printers was also
an expensive affair due to the cost of the
ink used, the ink wasted during printing,
and the overall expenditure involved in
maintaining these printers. Dot matrix
printers then were really slow and noisy
and had many other disadvantages, but
inkjet printers came into the scene and
changed all that. With advancements in
technology, these printers became
increasingly efficient, and as sales vol-
umes picked up, the prices too started
steadily declining.

sample letters, each having text combined
with a graphic logo. The time taken to
print out this sample file in black-and-
white and gray scale modes was logged.

The image quality test consisted of two
tests that were run using two separate sam-
ple prints. The first document was a com-
bination of text, vector graphics and
photos. The output of this document was
evaluated to determine the printer’s per-
formance in terms of its ability to reproduce
converging lines, concentric circles, high
contrast text on a dark background, and the
finer details in the original document.

To evaluate the performance of the
printer in handling photographic prints,
we used an actual A4-sized photograph
that featured many variations in hue and
brightness, and also had many details and

Printing Speed
(5-page document in seconds)

Mid-range Frinlers

Fpson Styles Photo 570 I 157
Epaon Stylus Calor 350 I G0
Hewlell Packan] Diskde 700y W A3
Hewlett-Packand DeskJst 9900 MW 43
Eodsk Persunal Pictune Maker 200 NA

dudgat Printars
Hawslett-Fackard DeskJet 2200 I A3
Hevalell-Packerd Deskde S30C [ G4
Ganan BJC 5100 (NI 76

Leemzrk 242 I 4G
leemark 757 [ 35
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Printers, Then and Now

Today, most of these printers use either
thermal or piezoelectric technology.
Thermal technology: This is the technolo-
gy used in the Canon and Hewlett-Packard
range of inkjet printers. Here, heat is used
to fire ink onto the paper. The ink is actu-
ally squirted onto the paper, and this
process is initiated by heating the ink to
create a bubble until the pressure forces it
to burst and hit the paper. The bubble
then collapses as the ink cools, and the
resulting vacuum draws ink from the
reservoir to replace the ink that was eject-
ed. Tiny heating elements are used to
eject ink droplets from the print head’s
nozzles.

Piezoelectric technology: This is a propri-
etary Epson technology wherein a piezo
crystal is placed at the back of the ink

fine nuances.

We also considered features such as
build quality, thoroughness of the docu-
mentation, bundled software, etc, with
points being awarded for each feature.

Based on the price, two categories
emerged: budget printers priced
below Rs 15,000, intended for
home use, and mid-range
printers costing more
than Rs 15,000, used
more in offices.

Speed

For comparing the
speed of the printers,
the text document was

printed in normal | eymark 752: Sturdy and fast

draft mode (or

black-and-white mode) on plain paper,
and then again using gray scale mode. We
then printed the image document in both
gray scale and normal colour modes on
plain paper. We logged the time taken for
each of these printouts to determine the
printer’s performance in each of the two
modes.

The Lexmark Z52 clocked the fastest
time of 36 seconds for printing the five-
page text document in normal mode, fol-
lowed by Hewlett-Packard’s DJ 990Cxi (42
seconds) and the Epson Stylus Color 880
(60 seconds). So if the bulk of your print-
ing applications at home or office involves
text documents, the Lexmark Z52, with its
combination of speed and excellent print
quality, is the best choice.

reservoir. The piezo element oscillates
when subjected to electrical voltage. To
generate an ink drop, a current is applied
to the piezo element. The element flexes
and in doing so, it shoots a drop of ink out
of the nozzle. The process helps to main-
tain control over the shape and size of the
ink droplet. The tiny fluctuations in the
crystal allow for smaller droplet sizes and
hence higher nozzle density.

The speeds of printers using either of
these two technologies have increased
tremendously over the years. You can now
choose from among various types of print-
ers, and can also print in multiple modes
(such as economical mode and best quali-
ty mode). So the next time you take an
inkjet printout, think of the amazing tech-
nology that makes it possible.

It printed the text document in gray
scale mode in 55 seconds, which was the
fastest time logged in this mode. The run-
ners-up (in gray scale mode) were the Lex-
mark Z42 (61 seconds) and the Canon BJC

2100SP (88 seconds).

You may well wonder why
£ you would ever need to print
a document in gray scale
mode. Well, if you have
used colours in a docu-
ment and just need a
printout to proof it, you
could take the printout in gray
scale mode and save your
expensive colour cartridge for
the final printouts.
In the image document test in
normal mode, the winner was the
Epson Stylus Color 880 with a print speed
of 31 seconds, followed by the Canon BJC
5100 (43 seconds) and the Epson Stylus
Color 680 (62 seconds). If you need a
printer to execute volume-printing tasks
in colour, go for the Epson Stylus Color
880.

In the final speed test, wherein the
image document was printed in gray scale
mode, the Epson Stylus Color 680
emerged as the winner with a timing of 44
seconds. Three printers came in a close
second—the Lexmark Z52, the Epson Sty-
lus Color 880, and the Epson Stylus Photo
870, with all three clocking 63 seconds. So
if you regularly proof images and want to
conserve your colour cartridge, you have
a choice of four printers.
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Image quality
When you consider buying a printer, the
image quality it offers is sure to be upper-
most on your mind. If the test of a printer
is in its ability to print image documents
that are faithful to the original, then its
ability to print documents with text and
images combined may be considered the
acid test. We divided the image
quality test into two

parts:
The  combi-docu- |
ment: This docu-

ment, as mentioned
earlier, contained both
high-resolution images
as well as text, which
were combined in a
manner that would com-
prehensively test the print-
er’s image reproduction
capabilities, including its ability to
replicate the finer details of the
original.

The Flower-Woman photo:
This was the second part of the
test procedure wherein the image (see
image in the Scanner comparison test) con-
tained several minute details, such as the
wrinkles on the woman’s forehead, details
in the clothing, contrast and sharpness in
the flowers, etc that would put the printer
to the test.

Image quality (combi-document)

We used photo quality inkjet paper, and
the document was printed in photo or
high-resolution mode as opposed to the
normal or draft mode that was used in the
speed test. We observed the four-colour
checkered box in the output to evaluate the
colour depth and the sharpness of the
checks. Only five printers passed this test
without any errors—the Epson Stylus
Color 870, the Epson Stylus Color 880, the
Canon BJC 5100, the Canon BJC 7100,
and the Wipro Emerge e7460. Seven of the
printers displayed an almost flawless per-
formance—for instance, the HP DJ 930C
lost a point for pixelation in the black
checks, while the Epson Stylus Color 680
lost a point for uneven checks.

The concentric circles image, which
had lines drawn from the centre to the cir-
cumference of the outermost circle, was
checked for accuracy of reproduction. The
Epson Stylus Photo 870 secured the high-
est score allocated for reproducing this fea-
ture, while the others lost out because of
jagged lines or non-uniform colouring.

Next, we observed the seven coloured
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HP DeskJet 990Cxi: High in quality
but also in price

bars with 10 levels of colour saturation
to determine each printer’s ability to cap-
ture the colour variations. The winner in
this department was the Hewlett-
Packard DJ 990Cxi—it was able to accu-
rately reproduce 59 of the 70 coloured
boxes. The same
vendor’s DJ
930C came a
"{ & close second
by flawlessly
picking up 56
of the 70
boxes, while
-~ the Epson Sty-
" lus Photo 870
took third place
by picking up 55
boxes.

The next sec-
tion we observed
was the black box
with the yellow
text. Here again,
the Hewlett-
Packard printers
took the top positions and were followed
closely by the Epson Stylus Color 880 and
the Kodak Personal Picture Maker 200.
The Lexmark range fared the poorest, with
all the outputs displaying a splurge of
black without even a tint of the yellow
colour of the text in the original.

We also considered a passport-sized
photograph of the flower-woman to deter-
mine the printer’s ability to pick out

&

minute details even from such a small
image. The joint winners here were the
Hewlett-Packard DJ 990Cxi and the
Kodak PPM 200, with the Epson Stylus
Color 880 and three other HP printers los-
ing out narrowly.

Finally, we determined the printer’s
ability to pick up small font sizes by observ-
ing the reproduction of the text printed in
four different font sizes. This is a relevant
feature if you want to print multiple pages
in a single sheet: You would then have to
depreciate the font size and would want
your printouts to still be readable.

All the Lexmark printers barring the
Z12, as well as HP’s 990Cxi, 970Cxi, 930C,
and 950C, were able to print three of the
font sizes. Others that matched this per-
formance were the Kodak PPM 200, the
Epson Stylus Photo 870, and the Canon
BJC 7100.

We then aggregated the scores achieved
by each printer. The overall winners were
the Canon BJC 7100, and Hewlett-
Packard’s DeskJet 950C, 840C and 930C.
The other impressive performers were the
Lexmark Z52, the Hewlett-Packard DJ
990Cxi, and the Kodak PPM 200.

Image quality (Flower- woman)
We concluded the image quality test by
observing the printouts of the Flower
Woman photo, and this was the most cru-
cial part of the test as the image contained
numerous minute details.

We checked for faithful reproduction

Inkjet Maintenance

Here are a few tips on maintaining your
inkjet printer:

Aligning/calibrating the print head: This
is one of the most important tasks to be
performed after installing a new printer or
a new cartridge. If the print head is not
calibrated properly, it may result in abnor-
mal or bad print quality. The newest
range of printers from Hewlett-Packard
have an automatic calibration process
wherein the print head is calibrated auto-
matically after the printer is installed or
when the printer detects a cartridge
change.

Cleaning the print head: If you
encounter problems while printing, such
as abnormal linings, bandings, uneven ink
flow, or missing colours, the printer noz-
zles are probably clogged with excess
dried ink that needs to be cleaned. This

can be done from the toolbox or the
monitoring software that gets installed
along with the printer drivers. Generally, a
test pattern is printed while the cleaning
process is on, and this can help you
determine whether a particular cartridge
is out of ink.

Checking for paper jams: This is a fre-
quent problem with inkjet printers, and
could happen because of dust collecting
in the paper path. You have to clean the
printer regularly, especially the area near
the paper output tray. Check for bits of
paper and even stapler or paper pins that
could cause paper jams and eventually
damage the printer’'s assembly. It is a
good practice to use a blower or vacuum
cleaner once in a while to remove dust
from the parts that are not accessible with
your bare hands.
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!!!!! Specifications
- @

Manufacturer ~ Model Dealer Phone E-mail Price Resolution  Interface Input buffer
Canon BJC 1000SP CRR Centre* 011- 6806572  brijesh@canon.co.in Rs 3700 720 X360  Parallel 10 KB
Canon BJC 2100SP CRR Centre 011- 6806572  brijesh@canon.co.in Rs 4000 720 X 360  Parallel/USB 54 KB
Canon BJC 3000 CRR Centre 011- 6806572  brijesh@canon.co.in Rs 6500 1440 X 720  Parallel/USB 128 KB
Canon BJC 5100 CRR Centre 011- 6806572  brijesh@canon.co.in Rs 9500 1440 X 720  Parallel 4 MB
Canon BJC7100 CRR Centre 011- 6806572  brijesh@canon.co.in Rs 13000 1200 X 600 Parallel 256 KB
Canon BJC 50G CRR Centre 011- 6806572  brijesh@canon.co.in Rs 15000 720 X360  Parallel/ IRDA 32 KB
EPSON Stylus Colour 680 Epson Singapore PLtd  080-5321266  sheetal@eid.epson.co.in Rs 8000 2880 x 720  Parallel /USB = 32 kb
Hewlett-Packard DeskJet 840C HP India 011-6826000  princy_batnagar@hp.com Rs 8499 600 X 1200 Parallel /USB 2 Mb
Hewlett-Packard DeskJet 930C HP India 011-6826000  princy_batnagar@hp.com Rs 10990 2400 x 1200 Parallel /USB 4 MB
Hewlett-Packard DeskJet 950C HP India 011-6826000  princy_batnagar@hp.com Rs 11499 2400 x 1200 Parallel /USB 4 MB
LEXMARK 712 T.V.S Electronics 044-2325506 ~ ap.aditya@tbg.tvse.co.in Rs 4295 1200 x1200 Parallel /USB ~ NA
LEXMARK 722 T.V.S Electronics 044-2325506 ~ ap.aditya@tbg.tvse.co.in Rs 4495 1200 x1200 Parallel /USB ~ NA
LEXMARK 732 T.V.S Electronics 044-2325506 ~ ap.aditya@tbg.tvse.co.in Rs 5495 1200 x1200 Parallel /USB ~ NA
LEXMARK 742 T.V.S Electronics 044-2325506 ~ ap.aditya@tbg.tvse.co.in Rs 8695 2400 x1200 Parallel /USB ~ NA
LEXMARK 752 T.V.S Electronics 044-2325506 ~ ap.aditya@tbg.tvse.co.in Rs 10995 2400 x 1200 Parallel /USB  NA
Wipro eMerge e7460 Wipro Pheripherals Ltd  080-6397418  helpdesk.mumbai@wepindia.com Rs 4500 (Only colour cartridge) 600x 600  USB 512 KB
[MID-RANGE |

EPSON Stylus Colour 880 Epson Singapore . Ltd ~ 080-5321266  sheetal@eid.epson.co.in Rs 19000 2880 x 720  Parallel/lUSB 256 kb
EPSON Stylus Photo 870  Epson Singapore P. Ltd  080-5321266  sheetal@eid.epson.co.in Rs 19500 1440 x 720  Parallel/USB 256 kb
Hewlett-Packard DeskJet 970Cxi  HP India 011-6826000  princy_batnagar@hp.com Rs 19990 2400 x 1200 Parallel/USB 4 MB
Hewlett-Packard DeskJet 990Cxi  HP India 011-6826000  princy_batnagar@hp.com Rs 24499 2400 x 1200 Parallel/USB 8 MB
Kodak PPM 200 Summit Infotech 011-6517995  vkalyan@summitindia.com Rs 18000 1200 x 1200 USB NA

*CRR Centre —Cannon Reseller Response Centre

of details such as the colour of the
woman’s teeth and the wrinkles on her fore-
head, and looked out for signs of dithering
or graininess in the print. Three printers
performed exceptionally well here—the
Epson Stylus Color 880, the Epson Stylus
Photo 870, and the Kodak Personal Picture
Maker 200. Those that narrowly lost out,
primarily due to dithering and poor con-

trast quality, were the Lexmark Z52 and the
Hewlett-Packard DJ 990Cxi.

Features

We considered features such as build qual-
ity, documentation, bundled software,
accessories offered with the standard pack-
age, the type of power connector provided,
etc., with points being allocated for each

Performance

 Features

Performance

Lexmark Z52

Canon BJC-3000

Epson Stylus Color 880

Features

114 EAE

HP 990 CXi

feature. Printers that printed even when
the lid was open incurred penalty points,
since it is not safe to print with the lid
open, especially if there are children
around. Most of the Lexmark models
printed even when the lid was kept open.
Dual-side printing facility was offered only
by the HP printers, with some models
offering it as an optional feature. But
although the Canon BJC 2100SP and the
Lexmark Z52 don’t posses this mecha-
nism, the software manipulates the entire
process by first printing alternate pages
and then flashing an online message that
prompts you to reverse the sides and place
the pages in the input tray in the correct
sequence.

The printers from Lexmark, Epson and
Canon display an online print status win-
dow that helps you keep track of the print
jobs that have been fired.

The Lexmark Z52 emerged as the most
feature-rich printer, followed by the
Canon BJC-3000, the Hewlett-Packard
970Cxi and the Lexmark Z42.
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TECHNICAL DETAILS

Rated print Paper Cartridges included Rated black  Rated color  Printing technology Weight (Kg) Physicial Dimensions Users Power Overall
speed capacity cartridge life  cartridge life (DxWixH) - cms Manual Cord Grades
4 PPM 50 Pages  Black & Colour 600 Pages 100 Pages Bubblejet Ink On Demand 2.2Kg 360mm x 174mm x 160mm Yes Yes B
5PPM 50 Pages  Black & Colour 1800 Pages 130 Pages Bubblejet Ink On Demand 24Kg 370mm x 191mm x 164mm Yes Yes B+
9 PPM 50 Pages  Black & Colour 500 Pages 280 Pages Bubblejet Ink On Demand 3.7Kg 418mm x 3.6mm x 169mm Yes Yes A-
10 PPM 130 Pages  Black & Colour NA NA Bubblejet Ink On Demand 5.3Kg 498mm x 279mm x 222mm Yes Yes B+
8 PPM 130 Pages  Black & Colour 900 Pages 320 Pages Bubblejet Ink On Demand 6.4 Kg 467mm x 313mm x 218mm Yes Yes A-
5.5 PPM 30 Pages  Black & Colour 170 Pages 40 Pages Bubblejet Ink On Demand 900 Grams  302mm x 112.5mm x 49mm Yes Yes B
3.8PPM 100 Pages  Black & Colour 600 PAGES 300 PAGES  Epson Micro piezo 4.1Kg 450mm x 547mm x 259mm Yes Yes A-
5PPM 100 Pages  Black & Colour NA NA HP Thermal Inkjet 5.66 Kg 18'x 7'x 14" Yes Yes B
7.5 PPM 100 Pages  Black & Colour NA NA HP Thermal Inkjet 5.7Kg 440mm x 196mm x 400mm Yes Yes B+
8.5 PPM 100 Pages  Black & Colour NA NA HP PhotoRet Ill CIr Layering 5.94 Kg 440mm x 196mm x 370mm Yes Yes B+
3PPM 100 Pages  Colour Cartridge Only NA NA Thermal Inkjet 1.8 kg 296mm x 373mm x 678 mm Yes Yes B
3.5PPM 100 Pages  Colour Cartridge Only NA NA Thermal Inkjet 24kg 319.8mm x 447mm x 495.6mm  Yes Yes B
3.5PPM 100 Pages  Black & Colour NA NA Thermal Inkjet 24kg 319.8mm x 447mm x 495.6mm  Yes Yes B+
5PPM 100 Pages  Black & Colour NA NA Thermal Inkjet 4kg 287mm x 444mm x 521mm Yes Yes B+
7PPM 100 Pages  Black & Colour NA NA Thermal Inkjet 4kg 287mm x 444mm x 521mm Yes Yes A-
2 Pages 100 Pages  Black only (Printer avaliable NA NA Thermal Inkjet 5.4 Kg 404mm x 476mm x 211mm Yes Yes B
with Colour and Black Cartridge)
4.6 PPM 100 Pages  Black & Colour 900 Pages 300 Pages Epson Micro piezo 5.6 Kg 450mm x 546mm x 269mm Yes Yes A
8.8 PPM 100 Pages  Black & Colour 540 Pages 220 Pages Epson Micro piezo 5.6 Kg 470mm , 613mm x 302mm Yes Yes A-
10 PPM 150 Pages  Black & Colour NA NA HP Thermal Inkjet 5.9Kg 431.8” x 196.8” x 431.8” Yes Yes A-
13 PPM 150 Pages  Black & Colour NA NA HP Thermal Inkjet NA 431.8” x 431.8” x196.8” Yes Yes A-
NA NA Color & Black NA NA Thermal Inkjet 2.6 Kg 463mm x 234mm x 195mm Yes Yes A-
CONCLUSION quality and so you wouldn't let pricing  breathtaking. This was especially apparent

It's clear that there can be no outright win-
ner for all uses—your application and
your budget will determine the best print-
er for you. If you are what we could term
as the ‘average home user’, you would want
to strike a balance between performance
(both in terms of speed and image quali-
ty) and price. If you are a graphics profes-
sional, you can’'t possibly compromise on

Epson Stylus Color 880: Good performance

constrain your choice.

In the performance category, the
Epson Stylus Color 880 with its faithful
reproduction of fine details and colour
gradations emerged the clear winner.
While the printer performed well in the
speed tests, it really shone in image quali-
ty prints, where the level of details and the
ability to faithfully reproduce col orswas

Canon BJC 3000: Value for money

in the photograph printout, where the
details in the various sections of the photo
came through brilliantly. Also, with very
robust build quaity and righ features, this
printer is a very good choice for the
demanding office user who needs the best
in printing technology.

The Canon BJC 3000, with its com-
mendable print quality, bagged our Best
Value award as it offered good perform-
ance at a very good price point, making it
an ideal choice for the home user who's
interested in printing stationary, cards etc
without spending too much.

With the price for a given technology,
speed, and resolution declining rapidly
over the recent past, inkjet printers are now
well within the reach of the home user. If
you are still deliberating on the pros and
cons of buying your first printer or upgrad-
ing to a new one, an evening of window
shopping will help you make the decision,
for you are sure to find a product that fits
your requirements and your budget.F!
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IN TEST: 10 PERSONAL FIREWALLS

116 EAI

Imaging: Neeta Wadiker

In the

Protect your PC from security
breaches with a personal firewall.
A look at the best of these

MOHAN KRISHNAN
lain paranoid or simply stupid? Either way,
you are capable of wreaking havoc on your
system. A little bit of sanity and patience, on
the other hand, can get you a perfect system
working to its optimum. The same logic can be
applied to personal firewalls. Today, you have a
number of options to choose from in this cate-
gory—some paid, some free. And depending on
your outlook and skill, you can configure your
firewall such that you are totally cut off from the
rest of the world, or the entire world has access
to your hard disk contents.

What exactly does a personal firewall do? A
firewall, to put it very simply, acts as a filter
between you and your network connections
(including Internet connectivity). It wards off
intrusion attempts, Trojans and other malicious
attacks. Personal firewalls are meant for the
home user or for the desktop user in a net-
worked corporate environment. They aim to
block simple attacks, unlike the enterprise-level
firewalls that the corporate world uses at the
server or router end. These are more complex
and are geared towards keeping the server up all
the time and protecting the entire network.

But do you really need a personal firewall?
Broadband, increase in security attacks, bugs in
everyday software, etc, would seem to suggest so
but then again, you might think that behind the
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anonymity of a dynamic link of a dial-up con-
nection or the firewall of a network, you are
pretty safe.

This may be true to some extent for intrud-
ers aren’t exactly searching for your particular
machine. But when the reviewers at Network
Computing (India) conducted a surprise scan
through some VSNL dial-up IP pools in Mum-
bai, they found that 89 out of around 2,000 IP
addresses were ailing from Back Orifice infec-
tion. In addition, around 24 NetBus infections
were identified. Another test they conducted
involved nuking and pinging (see Glossary) the
very same pool of IP addresses using two differ-
ent DoS (Denial of Service) tools. They succeed-
ed in around 50 per cent of the cases.

Now if your’s was one of the machines under
attack, you must have wondered what you did
wrong to suddenly find your machine crashing.
Soyou see, it is not necessary for a person to actu-
ally know you, or your IP address, to gain access
to your machine. If your machine is infected or
prone to exploits, then even beyond the anonymi-
ty of a dynamic IP address, your PC can be
hacked. A personal firewall, therefore, is one of
the methods you can use to deny access to such
intrusions. So, let’s get personal with the firewalls.

TEST PROCESS

The Test Bench in which the firewalls were
installed consisted of a Pentium 266 MHz
processor with 64 MB RAM. The operating sys-
tem in test was Windows 98SE. TCP/IP and Net-
BEUI protocols were installed on the Test Bench
and File and Print Sharing was also enabled
before installation of the firewalls. The security
level in IE 5.5 was medium with prompt before
using any Java applets or ActiveX controls.

To gauge the application-level filtering fea-
tures of the firewalls, we installed certain stan-
dard software that try to access the Net. Using
these software, we tried to send files as well as
download files from a testing machine. Apart
from these software, a popular Trojan, SubSeven
2.2 server, was also installed on the Test Bench.
Testing tools: Using a test machine, we ran cer-
tain port scanners on the Test Bench. The *nix-
based port
scanner, Nmap
(version  2.53),
- and  Windows
iemii TR : NT/2000 based
3 Retina Scanner

- Know who is
intruding into
: your computer
St with BlackICE
Defender

Porting Problems: How Firewalls Work

Firewalls basically work by acting as a
filter between your Internet connec-
tion and your application. At a very
basic level, you can grant or block
rights for different applications to gain
access to the Internet. But this is just
one part of the working and is related
to your access to the Net. Firewalls
also work in a reverse manner by
blocking access to outside traffic, thus
managing to ward off attacks. This is
done by monitoring the ports and the
protocols that the outside application
is trying to use. The main protocols
used for Internet access, TCP and UDP,
use port numbers to distinguish
between different logical channels on
the same network interface card.
There are 65,536 logical ports possible

and these port numbers can be seen
as a door to the outside world. Some
doors are closed, some are open, so
access to certain services or protocols
(HTTP, FTP) depends on the open/
closed nature of ports. Firewalls again
act as gatekeepers and, as per your
rule-set, show a port as open or closed
for communication. Hence, you can
block ports that you don’t use or even
block common ports used by Trojans.

Using firewalls, you can also block
protocols, so restricting access to Net-
BIOS will prevent computers on your
network from accessing your shared
folders. Firewalls often use a combina-
tion of ports, protocols, and applica-
tion-level security to give the best
results.

(version 3.02 beta) were used to scan the Test
Bench. With both the scanners, the machine was
first scanned before installing any firewall and
then scanned after the firewall was installed.

Apart from these port scanners, we tried
accessing SubSeven Server on the Test Machine
using the SubSeven client. At the same time, we
also used certain application exploits such as
those for ICQ. To test the ability of the firewall
to detect ActiveX exploits, we went to certain
sites that, using ActiveX controls or Java applets,
uploaded certain files or read certain files from
the local machine.

We also created a test HTML page with an
ActiveX control embedded that installed the
Thing Trojan on to the machine. We then tried
opening the HTML page using IE and noted the
behaviour of the firewall. Apart from these spe-
cific tools, we also tried nuking the Test Machine
(sending continuous packets of data). The abil-
ity of the firewall to detect and ward off such
intrusion attempts was noted.

In all, we tested 10 personal firewalls for their
features and performance. And since getting the
best out of your personal firewall requires
patience and learning, ease of use or configura-
tion settings were accorded the same importance
as the actual features and performance. The fea-
tures and performance as measured against the
price gives the value for money for the firewall.
The best firewall is therefore the one that has the
maximum features and gives the best perform-
ance at a price that is easily affordable.

Star performers

What makes for a good performing firewall? The
answers are simple—the ability to ward off all
intrusion attempts, control applications that can
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Glossary

TCP: Transmission Control Protocol is the
method used to transfer information
between two connected computers over
a network or the Internet. In a TCP
implementation, the protocol divides the
information into smaller packets, and
also at the same time ensures that the
packets reach the other side safely.

UDP: User Datagram Protocol is a con-
nectionless transport protocol, which
means that you do not need to have a
connection established between the
host and the remote machine before
starting transfer of data.

ICQ, for instance, is an application
that uses the UDP protocol. UDP, how-
ever, doesn’t ensure that the packets
reach easily, though it is faster.

ICMP: Internet Control Message Protocol
carries control messages that are used to
acknowledge and respond to connec-
tions. For example, the ping command
uses this protocol.

IGMP: The Internet Group Management
Protocol is an extension of the IP proto-
col and a standard for IP multicasting. It
is used to inform local routers about the
presence of a member of a multicast
group. If a host is part of a multicast
group, then it is also more prone to
IGMP flooding.

Packet sniffer: Packet sniffing refers to
monitoring data that is passed over a
network. You have specific software that
allow you to sniff the packets that travel
and retrieve information from it.
RATs/Backdoors: Remote Administra-
tion Tools are a method of controlling
remote machines using the IP address.
Trojans such as SubSeven and BackOri-
fice are RATs in that sense as you can
control a remote machine if the Trojan is
installed in it.

Normally, these Trojans have a server
part and a client part. The server is
installed in the remote machine and lis-
tens on a particular port. Using the
client, you can connect to the server on
that port, and then control the machine
in any way you want. You can even
enable packet sniffing using some RATSs.
DoS/Nukes/Flooding: Denial of Service
attacks prevent a target machine from
accessing a network resource. A simple
form of a DoS attack is by sending large
packets of data to a single machine,
thereby making it unstable or even
crashing it.
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access the Internet, prevent malicious scripts
or controls from stealing information or
uploading files and prevent Trojans and
other backdoors from running as servers.
Port scans: The good thing with most of
the firewalls we tested was that they didn’t
show up any ports as open in the Nmap and
Retina scans. If at all there was an open
port, it was port 139, which is related to
sharing files over networks. The one soft-
ware that showed up more open ports was
eSafe desktop. It showed port 139, port
6699 (the port used by the Napster applica-
tion), and other such ports as open. Black-
ICE Defender was the most informative in
terms of identifying the port scan attempts,
and even recognised the Nmap scans and
the actual commands that were being sent.
Intrusion attacks: The differences came up
when we tried the application level or OS
level exploits. Firewalls such as Sygate, Tiny
and eSafe showed up the blue screen
momentarily when we tried an IGMP
flooding. Others such as Norton Personal
Firewall, ZoneAlarm and NeoWatch
became unstable with packet flooding
attacks. However, such intrusion detection
attempts had no effect on ZoneAlarm Pro,
and the Network Associates products—
McAfee Personal Firewall and PGP Desk-
top Security. These two, in fact, managed
to do quite a bit of load balancing by ignor-
ing such attacks totally, to the extent that we
did not even come to know that we were
being flooded with packets. We faced no
problem with exploits targeted at software
such as ICQ or mIRC, and the firewalls
were able to ward them off easily.
Malicious Web sites: Detection of mali-
cious ActiveX controls, scripts or Java

applets was a grey area with all the firewalls
(except Norton to some extent). Sites man-
age to exploit the vulnerabilities in Inter-
net Explorer, Outlook Express and other
software to steal information or upload
files. Therefore, even if firewalls do not
recognise such malicious sites, they should
be able to warn you when data is being
retrieved or written to your machine.

We were able to easily upload a .hta file,
which runs a ‘Hello World” message, to the
Test Bench without the firewalls detecting
any warning. Only Norton stopped the
loading of a malicious Java applet on
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PGP Desktop wards off most intrusion
attempts

another site. We were also able to config-
ure eSafe Desktop to block the .hta file
from being uploaded. eSafe employs the
method of selective file-sharing or ‘sand-
box’. So for each application, you can spec-
ify the directory rights (or even file rights)
in terms of read, write, execute, delete, etc.
For instance, you can specify that Internet
Explorer will have no read rights over the
Windows Desktop and System directory,

Scanning through Web Sites

Before you start the firewall hunt, you
can get your machine diagnosed online
using Web sites that offer this service.
These Web sites normally scan your
machine using some commercial port
scanner to see if there are any ports open
and report the same to you.

Remember though, that if you are
scanning from a dial-up access, this may
take some time. And you cannot be
beyond a gateway or a proxy which hides
your IP address if you want your machine
scanned.

Symantec’s site even offers to scan
your machine for Trojans and analyses
the privacy features of your computer.

The ASP site of Network Associates
Mcafeeasap.com, also gives a free trial to
check your system for vulnerabilities
using PGP CyberCop scanner. The only
problem here is that you have to register
first before availing of this facility. There
are other Web sites which offer a paid
service, and this is more useful if you
have your own Web site or domain
name. Some of the sites offering audit
through the Web are:

www.symantec.com

www.grc.com

www.mcafeeasap.com

Www.securityspace.com
www.automatedscanning.com
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and will have rights only to the Temporary
Internet Files and Cookies directory.

This effectively stops many ActiveX
controls and malicious scripts that down-
load files to areas such as the Desktop or
Startup menu. Besides specific applica-
tions, you can even create a sandbox for all
generic applications. For example, no
application will have rights over the root
folder. This is quite an innovative concept;
no other firewall employed this concept.
SubSeven Trojan detection: Since we were
testing the firewalls using SubSeven 2.2,
which is the latest version and doesn’t even
show up in the processes list, we didn’t
really expect the firewalls to detect this ver-
sion. But surprisingly, BlacklCE immedi-
ately detected the SubSeven 2.2 Trojan
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The feature-rich Norton Personal Firewall

when we tried running the SubSeven serv-
er and sending it through. None of the
firewalls allowed access to the SubSeven
Trojan when we started the server with the
firewall running.

However, when we made the connec-
tion to the SubSeven server first and then
started the firewall, quite a few were found
wanting. Norton, ZoneAlarm and
NeoWatch allowed the SubSeven client to
issue commands such as opening the
CD-ROM, or hiding the Start menu. Other
commands such as packet sniffing didn’t
work with the first two, though NeoWatch
allowed even these commands. This is a
major security breach because if a Trojan
can start its activities before the start of the
firewall then it can bypass many restric-
tions. Firewalls that were based on creating
application-level rules didn’t face a prob-
lem because these were able to detect that
some application was trying to connect to
the Internet.

None of the firewalls we tested were
good in all respects. Norton Personal Fire-
wall, with support for blocking ActiveX
and Java applets, could have been a good
all-round performer but for its failure in
the SubSeven Trojan test. ZoneAlarm Pro
and BlackICE Defender performed well,

s] ] | = | - i

Block a range of protocols with McAfee

but they lacked protection against mali-
cious Web sites. Interestingly, if you can get
eSafe Desktop to work properly and tweak
its settings, you might get the best protec-
tion including protection against Trojans
and malicious sites. With its concept of
sandboxes, you can virtually guard all your
main system files. You can also manually
specify ports that should be blocked for
both inbound and outbound connections.
The problem is that we faced a lot of diffi-
culties in getting eSafe to work. Configuring
this software is also not that simple and
requires thorough knowledge of each appli-
cation and port, so this is not something

1/2 page AD
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Security in Cable Space

Are you more prone to security breach-
es if you are on a cable modem net-
work or DSL network? Conventional
logic would seem to think so. While
cable modems and DSL still assign you
a dynamic IP address, the fact of the
matter is that because you are in the
‘always on’ state, you have the same IP
address for a longer duration of time.
This gives a person who wishes to gain
access to your machine more time to
work towards it. Again, if you are shar-
ing a cable modem, as most people
are prone to, then your machine is on
the same network as the others you
are sharing the cable modem with, and
it's possible that they can gain access
to any shared folders that you might
have. Apart from the general precau-
tions that are valid for all computer
users, as a cable modem/DSL user you
should also take the simple precaution
of logging off the cable/DSL connec-
tion when you are not using the Inter-
net.

Performance Parameters

Firewall Port scanning Intrusion detection Script protection  Trojan Detection

BlackICE v 4 X 4

Defender

eSafe Desktop  Partial Blue screen Yes (through con- ¢
cept of sandboxes)

McAfee Personal ¢ v X v

Firewall

NeoWatch 4 Highly unstable X Partial

Norton Personal ¢ Slightly unstable  Partial Partial

Firewall 2001

PGP Desktop 4 v X Partial

Security

Sygate Personal v Blue screen X v

Firewall

Tiny Personal v Blue screen X (4

Firewall

ZoneAlarm v Slightly unstable X Partial

ZoneAlarmPro ¢ v X 4

that can just work out of the box.

Filtering capabilities

Since filtering is the mainstay of all fire-
walls, there were a number of parameters
on which we tested the filtering capabilities
of the firewall.

1/4 page AD

Preset security levels: All firewalls nor-
mally start off with prescribing different
security levels that you can use. These lev-
els normally range from low, or not block-
ing any traffic, to medium and high
security. With the highest security, you are
normally off the network and will not be
able to connect to the Internet. Depend-
ing on the firewall, you might have three to
four preset levels. These are a good aid for
a new user who is not familiar with the
network protocols or ports.

However, if you want to understand
exactly what these presets do, you aren’'tin
luck. Most firewalls don’t give any infor-
mation on the ports or protocols that are
blocked, and you can just forget about cus-
tomising the preset levels. Two firewalls
stand out in this respect—PGP Desktop
and ZoneAlarm Pro. Both of them offer a
description of the protocols that are being
blocked and even allow you to customise
the settings. PGP’s settings are based on
whether your computer acts as a client or
a server, while ZoneAlarm Pro allows you
to have different customised (or preset)
settings for the local zone (your LAN) and
the Internet zone.

Blocking ports and protocols: Very few
firewalls just block a port—they usually
combine it with specific protocols that
have to be blocked on that port. Norton
has a comprehensive feature as far as
granting permissions for different proto-
cols are concerned. You can even specify
the services that will be allowed on those
protocols and, if you desire, the range of
addresses that can use these protocols.
Norton also monitors specific HTTP
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Breaking the Firewall

Is a personal firewall the solution to all
your security problems? Certainly not, as
many reports would seem to suggest. For
instance, there’s a utility specifically tar-
geting ZoneAlarm and ZoneAlarm Pro that
stops ZoneAlarm if it is running, and pre-
vents it from starting. Called ZoneMutex ,
this is just a small terminate-and-stay-resi-
dent (TSR) program. Previous versions of
ZoneAlarm were also prone to an Nmap
scan which was done using port 67 as the
identified port (nmap —g67 —sS <IP address>).
eWeek magazine also reported another
crack for BlackICE Defender that allowed
to get past the firewall. The same crack
was supposed to work with other fire-
walls such as Norton also.

Remember that the effectiveness of a
personal firewall is to a great extend

ports, and you can add other ports to
monitor.

Tiny and ZoneAlarm Pro use the con-
cept of blocking certain protocols on a
range of ports. In both of these, you can
select the protocol and the direction of

dependent on you and the rules you cre-
ate. If a suspicious application tries to
access the Internet, your firewall will most
likely give a warning. Now, if you choose
to allow this application access, then
don’t blame the firewall if the application
turns out to be a Trojan. That's the main
loophole most cracks for firewalls work
around. It's the belief that if you are pre-
sented with an application that sounds
familiar (say Explorer.exe or lexplore.exe),
you are most likely to give access to this
application. It's therefore possible for a
Trojan to rename itself as a known appli-
cation and gain access to the system.
Regularly monitor the activities of your
firewall and use the NetWatcher utility
that comes with Windows to check out
your shares.

traffic you want blocked, and then the
ports on which the firewall will listen to
block the traffic. eSafe or BlackICE had the
same features, but the difference was that
you had to manually enter the information
for each port.
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Block protocols in ZoneAlarm Pro

McAfee was a bit different in terms of
the protocols that it supported. While
most firewalls restricted themselves to
TCP and UDP, or added IGMP and ICMP,
McAfee had support for allowing or block-
ing RIP (Routing Information Protocl),
ARP, PPTP, etc. In terms of customising
and ease of use, the simplest to use to block
ports and protocols were ZoneAlarm Pro
and Tiny.

Application-level security: The simplest
way a firewall works is by restricting or
granting permission to applications to
access the Internet. The first time an appli-
cation tries to access the Internet, the
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firewalls open up a response box which
you can use to allow or disallow that
application, and also tell the firewall to
remember this rule for future reference.
This is a very important feature because it
is the best way of knowing if some
unknown application (or Trojan) is trying
to access the Internet. In some firewalls,
application-level filtering was bundled
along with the feature to block ports or
protocols. Sygate was the best in this fea-
ture. After you use an application for the
first time and create a rule to allow it, you
can specify the IP addresses that this appli-
cation can use, the range of ports that are
allowed, and even schedule a period-range
during which the application can be run.
ZoneAlarm Pro also offers some features
related to application-level filtering in
terms of ports and protocols that are relat-
ed to the application. You can also specify
whether the application has access to the
local zone or Internet zone, and whether
the application can act as a server to other
programs trying to connect to it.

Blocking IP addresses and Web sites:
Although it is not traditionally part of a
firewall’s job, most firewalls nowadays
sport this feature. They can be used to
block access to malicious Web sites or as a
content filtering tool. They can even
restrict access to machines in the local net-
work. Most firewalls just ask you to speci-
fy the IP addresses that have to be banned.
Norton allows you to ban IP addresses or
host names (including subnets) in con-
junction with the protocol. PGP works in
a similar fashion. ZoneAlarm Pro has a
separate module that allows you to create
a restricted zone based on IP address or
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Sygate is the easiest to configure

host name. In some firewalls, you can cut
off access to the Internet using the IP
address range, or by setting the security
level to the highest. ZoneAlarm Pro has a
single icon that allows you to immediately
stop access to the Internet.

Into the Network Neighbourhood:
Intruders don’t just exist in the Internet
space—they could be people who are sit-
ting next to you in a cyber cafe or in office
and sharing the same network connection.
So, firewalls should ideally also protect you
from intrusions coming from the local net-
work, and even deny certain computers
access to files shared on your PC. Most fire-
walls didn’t sport this feature, and even if
they did, it didn’t work properly and we
could easily access shares on the Test
Bench. eSafe, Norton, ZoneAlarm and
ZoneAlarm Pro were the only ones that
allowed disabling of file sharing to banned
computers on the local network. In Nor-
ton, you could do that by restricting pro-
tocols to local addresses, while ZoneAlarm

Tracing back the Intrusion

If you are facing a number of intrusion
detection attempts, then if you have the
time and inclination, you can take some
proactive measures. Most firewalls tell you
the IP address of the machine that made
the intrusion attempt. A firewall such as
NeoWatch also comes with the NeoTrace
utility that allows you to backtrace to
where the intrusion attempt came from,
and also report the intrusion to its Web
site. NeoTrace basically performs a trace
route operation on the IP address to find
out where the address originated. You can
do the same using the command tracert <IP
address> in your DOS prompt. ZoneAlarm
also allows you to report an intrusion to
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Zone Labs, and also monitors the informa-
tion that is sent, so you can even keep
your identity a secret. You should report
such attacks as it helps security organisa-
tions build a database of places from
where intrusion attacks are being made,
and try to ensure that they don’t happen
again. If you get the IP address, even you
can report the intrusion to the ISP from
where the attack came or to the domain-
hosting provider. The ISPs and Domain
space providers normally have a policy
wherein their IP addresses cannot be
used for such intrusion activities, and can
therefore remove the offender from their
network.

and the Pro version have separate settings
for the local network. In eSafe, the person-
al firewall module doesn’t allow blocking
Network Neighbourhood, but in the
Administrator module, under the privi-
leges for the user, you can cut off access to
local networks.

Other features: Different firewalls came
with many other utilities that added to the
feature list. Norton and eSafe have the pri-
vacy or protection of confidential infor-
mation feature. Here, you can specify
confidential information that you do not
want transmitted to any Web site or non-
secure site. So, you can easily enter some
digits of your credit card, and block this
information from being passed. Norton also
allows you to block referrer logging, that is,
sites you visit will not know where you came
from. You also have the provision to block
cookies. Some firewalls also come with pass-
word protection features. Tiny is the only
one that has a remote administration utili-
ty. eSafe also ships an antivirus package
along, while PGP has features relating to
digital signatures and protection for VPNs
(Virtual Private Networks).

Among the various firewalls, it is evi-
dent that ZoneAlarm Pro and Norton Per-
sonal Firewall 2001 have the maximum
number of features.

Ease of use

A firewall may perform well and have loads
of features, but if it is difficult to configure
and access the features, then all the good
qualities are of no use. Ease of use is there-
fore an important criterion in choosing a
firewall, and we looked at factors such as
interface, configuration and reporting to
judge the firewalls.

Configuration: With most firewalls, you
could start working out of the box using
just the default setting, without having to
configure anything. This is true especially
in the case of application-level firewalls.
Here, every time an application tries to
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access the Internet, you are presented with
the option of allowing or blocking it. Even
for configuring other parameters such as
ports or protocols to block, you normally
have a tabular or drop-down menu to
select the options.

If, however, you need an example of
how a great software can be killed by bad
configuration parameters, don't look
beyond eSafe. Getting this software to
work was a big difficulty. The software
gave an ‘illegal operation’ error on two
machines due to problems with the
Winsock implementation. Finally, we had
to format our Test Bench again and load
eSafe before other applications to get it
working. Yes! All set, we thought... but no,
that was just the beginning of the prob-
lems.

Try installing any software, and eSafe
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Supressing alerts in ZoneAlarm Pro

comes up with a number of messages that
are plain irritating. You cannot stop the
eSafe engine without deselecting the
option in the Windows system configura-
tion, which means that you have to restart
the machine. Again, eSafe employs the
good concept of user rights, wherein you
can have different firewall settings for

Reading the Warning Signals

different users based on the Windows
login. But every time you change some
configuration for the firewall, you have to
again assign the configuration to the par-
ticular user for the changes to take effect.

Strangely enough, quite a few firewalls
do not give the configuration option in the
main toolbar itself. Instead, you have to
navigate through some menus. In the case
of Norton, you have to go through two lev-
els, whereas Tiny has two separate windows
for ‘status’ and ‘administration’. ZoneAlarm
and ZoneAlarm Pro are quite good in that
respect with icons for different options
arranged in the main window itself.
Danger signs: Personal firewalls do their
work in the background while you are
involved with some other application. The
icon in the taskbar is probably the only
way you come to know that the firewall is
still alive. But then, how do you know
when you are being attacked?

One way is to have a pop-up menu for
every intrusion detected. But imagine
being disturbed every 30 seconds with an
alert screen just because somebody hap-
pened to access your shared folder in the
local network. Alternatively, these firewalls
indicate through flashing signs in the
taskbar what kind of attack you are under.

The icons that Sygate used were among
the most intuitive and were clearly visible
even in the taskbar. Down and up arrows
were used to denote inbound and out-
bound traffic, respectively, and red signals
denoted blocked traffic or intrusion detec-
tion. Even with Norton, you could make
out an alert from the way the icon flashed.
ZoneAlarm had these bright yellow colour
flashes that were hard to miss, although
they didn’t tell you about the nature of the
attack. Some firewalls also allowed you to
send an alert to an e-mail address or play
an audible sound when an intrusion

Tiny is one of the free personal firewalls

occurred. But if you keep a high security
level, be prepared for friends or colleagues
putting up a No-honking Zone sign near
you in protest.

Keeping track: Event logs are the best way
to keep track of the activity in your disk.
Basically, alerts are created on the basis of
the rules you have created, and most fire-
walls allow you to log these alerts to a file.
While McAfee has an activity log feature
in its menu, the log file was one of the
worst, filled with hex-dump and http
headers of Internet activity that are of no
use. Sygate kept the best logs. It had event
logs in four categories: Security logs (noti-
fication of all intrusions), System logs
(basic system information relating to the
starting of Sygate), Traffic logs (details of
the network and Internet traffic) and
Packet logs (information on the packets
transmitted, along with the hex-dump).
All these details were given in neatly tabu-
lated format, along with details of the local
and remote host and the ports on which
the connection was made. Just don't keep
the file size for the packet logs too high,
since it puts quite a bit of load on the
system.

Even Norton had many logging
options, but you can’t exactly make out the
fine distinctions between the different
logs. BlackICE and Norton also provided a
graphical representation of the intrusion
attempts in terms of the history of the

Firewall Configuration ease Intuitive Taskbar Sounding alerts Log file format Filtering logs Graphical
icons representation
BlackICE Defender Partial X v Average X v
eSafe Desktop X X v Average X X
McAfee Personal Firewall X X X Poor X X
NeoWatch (4 b 4 (4 Good v b 4
Norton Personal Firewall 2001 X v X Good v v
PGP Desktop Security X X v Average v X
Sygate Personal Firewall Partial v 4 Good 4 v
Tiny Personal Firewall X v X Average X v
ZoneAlarm v v v Average X v
ZoneAlarm Pro v 4 v Average v 4
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Specifications

DETAILS OF THE FIREWALLS

Firewall BlackICE Defender ~ eSafe Desktop 2 McAfee Personal ~ NeoWatch 2.2 Norton Personal PGP Desktop Sygate Personal T
25 Firewall 2.1 Firewall 2001 2.5 Security 7 Firewall 4 W
(Evaluation)
Performance
Blocking port Yes Partial Yes Yes Yes Yes Yes Y
scans
Intrusion blocking  Yes Blue screen Yes Highly unstable Slightly unstable Yes Blue screen B
Trojan Detection Yes Yes Yes Partial Partial Partial Yes Y
Features
Preset levels 4 3 3 5 3+3* 6 3 3
Port blocking Yes Yes No No Yes (with protocol)  No No Y
Protocol blocking  Yes (with port No Yes No Yes
blocking) Yes No Y
Application level No Yes (with sandbox)  Yes No Yes (with protocol)  No Yes Y
security
IP address filter Yes No No Yes Yes (with protocol)  Yes (with protocol)  Yes Y
Blocking Web sites  No Yes No No Yes No No I\
Restricting file Yes Yes Yes No I\
sharing Yes Yes No
Privacy feature No Yes No No I\
Ease of use Yes No No
Configure from Partial No No Yes I\
main menu No No Partial
Intuitive taskbar No No No No N
icons Yes No Yes
Sounding alerts Yes Yes No Yes No Yes Yes [\
Filtering logs No No No Yes Yes Yes Yes I\
Graphical repre- Yes No No No Yes No Yes Y
sentation
Contact & Network ICE Aladdin Knowl- Network Associ- NeoWorx Symantec (Con- Network Associ- Sygate T
Developer edge Systems ates (Phone: tact: Tech Pacific,  ates (Phone: Technologies
9821019104, E-mail: 022-5960227, 9821019104, E-mail:
annette_castelino adil@techpacin- annette_castelino
@nai.com) dia.com) @nai.com)
Web site Networkice.com Esafe.com Nai.com Neoworx.com Symantec.com Nai.com Sygate.com T
Price $40 (approx) Free for personal $29 $40 $50 $60 Free for personal F
use use u
Rating B B+ B B- B+ B+ B+ E

* Levels for Security and Privacy ** Levels for local zone and Internet Zone
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attacks and the packets that were blocked
or filtered. With BlackICE, you could even
filter the logs in terms of their severity, while
other software such as Sygate allow you to
view logs of last 24 hours, last week, etc.

Both ZoneAlarm and ZoneAlarm Pro
logged the results to a text file, but in the
Pro version you had an option to suppress
logs for common events such as accessing
shares. However, ZoneAlarm restricts the
maximum alerts at a time to 500, after
which you have to clear the old alerts to
receive the new ones.

Pricing, support and documentation
The last parameter under consideration
was support, documentation and price.
There are firewalls that are free for per-
sonal use. This means you can use them at
home, but using it in office would require
you to purchase a license. Among the 10
firewalls tested, eSafe, Tiny, Sygate and
ZoneAlarm are free for personal use. The
price of the other firewalls ranged from
$30 to $50 (approximately Rs 1,400 to Rs
2,300), though PGP was pretty expensive
at around $60 (approximately Rs 2,700).
This is because PGP also includes support
for digital signatures and VPN.

What is the difference between a free ver-
sion and a paid one, you may well ask? Apart
from the fact that the firewalls are only free
for personal use, there is a noticeable differ-
ence between the paid software and the free
ones, as evident in ZoneAlarm and
ZoneAlarm Pro. The Pro version has every-
thing that the free version lacks and even
performs better in the intrusion detection
tests. There’s no instability with ping flood-
ers and IGMP attacks and there are a num-
ber of feature enhancements that allow you
to customise almost every feature.

However, eSafe really gives you value for
money. It ships with an antivirus and a sys-
tem monitoring utility, and can be tweaked
with a bit of difficulty to give very good per-
formance.

Apart from Tiny, the other firewalls
came with some documentation and help
files. Even NeoWatch had only online sup-
port. McAfee had one of the most illustra-
tive guides, while the products from Zone
Labs started off with a tutorial. NeoWatch
and ZoneAlarm also featured reporting of
intrusion attempts to the developers for
information.

All the firewalls also offered a feature
to update the software—in some cases
this was automatic and in other cases
you had to manually update from the
Web site.
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Safety Measures

M Disable File and Print Sharing if you are
not going to be on a network.

B Update your antivirus signature files
regularly...don’t be lazy about it. Use a
specialised Trojan cleaner if necessary.

M Regularly apply security patches to your
software (especially Windows and IE).

H Don’t open e-mail attachments if you
don’t know what they contain.

H Don't allow unknown applications
access to the Internet or to your machine.
Use the System Information utility (Start >
Accessories > System Information) to check for

CONCLUSION

To say that there is a proliferation of secu-
rity-related products these days is an
understatement. Major players such as
Symantec or Network Associates have a
range of suites for the same target audi-
ence, each with slightly varying features.
For instance, apart from Norton Personal
Firewall, Symantec also has Norton Inter-
net Security and Norton Internet Security
Family Edition, which extends the firewall
feature to include blocking of ads, parental
controls, etc.
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Similarly, McAfee has McAfee Inter-
net Guard Dog (also in a Pro version),
which essentially does the same. The feel-
ing of paranoia, especially in cases of
e-commerce transactions and given the
number of defacements of Web sites are
the primary reasons for such a large
number of new software to emerge in
this category.

the Running Tasks. To turn off a specific
application, you have to edit the registry.
H Regularly check the event logs of your
antivirus software or personal firewall.

Ml Disable ActiveX and Java and uninstall
Windows Scripting Host if not required.
M Turn off macros in Microsoft Word and
Excel or keep macro protection on.

H Use the command netstat -a to check
the open ports in your machine. Check
the open ports against the common list
of Trojan ports to see if Trojans are listen-
ing to some ports.

As we said earlier, even in the realms of
anonymity, you can be at risk. And if you
are not worried about spending around
Rs 2,000, then you should definitely go in
for a paid personal firewall. ZoneAlarm
Pro wins easily when compared to the
other firewalls.

It did well in all the parameters—its
performance was good barring the lack of
support for ActiveX controls, it had very
good features that were highly customis-
able and more than anything else, using
ZoneAlarm Pro is not at all difficult.

The nearest competition comes from
Norton Personal Firewall 2001 (version
2.5). The only area where Norton didn’t
fare that well was in the SubSeven Trojan
detection test. Otherwise, in terms of fea-
tures it was more than a match for
ZoneAlarm Pro with its inclusion of pri-
vacy features as well.

But using Norton isn’t as simple and
that’s another area where it lost out. A new
version of the Norton Personal Firewall
(version 3.0) has been released, and it’s
quite possible that this version is better
than the one we tested, with enhanced per-
formance features.

However, if you want to use a firewall
just for personal use, and have a problem
with the price, then you can easily use one
of the free firewalls. Here, it’s a toss-up
between ZoneAlarm and eSafe Desktop. If
you can configure eSafe properly, you will
get much better performance out of it than
what ZoneAlarm will give. Add to this the
fact that eSafe comes with its own antivirus
scanner, which can be quite useful.

However, don’t expect a personal fire-
wall to be a cure for all your problems.
There are a lot of precautions you have to
take beyond installing a firewall before you
are truly in the safety zone.fl
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How you wish you
could get rid of
those viruses on
your machine. A
look at the top
antivirus software
for your needs

Imaging: RAM

ROSSI FERNANDES AND YATISH SUVARNA

ikes, what i§ that weirdly named file on your
hard drive Is it a game? Is it a joke? Guess
again—you're infected by a virus! With the
advent of Broadband Internet connectivity,
DVDs and the ubiquitous CDs and floppy disks,
there exist many potential ports through which
malicious files and content can enter your com-
puter. Add to that backdoors or certain sections in
applications that developers keep open either wil-
fully or for development work. Potentially harm-
ful files can be placed on your computer through
these ports. Once this happens, there are

programs that can be used to monitor or even
control the functioning of the infected computer.

So remember that the next time your kid sis-
ter downloads that new game from the Internet
or one of the guys at work accesses a new Flash-
enabled Web site, your home computer or office
network could be subject to virus threats. The
consequences of having a virus in your system
could be anything—from an annoying message
on your monitor, to a full-blown failure and cor-
ruption of your data, operating system and appli-
cations. So long as there is software, there will
always be a certain breed of people who are intent




on wreaking havoc on computers for no appar-
ent reason. Hundreds of new viruses are put out
in the wild every year. Starting to feel panicky?
One of the best approaches to battle this scourge
is to face the problem head-on with the help of
antivirus (AV) software.

The antivirus comparison test was done on a
system running a P-111 700 processor with
64 MB of RAM. The hard drive used had a
capacity of 5.7 GB. The operating system on the
test bed was Microsoft Windows 98SE, which
was loaded with all the drivers. We took an
image of this system before running the tests on
each of the AV packages. This disk image was
restored after each package was tested.

A good antivirus should be able to find
present-day viruses and detect code that could
be potentially harmful. And, of course, it should
be able to successfully remove the malicious por-
tion of an infected file while leaving the data
intact. The emphasis of this test was more on the
detection feature, since an antivirus software will
usually clean the files it detects (or an update to
the definition files will be able to do that).

To run the antivirus software through their
paces, we took a collection of around 7,400
viruses along with some of the popular Trojans
that are floating around. This collection was cal-
culated to put a lot of strain on the antivirus
software. Most of the viruses used were exe and
com infecting viruses along with some boot sec-
tor viruses, including a mix of actual signature

files and infected files. The col-
lection also included Trojans
and macro viruses in the
archive.

There were two main virus scanning tests,
which included the main uncompressed file
scanning test and the compressed virus scan-
ning test that we ran on each of the antivirus
software packages. In this comparison test, we
only evaluated antivirus software targeted for
personal use or a small networked environment.
We did not look at enterprise-class antivirus
protection suites or client-server based antivirus
applications.

The overall score for each software was decid-
ed by logging the various features, performance
rates, ease of use and test results into a spread-

sheet. We also looked at
aspects such as availability
of regular updates. Based
on the weightage assigned
to the various parameters,

we reached the final score. .
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Detecting the deadly viruses
Whether a virus is detected
or not is the most important
performance criterion. \We
tested the detection rates by
two methods—detection of
7,400 viruses in an uncompressed format, and
detection of 4,700 viruses in a compressed file.
The viruses were a mix of actual signature files
and infected files. In the case of infected files, we
also looked at the ability of the antivirus software
to clean the viruses. Another thing we did was to
check the ability of the virus scanners to detect
the 10 most common viruses.

Most of the virus scanners performed well in
detecting viruses in the uncompressed format,
except for QuickHeal, which was able to detect
an abysmal 57 per cent of the viruses. The other
virus scanners detected around 90 per cent of
the viruses. Antivir came out the best, with a
98.26 per cent detection rate, followed closely by
InoculatelT. All the virus scanners were able to
detect and clean the 10 common viruses.

The differentiation among the virus scanners
was quite noticeable when we looked at the
detection rates for viruses in compressed files.
Three of the eight virus scanners (QuickHeal,
eScan, and McAfee) actually buckled under the
strain and crashed while attempting to detect
viruses in compressed files. Apart from AVG,
Inoculatel T and Norton, even the others didn’t
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perform well, with F-Secure detecting only about
2 per cent of the viruses in the compressed files.

Time for scan

Do you shy away from doing a full system scan
on a regular basis because just the thought of the
hours it will take puts you off? Consider a soft-
ware such as InoculatelT, which has a good
detection rate, and is able to scan the hard disk
(of a 1 GB partition) in 6 minutes flat. To a large
extent, the scanning time is dependent upon the
options that you have selected. Pure detection is
faster, but if you select options for cleaning,
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Antivir, AVG, McAfee
check out
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Antivir 9x

AVG

eScan

F-Secure
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prompting, or performing quarantine, then
the time taken increases. That’s probably
one of the reasons why Norton took as
much as 48 minutes for the entire scanning
process, while McAfee took 54 minutes. It
also seemed very strange that QuickHeal
took 51 minutes for a scan, considering that
its detection rate was quite low.

There is hardly any difference if you
scan for all files (including compressed
files). Again, Inoculatel T took just 4 min-
utes to scan the partition with the com-
pressed files. Admitted, Inoculatel T is fast,
but then it didn’t actually manage to clean
the infected files very thoroughly. Norton,
which had a good cleaning rate too, man-
aged the scan in 40 minutes. Three of the
software crashed at varying points while
scanning within compressed files.

Eating up resources

It's important that your virus scanner
does not eat up a lot of your system
resources. Otherwise, if you do a full-
system scan, you will have no option but
to sit twiddling your thumbs for the 30-
odd minutes it takes to scan. Even the
auto-protect feature shouldn’t hog mem-
ory, else your other applications may
become slow.

We used a utility called Cache Manag-
er to evaluate how resource-hungry these
software were and how much system
memory was consumed while these pro-
grams were running in the system tray.
F-secure took up the most system
resources—9.3 MB of the available RAM
in the system. Next came eScan with 4.6
MB. One of the leanest programs was
AVG, which just ate 2 MB of system
resources. However, the lightest of them
as far as resources are concerned was
QuickHeal, which consumed only 1 MB
of RAM.

Another aspect we analysed was the dif-
ference in boot-up time. Antivirus
software normally checks your machine
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during the boot
process, so there is
an increase in boot-
up time. If you are a
performance freak,
you will want this
difference to be
minimised  even
while you get maxi-
mum  protection.
With a 35-second
time difference,
Norton  certainly
increased the boot-
up time considerably. On the other hand,
Antivir made just a 3-second difference.

Therefore, if you happen to use
power- and resource-hungry applications
such as image-editing or 3D authoring
software, then remember that the heavier
antivirus software will definitely slow
down your other applications while it is
running. If your main focus is using your
application, you might do better to go in
for an antivirus package that is a lesser
strain on the system, even if it compro-
mises on some functionality.

Features

All the software should offer standard fea-
tures such as options for boot sector scans,
scanning before startup, creating emer-
gency diskettes, scanning within com-
pressed files, etc. Feature-rich scanners will
also include options for scheduled scan-
ning, network scanning, scanning within
e-mail, heuristic scanning, etc.

Norton 2001 was one of the most fea-
ture-rich antivirus software. It provided
for script blocking (preventing viruses
such as Melissa), task-based scanning,
scanning before you download, scanning

McAfee sports a cool interface and is rich
in features

e-mail, etc. With Norton, you can specify
the auto-protect feature to work even
when you just access a folder and don’t
necessarily double-click on the executable.
You can also specify the file extensions that
you want to be checked apart from the
default ones.

Even QuickHeal has standard features
like scanning inside compressed files (.ZIP,
ARJ) apart from other features such as
scanning inside compressed executable
files, heuristic scans, etc. There is also a File
Integrity option to recover a file from
unknown virus infection. The other fea-
tures include live database updates, online
protection presence and a Virus List con-
taining virus information. A variety of
scanning configurations, such as the pos-
sibility of including and excluding specif-
ic file types, etc, generating scan reports,
scheduled scanning and rescue informa-
tion, is also available.

F-Secure has an option wherein the
network administrator can configure glob-
al security policies for the company and
automatically update different servers
within the company with the predefined
security policy. Inoculatel T was a disap-
pointment. After having done so well in its
detection capabilities, it lost out on the fea-
tures count.

Ease of use

Understanding the configuration and
interface is quite important if you want to
get the best out of your antivirus software.
This is especially true of the auto-protect
option if avirus is detected. Most antivirus
software offer options such as automatic
cleaning, prompt for response, delete if the
virus cannot be repaired, etc. If you con-
figure this beforehand, the virus scanner
will work in the background without
unduly disturbing you.

In this respect, Norton offers a number
of configurable options, including graph-
ical alerts. McAfee and QuickHeal provide
some customisation features as well. One
of the simplest to use was F-secure with its
totally integrated single-point menu and
icons. McAfee uses the concept of panels
wherein the options are lined up in one
pane and clicking on them gives you mul-
tiple options.

Reporting features are equally impor-
tant if you want to understand the nature
of the antivirus attacks you are facing
and which files they are originating from.
All the antivirus software allow you to
create logs of your scan. These logs are
automatically generated when a virus is
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Contact

Phone number
Fax number
Web site

Features

E-mail checking

DOS bootup check
Browsing virus scan  NO
Download scan

Script blocking
Compressed File YES
Scanning
Performance
Viruses detected
(uncompressed)
Viruses detected in
compressed files
Time taken to scan
compressed viruses
Resource (MB of
RAM used)

Boot up time
difference

Rating

98.96% 90.59%

23.57% 92.87%

0.06 seconds

detected or cleaned. F-Secure has a log
that opens up as an HTML page in your
browser. Norton has one of the best
interfaces, while McAfee comes a close
second.

Get the update

Even if the antivirus software gives good
detection rates, there’s no way the software
can keep track of the new viruses coming
up every day. The only way to be up-to-
date is by regularly installing updates to
the signature or virus definition file. The
software normally allows for automatic
updation of files or you can download the
updates from the Net. Earlier, while updat-
ing the definition files, you had to manu-
ally stop the auto-protect feature, copy the
definition files to the directory where the
software is installed, and then restart the
machine. Now, you can dispense with this
manual process. The antivirus program
updates the file on its own without even
asking for a restart.

In McAfee, updating your virus defi-
nitions can be a bit time-consuming
because sometimes the entire scanning
engine is updated instead of just the virus
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0:04 seconds

Specifications

Name Antivir 9x AVG eScan

The Antivirus Details

F-Secure InoculatelT
Microworld
Software S
Rs.1800

Crystal Solutions
s Pvt Ltd
Rs.2500

022-8265701
022-8344750

022-5093111
022-5093112

NO
YES - proxy

92.39% 92.38% 97.12%

crashed 2.23% 92.06%

0:40 seconds

definitions. There is no concept of pro-
gressive updates—that is, if you update
your virus definition files for a particular
week, the next time you update, you
should just be given only the new virus
definition files.

Some software also give you options
for what you want to update. You can
choose just to update the rescue disk,
the virus definition files, or
even the scanning engine. F-
Secure offers you even more
options wherein you can
select the categories of defi-
nition files (macro, boot sec-
tor, etc) that you want to
update. You can select the
automatic update feature or
even schedule updates, but
for that you have to be
online at the time you have
scheduled the update, and
with a dial-up line this might
not always be possible. Norton even sup-
ports a feature wherein you can send a
suspicious file for scanning at their
research labs.

SR Wi

Computer Associates McAfee

McAfee 5.1 Norton AntiVirus
2001

N&N Systems and | Cat Computer
Softwares Services

Rs 1,600 Expree-Rs.500

QuickHeal 6.01

Rs 1,200

Standard -Rs.1800

022-4444601
022-4465097

020-6122173
020-6122173

91.08% 89.09%

crashed 85.44%

Among the viruses that were tested, Inoc-
ulatel T, AVG and Antivir are really coack-
ages that you can look forward to for
general system security, Antivir has a good
virus definition set, and had the maximum
detection rate. Inocu-
latelT also had quite a
good detection rate,
and it did
well in checking for
viruses within com-
pressed files.

AVG had a problem
in cleaning some of the
infected files and
therefore lost out on that count. In
spite of impressive features, McAfee
failed in detecting viruses within
compressed files.

The best all-round performer
was Norton AntiVirus 2001. Good
detection and cleaning rates, excellent
features and Live Update options truly
make it the best performer. True, it’s a bit
resource-hungry, but what the heck, you
can compromise that much to keep your
system bug-free.d
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Accounts in a big
mess? Whip them
into shape with
financial accounting
software

MITUL MEHTA

he sheer thought of keeping accounts can

make even the biggest business stalwart

dizzy, considering the tedious nature of the

work and the enormous effort that goes into
maintaining account books and preserving
them for the 10 years required by the law. Little
wonder that most people have switched over to
using computers for this purpose.

Of course, who hasn’t wished that financial
accountancy programs would be easier to oper-

Photograph: Rahul Sharma

ate, that the interface would be simpler, or that
it wouldn’t be so darn difficult to figure out how
the whole thing worked?

Over the years, software developers have
been trying to keep the customer satisfied by
making fundamental changes to make their
software more user-friendly. They have also
been trying to zoom in on the specific needs of
different types of users, because in practice,
these software have to cater to a large variety of

customers, from home and SoHo (small office =¥
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home office) users to medium and
large enterprises.

This comparison test focuses on
software created for the SoHo and
small business segment. While Tally
has always been a hot favourite
of this segment, the past year has
seen competition heating up with
newer and better accounting software

being launched, offering you more
choices.

TEST PROCESS

To determine the overall performance
of the accounting software, we evaluat-
ed a range of characteristics. These includ-
ed the type of features the software
incorporated, whether it offered value for money
and whether it provided adequate help for a per-
son to be able to work with it smoothly and
without hassles.

Features, rather than technical specifica-
tions, form the core of a test such as this. We
made a note of features such as inventory
control, management information systems,
multilingual support and security, and gave
points for each of them to help us compare the
products.

Cost is an important consideration. A prod-
uct may be cheaper but may have only a single
user license, which would be beneficial for a
home user, but not for a SoHo user who has
more than one computer. The software should
be able to balance efficiency and features with a
suitable price.

Features

The packages we tested contained a host of fea-
tures, from a simple data entry screen that even
anovice can understand to printing MIS reports
that only top managers and CFOs require to
make important business decisions.

Some of the features we gave more weightage
to were inventory control, security, support for
graphics in the form of graphs and charts and
MIS support for accounting as well as for
inventory.

Out of the packages we tested, only two were
DOS-based. The rest were 32-bit applications
running on MS Windows with a graphical user
interface.

A convenient feature for new users is tem-
plates. FACT, Tally and Wings, all have good
templates. Simply Accounting even has a tem-
plate for creating and selecting a type of compa-
ny, where you get to choose from at least 50
different types of businesses. The DOS-based
packages lacked this feature.

Document designing is another feature of
interest, because not all default reports and
documents will suit your requirements. This

End-user Talk

We talked to several people who have used
all kinds of accounting software on the job
and found that many big companies prefer to
use Oracle as their main database and
accounting software because it allows them
to do live updating of accounts and calcula-
tions with ease. Others told us that their com-
panies used custom-made software to satisfy
their needs. However, there are others, such
as JM Waghela, who have been using
accounting software such as Tally since a long
time. Tally has been a long-time favourite with
the accountancy community. People like
using it because of its simple interface, and
also because they are so familiar with all its
aspects by now.

Although old habits die hard, we decided
to introduce Waghela to some other account-
ing software. He found Wings 2000 Pro really
interesting and easy to use. So much so that
when we asked him which one he preferred,
he picked Wings 2000 Pro!

feature was well-supported by DOS-based
applications like ACE and Easy Accounting. But
they were no match for Windows-based pack-
ages such as Simply Accounting, which comes
with a Crystal Report writer that gives users
complete freedom to create and design reports
of their choice.

Regarding MIS reports, most of the packages
tested provided a basic level of reporting such as
accounts receivable/payable, cash/bank book,
and ageing analysis of debtors/creditors/stocks.
Tally has the distinction of providing the maxi-
mum number of financial reports. It gives users
the option to use ratio analysis to determine, at
any point, the company’s working capital, oper-
ating cost, return on investment, return on
working capital, etc. Simply Accounting stands
out because of its ability to present reports
graphically as well.

Like housekeeping is important in every
aspect of life, so it is with these packages. A lot
of data input takes place and maintaining that
data in a healthy format is essential. It is impor-
tant that the software allows you to back up data
not only on floppy disks, but on other available
media as well. And if the package can support
export and import of data, that is a definite
plus point.

Once again, Account 21, Tally, FACT and
Wings scored over the others. Account 21 even
has a proprietary explorer that allows users to
view complete details at a glance, and even
make changes if required. While Simply
Accounting does allow you to take backups on
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any media, export and import can only
be done from the MS Access database
management application.

Another feature we checked out was
whether the application allows viewing a
screen in full-screen mode. We found that
Tally, Simply Accounting and Arthalekha
had the option of being viewed on the full
screen, whereas the others were
limited to being viewed only in the default
size specified by the application.

Arthalekha has the dis-
tinction of being complete-
ly multi-lingual. At the
main menu itself, there isa N
toggle button that allows
you to switch between &
Hindi and English. While
Wings Pro also provides
multi-lingual support, it
does so at the report level
and not at the menu level.

Value for money

While price is undoubted-

ly an important factor, it
should not take prece-
dence over the quality of
the software. So the key is to
keep the price factor at the back

of your mind and first look out for features
you need. Ask yourself what you want out
of the financial accounting software. Is it
just the usual ledger journal and voucher
entries that need to be taken care of? Or
do you want advanced features such as
inventory control, MIS, multi-user pass-
word facilities, etc? There is no point in

R‘i{!,? qor

Curb Piracy! Go

One key factor that most people tend to
ignore is to install an original licensed
copy of the software. It is a misconcep-
tion that is propagated by local vendors
who blatantly say, “Tell us which software
you want, we'll install it for you.”

All software has to be purchased and
nothing comes free of charge. Even the
most popular of all operating system soft-
ware—MS Windows—has to be bought.

Pirated software is a major reason for
the malfunctioning of the software, lead-
ing it to crash frequently, and it is you
who have to suffer in the end. So
installing a cheap and pirated version of
the software is not exactly the right
move if you want to have a trouble-free
and stable working experience. More-
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shelling out all that extra money for a lead-
ing software if you'll never use half of its
hi-fi features. So first identify the software
that fulfils your needs, and then see if the
price tag is justified.

Of the software we tested, Wings2000
is absolutely free and it provides some
really decent features that would satisfy

most home users. But
when it comes to
advanced features, it
falls flat and that’s
where software like

Tally, FACT and Sim-

ply Accounting score.

If you have a low-

end machine such as a
486, a DOS-based pro-
gram is the way to go.
While ACE and Easy
Accounting provide fea-
tures such as graphical
representation of your
; data and password facility,
Rt their prices are a bit steep.
] And although your journal,
ledger, bank and cash details are all
looked after, you might still miss the GUI
that you've become used to with Windows.

Account21 would suit a small busi-
nessperson, with features such as multi-
currency, reminder letters to debtors and
good security options, although you
would have to pay more for a multi-user
version.

Wings2000 Pro, FACT, Tally, and EX
Next Generation, all fall in the small-to-
medium office segment. Apart from the

@

for Free Software

over, many companies provide free
updates, excellent after-sales services
and lumpsum discounts on forthcoming
products to bonafide registered cus-
tomers. And then there's the small mat-
ter of piracy being illegal. Does it still
sound like a waste of money to buy
original software?

If you would still rather not spend the
money, you can go in for free accounting
packages such as Wings. A professional
version of the package is also available,
which you can purchase if you are satis-
fied with its working and require
advanced user options. Many open
source packages are also available.
Accounting applications come built into
Linux and its other variants.

regular features, they also incorporate
other features that a mid-sized business
would require. Features such as an excel-
lent graphical user interface, MIS report-
ing facility and multi-user facility makes
them complete financial accounting
packages.

Security

We are all extremely cautious about who
should know how much about our mone-
tary transactions. For a businessman, it is
extremely necessary to have total control
over how he wants his accounts to be han-
dled. Many financial accounting packages
allow you to hide or completely disable
certain features depending on who is using
the package. You can create multiple users,
and define rights regarding which features
they can use.

Besides multi-user security, encryp-
tion is another way to keep your data
safe. We gave higher scores to software
that support data encryption and multi-
ple users.

Simply Accounting, FACT, Arthalekha
and Accounting2l provide intensive
security features. However, they have an
open database format, which means that
files created are not saved in the encrypt-
ed format. Tally was the only one that
provided encryption support.

EX, which uses the MS Access data-
base, provides almost no security for the
database, but it has multi-user security
wherein certain features can be disabled
for a particular user. Tally, FACT,
Wings2000 Pro, Simply Accounting and
Account2l also provided multi-user
accounting features, whereas DOS-based
programs like ACE and Easy Accounting
only provided the usual single-user pass-
word facility.

Help and Documentation

Help and documentation comes in vari-
ous forms and media—from manuals to
PDF and HTML files. The aim of help files
and documentation is to get the user to
learn and gain expertise of the software in
the shortest time possible.

Tally EIS 5.4 has a really interesting
manual. The manual has a lot of screen-
shots of the screens that you would come
across while working on Tally.

It is well-categorised with the tasks
arranged in appropriate groupings.
There are sets of instructions on how to
do particular tasks. The quality and
quantity of help given allows a new user
to do exactly what he needs by just
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Selecting accounting software is indeed a
tough job. With so many new features
being added in every upgraded version, it
tends to be a bit confusing to figure out
which accounting software would be the
most appropriate for you.

A home user should generally be look-
ing for taxation, banking capabilities, etc,
whereas a small-time businessman should
be looking not only for these features, but
also for product costing, inventory control,
MIS, etc.

So you should understand your current
requirements and identify your future

looking through the list of tasks in the
index.

DOS-based ACE has hardly any docu-
mentation on the software itself. However,
a pretty detailed manual is included with
it. The manual starts off by giving some
tips to prevent you from getting into trou-
ble. The installation procedure is also
explained well.

Easy Computing’s help comes in the
form of a small manual, which explains
the lengthy procedure of copying all the
files and starting installation. The quality
of the manual isn't too impressive—
there’s not even a clear index that you can
refer to.

FACT’s manual comes in the form of a
Word document. There is a really well-
designed index, butan HTML or PDF for-
mat document with links would have been
a better option for browsing through the
help document.

Wings2000 Pro’s manual is probably
the biggest amongst all the accounting
packages. It has been created for all three
versions of Wings—Wings2000 Plus,
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EX Next Generation: combines features with functionality
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Selecting the Package

needs, because it’s not just about the
money you spend to buy these packages.
There is an enormous amount of work
that goes into entering the data, which is
worth more than the cost of the software.
If something goes wrong with the data, or
the year-end reports don't get done the
way they’re supposed to be, the situation
at work could become really messy.

Here are some of the things to keep in
mind before buying accounting software:
The install size should not be too large or
heavy on the system.

B There should be adequate help and doc-

Wings2000 Pro and Wings2000 Net.
Arthalekha, on the other hand, has a bare
minimum of help provided, which is in the
form of the Windows help format.
Not much accounting ter-
minology is explained;
the emphasis is on
shortcut keys.

Simply Accounting
has a very nice on-
screen help file that is
well categorised. It also
explains a lot of
accountancy  jargon.
Compared to the other
packages, it comes out
tops with its compre-
hensive documentation
and easy-to-use help.

Sl P e l-':w: Y
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Ease of use

Even after spending a lot of
money on an accounting package, if
you're uncomfortable using it, then it
might end up lying on your computer
without you ever doing any quality work
on it. Hence the software needs
= to be user-friendly and have an

inviting look and feel.

Most of the products have
the standard international drop-
down menu style that makes it
convenient for first-time users,
barring Tally and Simply
Accounting, which have their
own style of menus. By and
large, the design and layout
were also clear and easy to
understand.

Simply Accounting is really a
software for beginners. The
software comes with a huge

umentation, so novice users don't feel lost.
B The interface should be simple and
configurable. Also make sure that it is a
single entry package—no double entry
should be required to update reports.

B Check for tiny but important details
such as whether document numbering
and date range are set up automatically or
manually, whether there is support for an
accounting period of more than a year,
and whether you can back up not just on
floppies but on other available media too.
B The package should have housekeep-
ing and maintenance features.

archive of templates for allowing users to
get their work done by simply answering a
set of questions. It stands
apart with its Web-like
feel and distinctive look.
On the other end of
the spectrum are Tally,
FACT and Wings2000
Pro, with advanced fea-
tures and also a complex
interface that a new user
would definitely find
difficult.

Account 21 has fol-
lowed the generic menu
appearance. The sub-
menus have colourful icons

depicting each entry type. This

can be a little confusing initially, but

once you get used to it, you should have
no problems.

The DOS-based packages are straight-
forward and uncomplicated.

Other accounting software, such as
Arthalekha and Wings 2000 Pro, provide
multilingual support. Arthalekha even
starts up with a Hindi interface and shows
up your preferred language once you
change the settings.

We also checked out whether it was
easy to enter data into the program or
whether it was a complicated procedure
wherein one had to switch through
numerous windows.

Simply Accounting leads here as well.
With a neat interface and design, it saves
you a lot of time and energy.

The data entry screen in Simply
Accounting is also very well designed and
there is even the option of customising its
appearance by choosing from among the
five skins available.
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=SS Specifications
Accounting Software: How They Fared

Details Tally EIS 5.4 Simply Account21 Wings2000 Easy Arthalekha ACE FACT 1.9 Wings2000 EX Next
Accounting Accounting PRO Generation 1.5
Contact Software at Simply Soft Topsys Wings Infonet Support Modular Coral Vedika Wings Infonet  Tata Consul-
Work Technologies Solution P. Ltd. Systems Infotech Ltd. ~ Soff'wares  Software tancy Services
Price Rs 22,000 Rs 5,992 Rs 12,950 Free Rs 9,995 Rs.5,000 Rs 9,500 Rs 14,500 Rs 18,000 Rs 9,500
Phone 022-6437209 080-2384900 080-5274343 040-3211458  011-5745596  020-4223510 033-2375091  022-5006490 040-3211458 022-8774081
Fax 022-6432275 080-2384905 080-5295046 040-3237318  011-5350473  020-4225896 033-2373298  033-2400824 040-3237318 022-8777441
Email info@software- enquiry@sim- topsys@vsnl.  info@wings20 easy@satyam. modular@giasp info@coralin- info@vedi-  info@wings200 jaideep_mud-
at-work.com plysofttech.com com 00.com net.in n0l.vsnl.netin dia.com ka.com 0.com holkar@mum-
Website www.software-  www.simplysoft- WWW.wings20 www.arthalekh www.coralin- www.vedi-  www.wings200 bai.tcs.co.in
at-work.com tech.com/ 00.com a.com dia.com ka.com 0.com www.tcs.com
Rating B B+ B A- B- B+ B B+ B+ B+
CONCLUSION asplendid feature-list at an extremely rea-

Managing Personal Finances

What if you are not comfortable with all
the accounting terms? What you need
is a personal accounting software that
takes care of things such as your daily
savings and budgets, keeps track of the
balances in your bank accounts, man-
ages you stocks portfolio and even
helps you with a bit of tax-planning if
necessary.

Two such software that do all of this
quite well and are also popular are
Quicken 2001 and Microsoft Money.
With their year 2001 versions, they even
have many sophisticated features. Unfor-
tunately, both these products are cus-
tomised more towards the Western
market, and hence many of the options
and features these software use (curren-
cy, for example), may not exactly be to
your liking. Features that you might
want to use are the bill reminder facility
and the cash-flow balance statement
that Quicken and Money provide.

So which one is the best? While all these
software provide utility, some of them lack
certain features while some surpass the
others in terms of
implementation
and ease of use.
Of course, like we
said earlier, it
depends on what
your needs are.
From our
analysis, we con-
clude that
Wings2000 gives you
the best value—it’s free
and it fulfils the com-
mon home  user’s
needs. While no help or
tutorials are provided
with the basic software,
these can be bought sep-
arately in the form of a
book for a small sum.
Home or office users who don’t need high-
end features will be more than satisfied
with Simply Accounting, which boasts of

Basic needs

Home users

Advanced needs

Performance

Price

142 B

Wings2000

Simply Accounting

FACT 1.9

EX Next Generation

sonable price.

On the small-and-medium business
front, Account21, Tally, FACT, Wings Pro,
Ex Next Generation were all very useful,
and in terms of

==

features and functionality, they were neck-
and-neck. Among them, FACT is the most
feature-rich—it gives users complete
inventory control and also provides very
robust reporting capabilities with highly
defined and complex levels and rules. The
others lost out because they lacked in
totality of features and supported less
accounting tasks as compared to FACT.

So FACT emerges the winner with very
advanced features, and that too at a rea-
sonable price. When it comes to taking
care of all that expenditure and going that
extra step to create reports, manage bal-
ance sheets and even plan your tax struc-
ture, opting for an accounting package like
FACT is probably the best step that you
can take to bring sanity to your financial
management.
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..to the ‘real’ side of
the virtual world.
DirectX8 and
GeForce3 are getting
together to give you
a gaming experience
you won't forget in a
hurry

144 FH

MARCO D’SOUZA
ou get thrilled by the spectacular lens flare
effects picked up off chrome bumpers in
today’s trailblazing games, but you crave for
more.

When the Porsche 911 GT3 blasts off at the
starting line, you want to see that cloud of smoke
rise from the spinning wheels. You want to see the
expression on your opponent’s face when he’s
about to get ‘fragged’. You want to feel like you're
really there.

Well, the marriage of next-generation graph-
ics APls and 3D accelerator cards promises to put
you splat in the middle of all the action in ways

Imaging: Ram

you never thought possible.

More than ever before, manufacturers of 3D
graphics processors are getting together with cre-
ators of the software that drives these cards and
creating advanced products that enhance your
gaming experience.

Two such products are nVidia’s latest 3D
graphics processor, GeForce3, and the newest ver-
sion of graphics API DirectX. So what makes
DirectX 8.0 tick? And what makes GeForce3 so
special? Here’s an insight into the two technolo-
giesand how they tie up to usher in the next gen-
eration of 3D graphics.
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What Makes DirectX
Tick?

DirectDraw: Allows direct
access to areas in the dis-
play adapter’s video memo-
ry and hardware buffers for
tasks such as page flipping
(used while creating anima-
tions to display one screen
while the next is being cre-
ated). Allows programs to
make full use of the colour
decompression capabilities
of various types of hardware
and not be dependent on a
specific type of hardware.
Direct3D: Allows access to
the advanced features that
handle 3D functions such as
triangle creation, scaling and
transforming 3D images.
This component is scalable,
allowing part or all of the
3D rendering pipeline
access to more advanced
features such as z-buffering
and anti-aliasing.

Direct Input: Implements
support for analog and digi-
tal input devices, offering
increased responsiveness
and sensitivity.
DirectSound: Offers direct
access to the audio sub-sys-
tem. Enables features such
as low-latency mixing
(where multiple audio
sources are used with the
soundcard) and hardware
acceleration for high sam-
pling rates when many
audio streams are used, like
in the new breed of games
that have surround-sound.
DirectPlay: The networking
component, which provides
access to devices over a net-
work—independent of the
hardware, protocols and
networking services that are
used.

DirectMusic: Part of the
direct sound sub-system
that streamlines the repro-
duction of music such as
MIDI playback in applica-
tions and games that are
written to use it.
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GEFORCE3

Graphics hardware has really matured over the
past couple of years. The performance capabili-
ties of today’s 3D accelera-

=N tors let game developers
- — truly display their artistic
HVIDIA skills.  The  emphasis

undoubtedly is on realism.
You want to be able to see
the ripples on that stream
when you're walking through the fantasyland of
your favourite role-playing game, and manufac-
turers such as nVidia have been consistently
churning out the hottest gaming hardware to
bring these effects to life.

nVidia products usually score both in terms
of sheer performance and their use of innovative
technologies. So does the GeForce3 carry on the
tradition, or is it just another graphics card
churned out from the assembly lines with the
mandatory increase in specifications? Let’s take
a look at some of its features and then decide.

The nfiniteFX engine

One of the major enhancements in GeForce3’s
technology is the ability to allow game develop-
ers to specifically program certain parts of this
graphics processor, allowing it to deliver custom
special effects. These technologies are collective-
ly referred to by nVidia as the nfiniteFX engine.
Two important components of this new archi-
tecture are the Programmable Vertex Shader and
the Programmable Pixel Shader.
Programmable Vertex Shader: In any 3D
model, the vertex is the most basic element. This
is the point at which the polygons in a 3D model
meet, so any changes in the position and other
characteristics of a vertex can change the appear-
ance of the 3D model. Until now, vertices could
be assigned to perform a very limited number
of operations in the 3D application. However,
with the GeForce3 there are a number of custom

The Programmable Vertex Shader will allow you
to see wrinkles on faces in real-time

e P T i rhs
The Programmable Pixel Shader will let you see
combined effects like reflective bump mapping

special effects, such as morphing, animation,
deformation and environmental effects, which
can be applied to vertices. This gives program-
mers a high amount of flexibility in what can be
done to the 3D objects in the game.

Effects such as fog, lens effects and water
refraction are now possible. Also, effects such as
wrinkles and stretch marks can be created on the
faces of characters in games, objects can morph
into other elements, and mechanical processes
such as gear trains can be simulated accurately.
This will mean more natural animations for
next-generation game characters.
Programmable Pixel Shader: Like the Pro-
grammable Vertex Shader, this feature allows
application developers to take one step further
towards creating life-like 3D scenes and effects.
This technology has been around since the
GeForce2 was launched. It was then known as
the nVidia Shading Rasteriser or NSR. Using it,
effects such as reflections, bumps, fog and tex-
tures could be applied at the pixel-level in a
scene. The GeForce3 processor takes this to a
much higher level by allowing up to eight tex-
ture operations in a single pass. This is coupled
with the ability to handle four textures at a
time. The GeForce3 can combine these opera-
tions to produce breathtaking special effects
such as reflective bump mapping and realistic
textures with environmental effects such as fog
and mist. Since these effects are processed in
parallel, it does not affect the frame rates in
games, but it certainly makes games look a
whole lot better!

Lightspeed Memory Architecture

nVidia graphics cards have always been notori-
ous for problems with their memory band-
width. As 3D processors keep getting faster,
even though exotic memory like DDR is used,
performance is hit at higher resolutions
because of the graphics card’s memory archi-
tecture.
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The XBox... a Taste of Things to Come

The first time the GeForce3 made its appear-
ance was not on a graphics card. Instead, it
made its debut in Microsoft's gaming console—
the XBox. Boasting of steroidal specifications,
this gaming console promised gameplay like
nothing before it. At that time, the GeForce3

Specifications of the XBox

CPU 733 MHz
Graphics processor (NV20) | 250 MHz core
Total memory 64 MB
Memory bandwidth 6.4 GBps

Polygon performance 125 million poly

gons/sec

Pixel fill rate 4.0 Gigapixels/sec

5X DVD, 8 GB HDD

Storage sub-system

Until now, the easiest way to counter this

problem was to add more memory and pump
up the memory’s frequency. However, with the
GeForce2 Ultra’s memory clocking at 460 MHz
with bandwidths of up to 7.3 GBps, something
else had to be done to alleviate the memory
bottleneck. So the GeForce3 uses a couple of
innovative approaches to access and use its
onboard memory.
Splines: In the past, graphics applications used
to send raw triangle data to the graphics card,
which in turn would process this dataand churn
it out into displayable graphics.
Nowadays, the complexity of the
3D elements in games reaches
high levels and there are times
when individual 3D elements are
often composed of hundreds of
thousands of polygons!

So instead of relying on raw
triangle data to define complex
3D surfaces, they are now defined
by a number of control points,
also known as splines. This
results in a significantly lower
load on the memory bandwidth
and greater efficiency is obtained,
especially when working with
complex 3D elements.

Crossbar memory controller:
Another enhancement to the
memory architecture is the cross-
bar memory controller. The
GeForce3 uses four memory con-
trollers that interact with each
other and the GPU. Therefore,
smaller chunks of information
can be accessed and processed

A scene without antialiasing (above) and with it from many parts of the memory

(below). Notice the reduction in jaggies
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simultaneously.

was code-named NV20 and it was one of the
most powerful graphics sub-systems available
for 3D computer graphics.

Gear up for the next generation of gaming with
Microsoft's XBox

HRAA (High Resolution Anti-Aliasing)

This is another feature that was incorporated to a
lesser extent into the GeForce2 as well. Aliasing is
the appearance of undesirable jagged edges in a
3D model when there are not enough pixels to
represent it. The GeForce3 uses a process called
Quincunx Sampling to minimise these ‘jaggies’
by interpolating pixels between the jagged edges.
It does so by internally increasing the resolution
of the game and then scaling it down to the
required resolution. This feature is hardwired into
the GeForce3; enabling HRAA to make edges and
lines in 3D games appear smooth.

Lossless Z-compression

One of the most important components of the
3D processor is the Z-buffer. This is the area
where the 3D processor stores depth information
about a scene. The graphics processor uses this
information to know which 3D objects lie in the
foreground and which are in the background.
Since this information is extensive in typical 3D
games, it takes up a lot of memory bandwidth. To
optimise the memory bandwidth, GeForce3
implements a form of lossless compression of this
Z-buffer data and therefore allows the memory
to be used more efficiently.

Z-Occlusion Culling

When a 3D object is hidden by another object in
the foreground, there is in fact no need to draw
that hidden part because it won't be visible to
the viewer. If this approach is used, the infor-
mation needed for drawing this object does not
have to passed to the graphics processor. The
GeForce3 uses this technique of only processing
graphical information that will eventually be
drawn in the scene. This results in a significant
increase in the efficiency of the graphics proces-
sor’s throughput.
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The Games to
Look Out for!

Everglade Rush: This futur-
istic hovercraft racing simu-

lation taps the power of the
GeForce3 and coupled with
the new features in DirectX
8.0, it features very impres-
sive textures and lighting
effects as seen in its pre-
release images.

Dronez: This is an RPG that
is set in a 3D world and it
features some very impres-

sive and breathtaking effects
in terms of the complexity
and the animations of the
3D models used.

Independence War 2: This
space war takes detail to an
altogether higher level

where the models boast of
polygon counts that near a
hundred thousand! These,
along with some very
impressive lighting and par-
ticle effects such as gunfire
and explosions, are brought
to life with the GeForce3
and DirectX 8.
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DIRECTX 8.0

Firstly, what is DirectX? DirectX is an Applica-
tions Programming Interface or API. This
software is incorporated into Microsoft’s oper-
ating system and it provides a bridge over
which applications and games can access the
various features that are supported by multi-
media hardware such as 3D accelerators,
soundcards, input devices such as joysticks, etc.
If a particular 3D graphics card can support a
plethora of radically new features, it would
amount to nothing if the API does not support
these functions.

The primary aim of DirectX was to create a
set of tools and interfaces that provides pro-
grammers with the building blocks necessary for
developing applications that run independent of
the hardware upon which these programs are
run. This allows developers to concentrate more
effort on the features of the application without
bothering about hardware issues.

Prior to DirectX, software creators had to
develop products to work well on a variety of
hardware configurations and there was no real
standard for doing this. DirectX provides what is
called a Hardware Abstraction Layer (also
known as the HAL), which makes use of soft-
ware drivers to communicate with the applica-
tion and the hardware.

So if software developers write a code to work
with DirectX, they don’t need to worry about
which hardware platforms it can run on, as all
hardware that supports DirectX will run the
software.

DirectX provides control to a set of tools that
control low-level functions such as 2D graphics
acceleration, sound generation mixing and
reproduction, and support for input devices
such as the mouse and joystick.

All these low-level functions are supported
by various components that together make up
the foundation of DirectX: Microsoft Direct-
Draw, Microsoft Direct3D, Microsoft DirectIn-
put, Microsoft DirectSound, Microsoft
DirectPlay and Microsoft DirectMusic.

Sowhat’s new in DirectX 8.0?

At first glance, you'll find that the new features
supported here are strikingly similar to those
that have been implemented in the GeForce3.
In fact, nVidia has licensed many of its tech-
nologies to Microsoft for the development
of DirectX 8.0. Little wonder that as of now,
GeForce3 is the only graphics processor that
is fully DirectX 8.0 compliant. Let’s take a
look at what new features have been added to
DirectX 8.0.

Programmable Vertex Shaders: This feature
will allow programmable control over the
transform and lighting portion of the graphics
processor. Using this, game developers will be

able to simulate far more realistic effects
when dealing with objects in skin and cloth and
the deformations that are associated with it.
Using this feature, developers will be able to
impart a different ‘feel’ to each of their games
by making the 3D objects in each behave and
react differently.

Programmable Pixel Shaders: Tying in with the
feature that is implemented in the Pixel Shader
used in cards such as the GeForce3, game devel-
opers will now be able to create combined effects
such as bump maps with reflections and tex-
tures. This would make effects such as water rip-
ples and corrugated metallic surfaces more
realistic than ever.

Multi-sample Rendering: In this feature, multi-
ple instances of a 3D scene can be rendered in
different frame buffers and are then displayed in
the manner desired by the application creator.
This would allow for effects such as anti-aliasing,
motion blur, depth of field, soft shadows, etc.
Volumetric Textures: This feature ties in with
the Programmable Pixel Shader feature. Here,
textures will be assigned one more dimension,
giving that extra sense of realism.

N-Patches: This allows the complexity of a
model to be increased to greater levels. It does
this by using special curves called Bezier curves
to increase the smoothness in the curved areas
of the 3D model. N-Patches could allow a rela-
tively simple model to appear much more
detailed.

Texture compression: Textures are one of the
biggest elements used in 3D scenes, and they
are often the cause of the bottlenecks associat-
ed with the graphics card’s memory. DirectX
8.0 has incorporated support for texture com-
pression. Compressing all those large texture
files will increase the efficiency of the memory
bandwidth, resulting in very significant
increases in performance and greater visual
quality.

Matrix Palette Skinning: Much like vertex skin-
ning, MPS is a feature that allows far more real-
ism in transforming objects that are skinned
with textures. Used to generate effects such as
wrinkles in cloth or skin, this method provides
greater fluidity than vertex skinning as there are
more control points used here.

The verdict?

The GeForce3 coupled with DirectX 8.0 prom-
ises games that are going to greatly blur the
dividing line between games and movies. It looks
like the catchword for the next generation of
graphics accelerators is not just pure frame rates,
but also realism. So the next time you gun the
500 bhp engine in that Lamborhgini racing sim-
ulation, the visual quality of the game and its
special effects might be so intense that you might
actually smell the burning rubber![l
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More Info on

the hardware products tested.
Check out

Mindware

his internal CD-writer from

Acer is built on Acer’s Seam-
less Link Technology, which
ensures that there is no buffer
under-run. The burn process
failed for one CD because the
drive was slightly jerked during
the burning process. It has a
Play/Skip button for playing
conventional audio CDs.

HARDWARE

Radar

A PC from Dell, a 17-inch monitor, motherboards, a CD-writer
and a hard disk drive among other hardware devices

Acer CD-RW 1208A

SPECIFICATIONS:
Interface: IDE
Features: 12x write, 8x
rewrite, 32x read
speed; 4 MB buffer
Benchmarks:

SiSoft Sandra: 1161
kbps sequential read,
359 kbps random read,
170 ms average
access time; 1346 in
CD WinBench 99;

7 minutes 5 seconds to
write 650 MB of data
at 12x

verdict

Acer CD-RW 1208A

Performance A bAoA
Build Quality h A A
Value for Money & & & i
Features h b A
OVERALL A oAb

+4 MB in-built buffer

- Not stable

Price: Rs 13,500

Contact: Acer Peripherals

Phone: 022-5705230

Fax: 022-570535

E-mail: pankajpamani@acercm.com.tw
Web site: www.acer.com

For your eyes only

his is a Full Flat Square Tube

17-inch monitor with a 16-
inch effective diagonal view-
able area and a 0.25 mm
diagonal pitch. It is not capable
of higher resolutions at higher
refresh rates, making it unsuit-
able for working with graphics.
The display is feature-packed
with a wide variety of image,
colour and geometry controls.

ViewSonic E70F

SPECIFICATIONS:
Interface: 15-pin D-Sub
Features: Max resolu-
tion 1280x1024 pixels at
60 Hz; anti-static, anti-
reflection screen coat-
ing; CD with drivers
and screensavers
Benchmarks: Anom-
alies along upper right
edge of screen in the
screen geometry tests.
Slightly blurred raster
along lower left and

verdict

\iiewSonic E70F

Performance

Build Quality

Value for Money

> > (>

Features

E S N Sk 3
> > >
E 2 it 3 3

OVERALL &

+ Highly configurable OSD

- Audible clicking sound when
changing from normal to text mode
Price: Rs 14,500

Contact: Roop Electronics

Power with speed

he DiamondMax VL series of

hard drives from Maxtor
comes in capacities of 10.2 GB
t0 40.9 GB. The one we tested
was a 20.4 GB hard drive. In
spite of the fact that this is a
5400-rpm drive, it delivered
impressive performance in all
the tests. Its aggressive pricing
makes this drive suitable for
home users.

g right edges of screen | phone: 022-6631921 Fax: 022-6103919
s while displaying con- E-mail: sales@rooponline.com
vergence test pattern. | \yep site: www.viewsonic.com
Maxtor DiamondMax VL 40  seecricanions: verdict

Hard Disk

Interface: IDE
Features: 5400 rpm
rotational speed, 2 MB
SDRAM cache buffer
buffer with an Ultra
ATA/100 compatible
interface

Benchmarks:

SiSoft Sandra: 28 MBps
sequential read, 5 MBps
random read, 10 ms
average access time
15500 in High End Disk
WinMark 99; 5190 in
Business Disk Win-
Mark 99

Maxtor DiamondMax VL 40 Hard Disk

Performance h bbb
Build Quality A A A
Value for Money & & & &
Features h bbb
OVERALL A bbb

+ High data transfer speeds

- No details of jumper settings on the
hard drive

Price: Rs 4,800

Contact: Karma Distribution

Phone: 9810437872 Fax: 011-6420452
E-mail: naresh@karmasg.com

Web site: www.esysdistribution.com

152 FHI

June 2001



m select~report card

Ticket to the movies

nstead of a tray, this drive

features a slot-in mechanism
that can be easily used in the
horizontal or vertical positions.
Its digital servo mechanism,
CAV technology and Dynamic
Damping System (DDS) helps it
withstand vibration and also
helps minimise errors by
improving stability and accura-
cy of the data read.

AOpen 1640 PRO DVD-ROM

SPECIFICATIONS:
Interface: IDE
Features: 16x DVD/40x
CD-ROM drive; slot-in-
mechanism; supports
CD formats like
CD/DVD, CD-R/RW,
DVD-R/RW; incorpo-
rates DDS, an internal
buffer of 512 KB, bun-
dles PowerDVD 2.55
Benchmarks:

SiSoft Sandra: 3235
sequential read, 865
random read, 102 ms
average access time;
1900 in CD WinBench 99

verdict

AOpen 1640 PRO DVD-ROM

Performance h

Build Quality

Features

h
Value for Money &
L)
L

> > > >

> > >

> > >
-

OVERALL

+ Slot-in mechanism

- Does not support DMA
Price: Rs 5,950

Contact: Yogi Comp

Phone: 022-8806582

Fax: 022-8806582

E-mail: shailz@yogicomp.com
Web site: www.yogicomp.com

A good bargain

low-budget motherboard that
Iso delivers quality perform-

ance. Supports both Slot1 or
Socket 370 based processors,
which makes it useful for
upgrading your processor in the
future. Its dual-inline memory
module banks support up to 256
MB of memory. This is a disad-
vantage as there is no space for
further upgradations.

Kranion KP2A693A
Motherboard

SPECIFICATIONS:
Socket Type: Slotl or
Socket 370

Chipset: VIA693A
Features: Five PCI
slots, one ISA slot,
one AGP 4x slot and
one AMR slot; support
for both Slot1 or Sock-
et 370 based proces-
sors

Benchmarks:

1480 in 3D Mark2001,

21.8 in Content Cre-
ation

verdict

KRANION KP2A693A MOTHERBOARD

Performance h b b
Build Quality A b AA
Value for Money & & & & 4
Features T EX
OVERALL h bbb

+ Dual socket motherboard

- Only two memory banks for DIMM
Price: Rs 3,000

Contact: Cerebra Integrated
Technologies

Phone: 080-3474934 Fax: 080-3755492
E-mail: cerebra.smt@cerebracom-
puters.com

Anything but dull

Anew entrant in the Indian
market, this brand has some
very striking features and spec-
ifications. It excels in graphics
and audio applications, which
puts it in the serious gamer’s
sights. The company has a toll-
free number for ordering any
Dell product and also for solv-
ing after-sales problems.

SPECIFICATIONS:
Features: 1 GHz P-IlIlI,
128 MB RAM, 20 GB
HDD, nVidia GeForce2
GTS w/32 MB video-
card, Intel i815 mother-
board, Creative
SoundBlaster Live!
soundcard, Harman/

verdict
Dell Dimension 4100
Performance h bbb
Build Quality AR ELE
Value for Money & & & &
Features h b h A
OVERALL bbb

Steady and stable

his board proved to be very

stable during the tests. It has
a highly identifiable gold-plated
heat sink installed over the
north bridge. The motherboard
also features the capability of
varying the bus speed and the
processor core voltage in
steps, which makes it easier to
overclock.

+ Fault indicators on the motherboard
+ Machine can be customised

q_ Kardon speaker system !
. Benchmarks: according to your need

33.5 in Business Win- Price: Rs 81,999 (configuration specif-
stone 99, 29.3 in ZD ic, local taxes extra)
Content Creation, 6579 | Contact: Dell Computers
in 3DMark 2000, 122.8 Phone: 1600338044 (toll free)
fps in Quake Il Web site: www.dell.com

A Open AX3S Pro SPECIFICATIONS: verdict

Motherboard m;‘%tiﬂ;)'gzgt 138 A Open AX3S Pro Motherboard
Socket Type: Socket Performance AR REY!
370 Build Quality A A hh
Features: Bundles with Value for Money & & & &
two software CDs, Features TYYY
including the drivers
for the main board and OVERALL Ahbaid

Norton Antivirus 6.0
Benchmarks: 2336 in
3DMark 2001; 125.9 fps
in Quake 11l (normal
mode) and 94 fps (high
quality); crunched
through all 21 filters in
116 seconds in the
Photoshop test

+ Good facilities for over-clocking
+Good package with detailed manuals
Price: Rs 7,000

Contact: Yogi Comp

Phone: 022-8806582

Fax: 022-8806582

E-mail: shailz@yogicomp.com

Web site: www.yogicomp.com
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Photo Finish

Avery basic photo editing
software, but a bit confusing
for the beginner. It has some
easy-to-use filter effects. It
allows you to save images in
PSD format also, but you can
work with layers in the drawing
mode and not in the paint
mode. Lacks the power to be
used for industrial strength

SOFTWARE

Radar

The latest software in the market for editing photos, logging PC activity,
encryption and more

Digital Grafia

snj g mid e sssdd s enidorg ddagme faar

el ok e o

L e

SPECIFICATIONS:
Install size: 6.53 MB

Features: provides
layers in drawing
mode; filters and
masking facility in

verdict ER

DIGITAL GRAFIA

Ease of use h &
Features LX)
Performance h A A
Value for money # &
OVERALL L

+ Feature-rich

+Only 6.53 MB installation

- Confusing to use

Price: Rs 21,000

Contact: New Oriental Imaging Pvt Ltd
Phone: 022-768 0551 Fax: 022-7631088
E-mail: oclcom@bomb5.vsnl.net.in

photo-editing. paint mode : ( /SNILNE
Web site: www.orientalimaging.com
e R et N
EASY PEG
— Ease of use b b oAb
upports viewing of JPEGs, Features A b A
bitmaps and PNG formats Performance b
and also has some good effects Value for money #
to enhance your photographs. o oA
Y .p grap SPECIFICATIONS: CHEAL
It supports viewing of AVl and Download size:
MPEG videos and you can also 163 MB + Easy to use .
extract frames from them. It Features: Supports + Small download size
viewing of JPEG, + Feature-rich

has an impressive colour
palette and you can increase or
decrease any of the red, green
or blue channels.

bitmap, PNG, Avi and
MPEG files; features
include thumbnail cre-
ator, screen capture

- Videos can only be viewed in 200x
200 window size
Price: Freeware
Web site: www. Hnm-freeware.com

Ageneral purpose, easy-to-
use software that runs in
the background and lets you
monitor the programs that you
run. An irritating thing about
this software is that you need
to reboot every time you
change its settings. Overall, a
very expensive package that is
not worth investing so much
money.

PC Activity Pro

Bpinalgn | SsewEp | ®aede | S
G0 | vismiwwos | Jwawe | mbiiy | T
il E &
Driem
Bpemi
Tt FEEUITY PN WEE ::r'_
I by | [m il e
br Sk fia am ey o
P orimie | BO0 |1med
b o ;': ] |"|u
e | Jo I ekt
(™ =1 fam -
T ity ot Jaie: _I
-
o e |

SPECIFICATIONS:
Features: Logs all your
activities such as start-
up, shutdown time;
encrypts your log files;
maintains record of
sites visited

verdict

PCACTIVITY PRO

Ease of use

> >

[
Features -
Performance h

Value for money #

OVERALL L

+ Records all your PC activities

+ Not resource hungry

- Requires a reboot on change of
settings

- Extremely expensive

Price: Shareware, $149.95 registra-
tion fee (approximately Rs 6,898)
Web site: www.softsecurity.com
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|t can encrypt almost any type
of file on any type of media, be
it Zip disks or tape drives. You
could e-mail the encrypted file
in a self-extracting file format
to anyone irrespective of
whether they have Secure IT
2000; all that the person
requires is the right key and
that his machine should be run-
ning on a Windows platform.

Secure IT 2000

L ee—
"
L, TR |
[Te
B o T e
F. o2 | Pasmenm |
| e
| e r——
T
I P S ey
Cmm s
-
e e
- i
B s
e a
Al =t

e | W

SPECIFICATIONS:
Features: 448-bit
encryption algorithm,
built-in file shredder

verdict
Secure IT 2000
Ease of use h b A b
Features h bAoA
Performance h b bk
Value for Money # & & i
OVERALL hhhh

+ Extremely high encryption algorithm
level (448 bit)

+Very easy to use

Price: Rs 3,250

Contact: Secure Soft India

Phone: 022-4452393 Fax: 022-4453371
E-mail: info@secure-soft.com

Web site: www.secure-soft.com

Print one, two, four and up to
eight pages in a single page
with this software. Its configu-
ration is like that of your printer
driver. You can save your print-
ing job, so you can print later
without bothering to locate the
documents. You can manually
print on both sides of the paper
if your printer does not support
dual-sided page printing.

Server Choice

t allows you to configure your

machine as a Web, proxy,
mail, news or ftp server. After
the installation process, the
default address is the name of
the machine itself, and you can
access the features through a
Web interface. On the client or
node machine, the software
allows you to share mailboxes
and also messenger services.

Fine Print 2000 verdict
TN i Fine Print 2000
e 'I-""""““l" ' ' s e Ease of use bbb
,._ - — =¥ Features ‘TEX
- i £ Performance h A oAb
—_— Value for Money & & & &
_— OVERALL A A A
—a + Saves paper and ink
+ Can save your printing job
—— + Lets you print on both sides of
SPECIFICATIONS: paper
s Pas OS support: - Expensive
¥ il e pmr— Win98/ME/NT/2000 Price: Shareware, $39.95 (approxi-
5 B e Installation size: mately Rs 1,838)
1.66 MB Web site: www.fineprint.coms
E-Serv verdict
b e ' E-Serv
Ease of use A h A
Features hoh b
Performance h h b
Value for Money & & & 4
SPECIFICATIONS: OVERALL h ok A

Features: Options to
configure your
machine as a Web,
proxy, mail, news or ftp
server; the proxy serv-
er allows both http or
ftp connections

+ Feature-rich software

- Difficult to use for a beginner

Price: Rs 4,500 (12-user), Rs 5,500 (25-
user)

Contact: True Software Solutions
Phone: 011-5535158

E-mail: info@truesoft.net

Web site: www.truesoft.org

Child-safe Web

f you want to screen out cer-

tain Web sites from your Net-
savvy kids, this may be a good
tool to use. But Krowser uses
predefined criteria, so it is not
completely foolproof. Once
installed, it automatically dis-
ables the default browser and
you have to use this as the
default browser. It is protected
by an administrative password.

SPECIFICATIONS:
Features: A database
of about 4,000 Web
sites has been
reviewed for their
content

verdict

Krowser

Ease of use

Features

Performance

Value for Money

> > >>
E N bt 3

OVERALL

+ Very small download size

- Doesn't protect you from all objec-
tionable Web sites

Price: Freeware

Contact: Pitara Kids network
Phone: 022-6389755

E-mail: khanna@pitara.com

Web site: www.pitara.com
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Dotty about .Net

he name says it all. It is tar-

geted more towards profes-
sional programmers and
developers and calls for a
higher level of expertise and
knowledge of technologies
such as COM, COM+, ASP and
VB. It is geared towards telling
you what .Net is all about and
what it can do for you. It
includes chapters on topics
such as .Net overview, what'’s
new in Visual Basic.NE and
so on.

Reviews

Introducing .Net

JAGE;
220012

Introducing

Publisher: Shroff Publishers
& Distributors

Contact: Computer Book-
shop

Phone: 022-2070989

Fax: 011-3259790

E-mail: cbsbom@
giasbmO01.vsnl.net.in
Price: Rs 300

Rating: & & & &

his book takes a look at pro-

gramming concepts in a sim-
plistic and humorous manner. It
teaches you to program a com-
puter in the most convenient
way possible and at the same
time with a view to enjoying it.
Itis divided into seven parts
and also provides you with
information on a few program-
ming careers. For an insight
into programming at a begin-
ner’s level, you would probably
want to start with this book.

Beginning Programming for Dummies

Beginl‘liﬂ_g
programming

- T ._;I q ﬂ 'ii
| I._'if‘“r*ﬂ.E-u
A Reference
far ike

Rest of Us!

- FEAES

[ T T P ——

Contact: IDG Books

Phone: 011-3260877

Fax: 011-3259790

E-mail: idgbooks@vsnl.com
Price: Rs 199

Rating: & & &

Whack the hacker

very IT company faces the

danger of hacker attacks and
protection from such possibili-
ties is what this book looks at. It
looks at the world of network
security, its vulnerabilities and
also how to protect yourself.
You have different scenarios
highlighted and other informa-
tive chapters on topics such as
footprinting, hacking Win95/98
and Me, firewalls and more. A
very handy book for system
protection.

Hacking Exposed: Network Security

Secrets and Solutions

Publisher: Tata-McGraw-
Hill

Contact: Computer Book-
shop

Phone: 022-2070989

Fax: 011-3259790

E-mail: cbshom@
giasbmO01.vsnl.net.in
Price: Rs 395

Rating: & & &

Find it on
i€
Interactive,,

Arena

For game reviews
check out,
Mindware

On the Stands

Laws relating to
Information Tech-
nology

The book takes an in-depth
look at the various legislative
laws surrounding IT T
and covers such topics | IHFGRHAT
as legislation from for- \
eign countries and also |
the latest develop-
ments on Taxation of
Electronic Commerce.

Contact: Vikas Publishing
Phone: 040-4742324
E-mail: asialaw@
satyam.net.in

Price: Rs 400

The Silicon Valley
PC

Here, you are provided with
information on various
aspects of Information Tech-
nology starting from
the very basics. It con-
tains chapters on sub-
jects such as
Integrated circuit
chips, computer moth-
erboards and other IT-

related issues.

Publisher: Equation Meridan
Contact: Computer Bookshop
Price: Rs 320

The Silitea Ralley
PE i Atre! Masieriid

Hie |

CGI & Perl in easy
steps

This book is part of an ‘In easy
steps’ series of com-
puter books that pro-
vides you with
easy-to-understand
instructions on vari-
ous computing and
programming topics.
This particular book
looks at a step-by-step intro-
duction on how to write Perl

scripts.
Contact: IDB Books
Price: Rs 165
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Do some research
beforehand to figure
out which features
and options you
require and the price
you are willing

to pay

UNDERCOVER

Dial ‘M’ for...

They're getting sleeker all the time. And no undercover agent is complete
without one. So Agent 001 decides to get himself one of the latest models

ustin Powers has one. Nathan Hunt flaunts

a couple of sleek ones when he’s off on his

impossible missions. And James Bond has a

new one every time | see him! So | decided
it was high time | got myself one as well. A
mobile phone, that is. Why, what did you think
I was talking about?

Last month, I was on the prowl in some
Mumbai suburbs, looking for the perfect little
gadget to accompany me on my missions.

| found out pretty soon that Nokia phones
are the hot favourites. One of the cheapest and
coolest models is the Nokia 3310, known for its
compact size and its price tag. This can be any-
where between Rs 7,500 and Rs 13,000, depend-
ing on where you buy it. An authorised dealer in
Colaba, Mumbai, offered it to me for Rs 11,500.
Another vendor promised me, “Woh-ich maal,
bina dabba, sevan five.” (The same model, with-
out the packaging, for Rs 7,500). When | asked
for something similar but cheaper, | was told
about the Nokia 3210. This doesn’'t have the
vibration option that the 3310 has, so it costs
between Rs 5,500-6,500.

This phone happened to be unavailable at
most shops | asked at. Many vendors offered me
a substitute. “Arey! Triumph yaa Alcatel le lo.
Sasta padega.” (Go for Triumph or Alcatel, they’ll
be cheaper.) Triumph is a mobile service

What to Look Out for

Be careful about the following points

while buying a cell phone:

M Try dialling through the phone and
speaking into it to check for any recep-

| Check the cell phone for any damage.
Try to see if any scratches are visible

on the panel or on the screen of the
handset.

M It is probable that you might end up
buying a used mobile. The best place to
check this is the inside of the mobile
where the battery is placed. These

parts are not easy to replace unlike the
front panel or body, which are easily
replaceable.

W Check the battery power. You might
be sold a cell phone with inactive bat-
teries or ones that are nearly dead.
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tion problems.

B If possible, test the various features of
the mobile to ensure that the piece is
working perfectly.

B Choose a good mobile service
provider that has an established setup
in your area of residence or work. Also
find out about all the schemes being
offered by the service provider to pick
the one that suits you best.

The final word: buy from authorised
dealers. You will not only get a genuine
product but also better and more reli-
able service.

provider, which also sells unbranded phones
under its brand name. Alcatel is known in the
market for its looks and features, especially in
the latest models such as the Alcatel 701 series. |
chanced upon some of these, but they were quite
expensive.

Ericsson phones were pricey too, especially
the ones | saw in some of the official shops in
Andheri. | also saw some smashing Sony and
Samsung phones. They were sleek. They were
WAP-enabled. Their prices touched Rs 20,000 in
the black market. Sigh!

I'd like to say two words about the black mar-
ket before we go any further—caveat emptor.
Nokia, Samsung and Ericsson appear to be the
most popular trio in the black market, although
you'll never hear it from those guys. They just
try to sell you whatever they have. So you'll hear
a lot of stuff like, this is the latest maal (he plans
to overcharge you), that he has sold three of
these since morning (slow-moving product,
maybe defective), or that this is his last piece in
stock (wants to dispose of old stock before
arrival of a new model).

Another thing that is prevalent is the
‘exchange phenomenon’ | kept bumping into
people who were trying to exchange their old
phones for newer ones. If the deal goes off well,
the buyer gets some discount on the new phone
he’s buying, while the seller gets a phone he can
resell as new to an unsuspecting victim.

“Arey, naya maal hai yaar!” (It's a new piece)
shopkeepers would protest, as | suspiciously
opened up the back panel of phones, trying to
check whether it was old.

A word of advice: If you are tired of your old
phone, you could jazz things up a bit by going in
for skins and add-ons made by the company
itself. These are available for most phones and
cost between Rs 350-550.

One thing’s for sure, vendors in the black
market are not the best people to ask for recom-
mendations. So do some research beforehand to
figure out what type of phone you want, which
features and options you require, and the price
you're willing to pay. | finally bought the Nokia
3310, so that is one mission accomplished. Next
target: a BMW like Agent 007’s.E1

Want to share insights with others on the things to look for
when buying a cell phone? Write in to
readersletters@jasubhai.com to share your experiences
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Find it an

Interactive,,
More Info on

category. Check out
Mindware

the top five products tested in each

HARDWARE
Monitors (14- & 15-inch)

Sony CPD-E100

+ Good features and performance

— Not for professionals
Contact: Rashi Peripherals
Phone: 022-8260258

Fax: 022-8190766

Price: Rs 14,800

Monitors (17-inch)

ViewSonic PS775

+ Very good image quality

+ Support for high resolution
Contact: Roop Electronics
Phone: 022-6631521

Fax: 022-6103919

Price: Rs 24,000

Monitors(19- & 21-inch)

Sony CPD-G500

A-LiIst

A listing of the best products in different hardware and software categories

but only the winners get to this page—a list-

ing of the best performing hardware and

software that have been tested till date in differ-
ent categories.

Every month, at the Digital Media Test &

Research Centre, we carry out a series of com-

parison tests as well as individual product

Who's in, who's out? The competition’s hot,

Phone: 022-8260258
Fax: 022-8190766 cabinet)
Price: Rs. 32,000

motherboard, 128 MB RDRAM and

reviews. Based on these tests, the best products
have been listed here (detailed reviews on Digit
Interactive-Mindware). As different products get
reviewed over the months, the top products
might find themselves slipping out of the charts
and replaced by the latest entrants in the market.
So, keep your ears sharp and eyes open and keep
yourself abreast of the latest cool products.

Phone: 022-8806582
Fax: 022-8806582
Price: Rs 5,950

Hard disks (SCSI)
Speakers Seagate Cheetah 18XL - CD drives
Creative SoundWorks ST318404LW - 18GB ASUS CD-S500
DTT3500 + Blazingly fast + Good performance
+ True Dolby Digital-compliant — Heats up quite a lot — Slightly inferior build quality
sound Contact: Rashi Peripherals

Contact: Compuage Infocom
Phone: 022-4913986

Fax: 022-4919069

Price: Rs 31,000

Phone: 022-8260258
Fax: 022-8190766
Price: Rs 3,000

CD-RW drives
Soundcards Seagate Cheetah 18XL- Plextor W1210TA
SoundBlaster Live! ST318404LW-18GB + High write and rewrite speeds
Platinum 5.1 +2 MB buffer
+ Dolby Digital AC-3 Contact: ACI Contact: Zeta Technologies
compliant Phone: 022-8595830 Phone: 022-4102277

Fax: 022-8595831
Price: Rs 18,000

+ High quality sound
processing

Fax: 022-4102277
Price: Rs 13,500

+ Truly flat 21-inch screen; support Contact: Compuage Infocom

for nearly every type of image
Contact: Rashi Peripherals
Phone: 022-8260258

Fax: 022-8190766

Price: Rs 87,900

Graphics card

ASUS V7700 GeForce 2
GTS Ultra

+ Blazingly Fast; DDR memory
Contact: Mnemonic Systems

ASUS V7700 GeForce2 GTS Ultra

Phone: 022-4913986
Fax: 022-4919069
Price: Rs 13,500

Motherboards

ASUS PAT

+ Fits into any ATX cabinet
+ Good feature list
Contact: Rashi Peripherals
Phone: 022-8260258

Fax: 022-8190766

Price: Rs 17,500

Processors

Pentium 4 - 1.4 GHz

+ Fastest processor available in
India

Contact: Ockam Systems
Phone: 022-6234798

Fax: 022-6704503

Price: Rs 37,000 (kit including

Hard disks (IDE)

IBM Deskstar 75GXP
DTLA-307075 - 75GB

+ 10,000 RPM; good data transfer
+ 1 MB buffer

Contact: Wales Technologies
Phone: 022-3828100

Fax: 022-3828200

Price: Rs 19,500

DVD drives

Aopen 1640 Pro DVD
+16x DVD speeds; 512 KB cache
+ Good build quality

— Does not support DMA
Contact: Yogi Comp

Epson Stylus Color 880

Inkjet Printers

Epson Stylus Color 880
+ Very quiet; good results
Contact: Epson India

Phone: 022-8257286

Fax: 022-8267287

Price: Rs 19,000
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Laser Printers

External Storage Devices

Samsung ML-5200A

+ Good text printing with effortless
USB connectivity

— Average print speeds

Contact: Samsung

Phone: 011-6932517

Fax: 011-6932607

Price: Rs 23,500

Scanners
Epson Perfection 1640SU

Epson Perfection 1640SU

+ Transparency unit included as
standard accessory

+ Fast image scanning

—Too bulky (4.5 kgs)

Contact: Epson India

Phone: 080-5321266/70

Fax: 080-5581799

Price: Rs 22,500

PCs
Dell Dimension 4100

== - | *1“

— 2T

Dell Dimension 4100

+ Customisation possible

— Too compact for expansion
Contact: Dell Computers
Phone: 1600338044 Toll free
Fax: 1600338046 Toll free
Price: Rs 81,999

Laptops

Zenith 21A Corpo-
rate Notebook

+ Feature packed

+ Excellent performance
— Alittle bulky

Contact: Zenith
Computers

Phone: 022-8377300
Fax: 022-8364859

Price: Rs 1,25,000

160 [l

IOMEGA 2GB Jaz

+ Very good price per MB; hard-
disk-class performance
Contact: Neoteric Infomatique
Phone: 022-4172600

Fax: 022-4163679

Price: Rs 18,000

Handhelds

HP Jornada 680E

+ Power 133 MHz processor
+ Colour screen

Contact: Hewlett-Packard
Phone: 011-6826000

Fax: 011-6826030

Price: Rs 39,000

MP3 players

Creative NOMAD Jukebox
+ Excellent sound quality; onboard
audio processing; USB interface
—Has moving parts

Contact: Compuage Infocom
Phone: 022-4913986

Fax: 022-4919069

Price: Rs 32,000

Keyboards

ACER Ergo

+ Ergonomic design
Contact: Acer Peripherals
Phone: 022-5705230

Fax: 022-4705235

Price: Rs 4,000

Gaming peripherals
Microsoft SideWinder
Force Feedback Pro

+ Highly customisable
Contact: Mnemonic Systems
Phone: 022-8010871

Fax: 022-8051761

Price: Rs 8,750

Pointing devices

Microsoft Intellimouse Eye
+ Very smooth; resilient to dirt
Contact: Microsoft Corporation

L. Zenith 21A

Phone: 022-2850193
Fax: 022-2850198
Price: Rs 3,600

SOFTWARE
Operating systems (Linux)

SUSE Linux 7.0

+ Simple to install; many bundled
applications

Contact: G. T. Enterprises
Phone: 080-6606093

Fax: 080-6671407

Price: Rs 1,800

Operating systems (Windows)

Windows 2000
Professional

+ Very stable

— Heavy on system requirements
Contact: Integrated Business
Solutions

Phone: 022-8214701

Fax: 022-8328240

Price: Rs 8,400

Page layout

Corel Ventura 8

+ Many bundled features and tools
Contact: Integrated Business
Solutions

Phone: 022-8214701

Fax: 022-8328240

Price: Rs 35,000

Web authoring
Macromedia
Dreamweaver 4

+ Extensive feature support
Contact: Integrated Business
Solutions

Phone: 022-8214701

Fax: 022-8328240

Price: Rs 13,000

Antivirus

Norton Antivirus 2001

+ High detection rate

+ Good script blocking capability
— Resource hungry

Contact: N & N Systems

Phone: 022-3680512/17/18

Fax: 022-3680513

Price: Rs 1,600

e

Firewalls *1 o

ZoneAlarm Pro 2.6

+ Good performance

— No protection against ActiveX
controls

Contact: www.zonelabs.com
Price: Rs 2,000 (approx)

CD-burning software
Easy CD Creator 5 Platinum

Easy CD Creator

+ Very fast writing speed
Contact: www.roxio.com
Price: Rs 3,600 (approx)

Voice recognition
Dragon NaturallySpeaking
v5.0 (Preferred Edition)

Dragon Naturally Speaking

+ Impressive speech recognition
— High on system requirements
Contact: HCL Infosystems
Phone: 011-4526518

Fax: 011-4526579

Price: Rs 17,995

Accounting Software

FACT 1.90

+ Exhaustive feature list

— No security for database

Contact: Vedika Software

Phone: 022-5006490

Fax: 033-2400824

Price: Rs 14,500 *ﬂ
L
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m digit diary

The Test Centre has a
unique visitor this
summer. He’s here to
learn, but he sure is
teaching us a thing or
two

Gyaan with Kyan!

f we were to pinpoint one factor that explains

the enthusiasm and charged atmosphere

that’s the hallmark of this organisation, then

it would probably be the fact that we have
some of the youngest professionals, with an
average age of about 22 years. And every once
in a while, this age limit gets pushed a notch
lower.

Meet Kyan. One of the newest arrivals at the
Test Centre, this young man is probably one of
the most qualified people around the office.

Kyan has been reading JDM magazines since
the beginning and has always wanted to work
with us. He has the distinction of having suc-
cessfully completed his MCSE and an e-com-

merce course. He is fluent in Web
programming languages such as Javascript,
HTML, etc, and he’s got his own Web site to
prove that.

Starring Live!

And when he’s not arming himself with the
latest computer fundamentals and program-
ming languages, he’s studying for his first board
exams, coming up next year.

Oh! Did we mention that Kyan is just 14
years old?

Before you, like many legal eyes in the office,
start accusing us of promoting child labour, let
us make it clear that Kyan is here to spend his
summer vacations, before he gets back to his
books and his studies.

And how is the Test Centre reacting to the
presence of someone so young? When
they’re not teaching him the finer
nuances of benchmarking moth-
erboards and graphics cards,
they are playing pranks on
2 him. Like carrying him about

g upside-down. In his turn,

.| Kyan manages to get back at

the Big Bad Boys by chang-
ing the settings on his oppo-
nents’ computers when
they’re not around.

He gives the confirmed
gamers a run for their money in
the Quake Arena. The only person
he still hasn’'t beaten is Rossi, one of
the finest Quakers around the office—and
before Kyan’s arrival, the youngest at 19.

Don’t let his size fool you for his sense of
humor and his wit does in fact belie his age.
Aliasagar, who'’s usually the quiet one in the
Test Centre is driven to defending himself in
one of the verbal battle of taunts that he regu-
larly has with Kyan. With one of the sharpest
minds around, this is one kid who's destined to
go places, but for the time being, he’s doing a
good job of juggling his schoolwork with his
other intellectual pursuits. No wonder, then,
that he’s sometimes called Gyaan!Fl

April saw a lot of activity at Jasubhai Digi-
tal Media. The reason: the third annual
day celebrations with a day-long agenda
of team presentations, entertainment and
fun. Competition was severe as every
team wanted to leave an impression. All
the teams took time out from their hectic
schedules to come up with ideas and
rehearse for their presentations.

We were between the devil and the
deep blue sea—caught between closing

issue and preparing for the presenta-
tion! One day to go and we still couldn’t
find the time to prepare for it. Till we hit
upon a simple idea. Why not do a live
presentation of the issue-closing? What
followed was a mad adventure. Some-
one russled up a Webcam and the night
was spent in experimenting with it. In
the process we recorded the antics of
some unsuspecting victims in their
dare-devilry before the camera.

By the morning, we had things sort-
ed but sound was still a problem. So we
hit upon another simple idea. While the
rest of the team ‘performed’ in front of
the camera, Karan, our assistant editor,
filled in the audience three floors below
with what was happening.

We had a blast doing the presenta-
tion, but the icing on the cake was that
no one believed that it was actually
being relayed live from another floor!
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Confused
state of mind!

One of our readers
received the strangest of

Fusk Porwad  Fashion Theowoh The Aoy

e-invites. While the event
itself was pretty ordinary,
what was extraordinary was
the location. If you look
closely you'll see why this
invite merits a place in
backbyte!!

Contributed by: Cybug Bug-
proof, via e-mail

Long lost

siblings?

You know how every per-
son in this world is sup-
posed to have a look alike
somewhere else (or some
jazz like that!)? Well, the
same appears to be true for
the Apple iMac as well. See
the resemblance?

Highlight the lighter side of
computing. Mail your contributions
to Backbyte

Digit, Plot D-222/2,

TTC Industrial Area, MIDC,
Shirvane, Nerul,

Navi Mumbai 400 706

or send e-mail to
backbyte@jasubhai.com
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Samsung s sinking!

] This advertisement has a
number of ‘irresistible
offers’ on display. But have
you heard of a 17-inch
‘Samsung Sinkmaster?
You'll have to be cautious
while watching Titanic on

+ Pl 800

+ Pl B50

-+ Mereury B0 Intel Board
(133 MHz)

+ Javlin 810 intei MHZ Mather
Board

Re.3,950/-

Rs.3,850/-
+ Mercury 210 Intel with
SEKBPS Modem Rs.3,650)-
+ 20BB Scagate Mard Disk  Rs.4,600/-
* 14"5amsung Calour Manttor

[2 yrs. warranty] Rs.6,500/-
+ 15" Samsung Colour Monitar H
2 yre. warrdnty) Rez1s0- | thisone!

+ 17" Samaung Colour Manitor

rs.1.300- | Contributed by: Arun

[2 yra. warranty)
+ 17" Samsung Slnbmasber

flat 753 DF Rs.13,900/-

+ 52X Samsung OO fam Drwe Rs.1,825/-
+ S0GB Samsung Hard Dl

Assured Connect|V|ty7

If you're thinking
of getting an
Internet connec-
tion from MTNL
then you would
definitely want to
think again. The
chances of getting
connected aren’'t
really all that
high! According
to this advertisement MTNL offers 9.9 per cent assured
connectivity!

Contributed by: Jayesh Bindra, Indore

Designer tooth
crowns anyone?

Have you ever wished you had an ‘Uncle Scrooge’ type of
grin, so you could flash a dollar sign everytime you
smiled? Well, all praise to the almighty Web, you can even
avail of this. Just logon to www.rongrant.com and choose

Al B b Mrwmos et amdbovny =] eRiaal e

from dozens of designer samples for tooth crowns which
you can have made for you. This should put a sparkle in
your smile!

Taken from the Net

RETRO
Office Suites

The first popular word processor for micro-
computers was Electric Pencil written by
Michael Shrayer. The same was available in -
December 1976. Shrayer decided to write
the manuals for the programs in the same
program itself, and thus the concept of
word processing came about. The first
electronic spreadsheet written for the per-
sonal computer was VisiCalc with the
development starting in 1978.

3
‘Page not found’ Is passe

You know how utterly exasperating it is when you type
in a particular URL and come up against a dead end.
And that lousy ‘Page not found’ message doesn’t help
either! But one of our readers came across a link where,
surprisingly, the
same message
will put a smile
on your face!
Contributed by:
Anubhav Mehro-
tra, via e-mail

T Bweat never feoked 50 GOOD.

If true happiness can only be achieved
througlh & state of nothingness,
vou're geing down the right path.

rnisly, W rraiAn't Bl Tha Rae v rspleensd, Pisses rhark e | R

Bandwidth flow!

Exasperated with the current bandwidth speed that you
get? Well who isn't! But here’s a spoof site we came across
that offers a rather novel but extraordinary solution to the
problem. You can connect your PC to your water tap for an
always-on Internet connection with unlimited access and
download speeds. Shocked? Don't be, it’s just an April fool’s
joke. But for more laughs check out www.dutchwater.com.
Taken from the Net

It's all relative

Want to get rid e F i A

of your trouble- L] M relatives", ..
some relatives?
Well now you
don't have to lie
your way around
them. Here are
some really use-
ful options which
should solve all
your relative problems for good. You can choose from
moving your relatives, to deleting them to even renaming
them!

Contributed by: Sajal Kayan, via e-mail

-f_1| Copy "relatives”, .
_;.} Delete "relatives"

EIIE Eename "relatives", ..
3’:"3’_'] few Folder, .
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